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DEPARTMENT OF THE NAVY 
NAVAL EDUCATION AND TRAINING 

SECURITY ASSISTANCE FIELD ACTIVITY 
250 DALLAS ST, SUITE B 

PENSACOLA, FL 32508-5269 

LEITER OF PROMULGATION 

1. The purpose of the International Military Student Officer (IMSO) Program Guide is to prescribe
policies and to delineate functions, duties, and responsibilities for the IMSO program.

2. This Manual supersedes the 2023 IMSO Program Guide and is derived from the following
references:

(a) Security Cooperation Agency Manual 5105.38-M, Security Assistance Management Manual

(b) SECNA VINST 4950.48, Joint Security Cooperation Education and Training Regulation

( c) NETCINST 4950.40, International Education and Training

3. Unless otherwise specified, the IMSO Program Guide is intended to be used as a management tool
in the performance of the functions associated with administering international students engaged in
education and training under the Security Cooperation Education and Training Program.

4. Suggestions to improve IMSO program administrative policy and procedures are encouraged and
shall be submitted to IMSO Training Division, Naval Education and Training Security Assistance 
Field Activity Administrative Officer (AO), 250 Dallas Street Suite B, Pensaco� FL, 32508-5268 or
via email at the following address: PNSC _ NETSAF A_ IMSOHelpdesk@us.navy.mil.

l)Jufib 
/o�L W. IBSTA

4950
Ser N-00/0146 
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Chapter 1 

General  

1-1 Authorization.  The IMSO program is established under the
authority of the Defense Security Cooperation Agency Manual
5105.38-M, Security Assistance Management Manual and the
SECNAVINST 4950.4B Joint Security Cooperation Education and
Training (JSCET) Regulation.

1. Naval Education Training Support Assistance Field Activity
(NETSAFA) is SECNAV's responsible administrative agent for the
IMSO program and is granted authority commensurate with this 
responsibility.

2. NETSAFA provides IMSO program guidance and support to IMSOs
via the NETSAFA IMSO program office.

1-2 Purpose and Objectives.  The International Military Student
Officer (IMSO) has one of the most challenging and demanding
jobs in the Security Cooperation Training Program (SCTP) because
the IMSO is called upon to accomplish tasks unlike those
performed anywhere else in the military.  The IMSO is a host,
administrator, counselor, expeditor, diplomat, and summarily,
the official U.S. Government representative who serves as the
primary Point of Contact (POC) for the International Military
Student (IMS) attending courses of instruction at U.S. military
installations in the United States.

1. The IMSO's responsibilities begin when the confirmed
training is reflected on the Security Assistance
Network Web (SANweb) and/or when the IMS's name is posted on the
SANweb or received via e-mail from the Security Cooperation
Office (SCO).  From arranging for quarters to meeting the
student, the IMSO must initiate detailed planning long before
the student arrives.  From the date of arrival until the student
departs, the IMSO serves as a central point of contact for the
student.  The impressions made on the student are carried home
and could be the key factor that makes the student’s training
beneficial for both the individual and the United States.

2. The tasks performed by the IMSOs are critical to the success
of the Security Cooperation Training Program objectives, which
are:

a. To create or enhance a foreign country's ability to
perform its role in a manner consistent with U.S. 
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multinational strategy or as may be indicated in treaties, or 
other international agreements; 

b. To assist the foreign country in developing expertise
needed for effective management and operation 
of its defense establishment or an element thereof; 

c. To create skills needed for effective operation and
maintenance of equipment acquired from the U.S. through Foreign 
Military Sales (FMS), U.S. Grant programs (International 
Military Education and Training (IMET), Foreign Military 
Financing (FMF), etc.), or direct commercial sales from U.S. 
vendors; 

d. To promote U.S. military rapport with the armed forces
of the foreign country; 

e. To promote the foreign policy, security and general
welfare of the United States by assisting partner nations in 
their efforts toward economic development and enhancement of 
internal and external security; and 

f. To promote a better understanding of the United States,
including its people, political system, and other institutions. 

1-3 Navy Support and Supervision.  Navy International Program
Office (NIPO) falls under the Secretary of the Navy (SECNAV) who
is responsible for overall management of Department of Defense
(DoD)/Department of the Navy (DON) policy and guidance regarding
international military education and training within DON.  See
Naval Education and Training Center Instruction (NETCINST)
4950.2F Enclosure 3 dated 3 February 2022 for IMSO Duties and
Responsibilities.

1. Commanders of Naval Systems Commands, Fleet Commanders,
Naval Education and Training Command (NETC), and other U.S. Navy
major claimants will ensure commanding officers appoint an IMSO
to administer the Security Cooperation Training Programs.
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Chapter 2  

International Military Student Officer Requirements 

2-1 Full-time and Part-Time IMSO.  A full-time IMSO is defined as a
Service member, civilian or contractor whose IMSO work tasks are
comprised of eighty percent or more of their assigned work tasks.
A part-time IMSO is defined as a Service member, civilian, or
contractor whose IMSO work tasks are comprised of less than eighty
percent of their assigned work tasks.

2-2 Designation Requirements.  Commanders of Naval Systems Commands
(SYSCOMS), Fleet Commanders (FLTCDRS), Naval Education and Training
Command (NETC), and other U.S. Navy major claimants will ensure
Commanding Officers (CO) appoint, in writing, an IMSO to administer the
SCTP.  COs should use the following criteria when appointing an IMSO to
their command.  A sample letter of appointment is provided
at Form B.1.

1. The IMSO may be either military (officer or enlisted) or a United
States Government (USG) civilian employee.  For contractor provided
training where a military member or civilian employee IMSO is not
present, the contract vendor should perform IMSO duties.  The IMSO will
monitor and coordinate activities for the IMS's training, including
implementation of the Field Studies Program (FSP).  The IMSO appointed
must be tactful and mature, be sensitive to a myriad of cultural
differences, exhibit sound judgment, and be able to communicate 
effectively both orally and in writing.  Potential IMSOs should apply 
for consideration.

2. IMSOs will be appointed for a minimum of two years, when possible, 
and will receive the necessary training to perform this important 
function.  Training of U.S. Navy (USN) command IMSOs will be 
coordinated with Naval Education and Training Security Assistance 
Field Activity (NETSAFA).  Section 2.3  provides information on 
specific IMSO training courses.

3. The IMSO's name, office, address, telephone and email must be 
reported to NETSAFA, Code N-34I via the appropriate Navy Major 
Claimant.  This can be accomplished using the SANweb, Security 
Cooperation Training Management System (SC-TMS) location Contacts
page.  The designation letter and intake form (Form B.1,Form B.2) shall
be emailed to the IMSO Program Manager at:  
PNSC_NETSAFA_IMSO<Helpdesk@us.navy.mil.
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2-3 Required Training.  NETSAFA is responsible for providing IMSOs
with the necessary guidance and oversight to enable them to carry
out their duties. The NETSAFA IMSO Division will also coordinate
necessary training for IMSOs, and will host and conduct the IMSO
Workshop as prescribed.

1. Within Defense Security Cooperation University (DSCU), the School of
Security Cooperation Studies (SSCS) provides a number of courses to
benefit IMSO duty performance.  In an effort to recruit, develop and
retain personnel for duties in the Security Cooperation enterprise, OSD in
coordination with MILDEPS have identified personnel billets for coding in
Security Cooperation Workforce Database (SCWD).  Most full time IMSO
billets have been coded as part of the SCWD.  Per OSD – SCWD requires all
full time IMSO’s to complete the Introduction to Security Cooperation
(SC-101)course and the Fundamentals of Security/Transfer (ACQ-130).
Contact NETSAFA, IMSO Program Manager for information and instructions
regarding training within ten working days of receipt of designation as an
IMSO.

2. The IMSO workshop is announced by message with the specific date,
time, and location. The workshop is designed to enable IMSOs to share
knowledge and/or experience gained from daily contact with the IMS, and
resolutions to problems that individual IMSOs have experienced. The
workshop is also a valuable training experience for new IMSOs, both
through the structured seminar topic discussions and through the personal
contact with experienced IMSOs.  This IMSO Workshop is funded by DSCA/
NIPO, not the parent command.  Inquiries about the workshop should be sent
to the IMSO Program Manager at: PNSC_NETSAFA_IMSO<Helpdesk@us.navy.mil

2-4 Recommended Training.  The below listed courses are recommended
IMSO training courses:

1. Intercultural Competencies Course (ICSOF).  The United States Air
Force Special Operations School at Hurlburt AFB FL, conducts a one-
week ICSOF course eight times a year.  The course is "activity
funded" for per diem and travel, and there is no tuition cost.  The
purpose of the course is to improve communication skills of DOD
personnel engaged in liaison with international military personnel,
sensitizing them to differing cultural values, behavior, assumptions
and perceptions.  Quota requests are to be processed through unit,
command and/or service training offices.  Quota requests should
include name, rank, Social Security Number (SSN), course name,
desired dates, and should be requested at least 30 days in advance
from:
IMSO ASSIGNED
5720 Integrity Drive Building 453
PMO Millington TN 38054
DSN 882-4897 or (901) 874-4897

NETSAFA 
 MAY 24
NETSAFA 

  MAY 24 

11

Mark.Watson1
Cross-Out



2. Cardiopulmonary Resuscitation (CPR) and First Aid Training.
It is highly recommended that IMSOs and assistants undergo this
training to prepare them in the event of an emergency,
especially during FSP trips.

3. Safety Training.  Due to a number of factors including
differences in language, customs, and the understanding of non-
verbal cues the requirement for safety in Navy training is
paramount when it involves the training of IMS.  IMSOs are
reminded to place special emphasis on safety and on following
all safety regulations and instructions when dealing with the
IMS, instructors and other staff members who are responsible for
the safety and safe conduct of international students.  NETCINST
5100.1B of 23 March 2015/CH1 of 3 April 2015 (NETC Safety and
Occupational Health, Program) provides policy and guidance on
safety procedures for conducting training.  IMSOs should ensure 
that IMS are fully briefed on Training Time-Out and Drop On 
Request (DOR) procedures for high risk courses. 
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Chapter 3 

IMSO Duties and Responsibilities 

3-1 IMSO Duties and Responsibilities.  IMSOs are responsible for the 
overall administration of IMS while assigned to their training
activity.  Chapter 2 of this guide and Chapter 10 of the JSCET outline 
details for IMS administration. Checklist C.1 is a Summary Checklist of 
the many tasks and events that occur from the first notification of an 
IMS enrollment in a course to the IMS’s final departure from the training 
installation.  IMSOs are encouraged to use a Summary Checklist for each 
IMS, and to file the Checklist in the IMS Training Record.  IMSO Duties 
and Responsibilities include, but are not limited to the following:

1. Coordinate orientation tours and foreign visits with
appropriate base personnel.

2. Interface with various agencies to facilitate the execution
of the SCETP and SCWDP (e.g., NETSAFA, NIPO, Fleet Commands,
Learning Centers (LCs)/Learning Sites (LSs), as well as naval
attaches of foreign embassies, country liaison officers,
federal, state, and local government personnel).

3. Ensure all interagency agreements adequately reflect and
support SCETP and SCWDP objectives and requirements.

4. Routinely log into SC-TMS to review and verify IMS
projections.

5. Provide projected class information to instructors and LC
personnel as required.

6. Interface with SCOs for timely IMS arrival information to
ensure IMS is aware of local arrangements and other routine
administrative matters.

7. Review IMS ITOs to identify and resolve discrepancies.

8. Manage the International Training Sponsor Program per
applicable directives.

9. Arrange berthing and messing for IMS, as well as assist in
the arrangement of housing for married IMS and dependents, if
applicable.

10. Arrange credentialing procedures for IMS and dependents, if
applicable.
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11. Serve as the Defense Language Institute Testing Control Officer for
their region. Ensure defense language proficiency test desktop software
updates are downloaded, and software currency is maintained so that IMS
testing can be administrated.  Assist in the resolution of English
language comprehension waiver issues.

12. Ensure photographs of each IMS are loaded onto SC-TMS to support
SCETP security measures.

13. Prepare IMS arrival and enrollment reports at the beginning of
course and IMS completion reports at the end of the course in SC-TMS.

14. Review IMET or other program payment requirements and IMS ITO to
determine travel and living allowance (TLA) payments.  Prepare TLA
documents.

15. Resolve IMS related incidents and academic and disciplinary
problems.  Become thoroughly familiar with SC regulations and
instructions relating to IMS issues and prepare timely reports, as
required.

16. Counsel IMS regarding academic and disciplinary issues.

17. Advise the chain of command on serious breaches of military or
civil law by IMS and recommend appropriate action to be taken.

18. Conduct thorough and comprehensive DoD arrival and departure briefs
for all IMS in the region.

19. Ensure DoD insider threat video is shown to all IMS during arrival
briefs and documented on briefing form or in SC-TMS.

20. Arrange pick-up and departure transportation for IMS and
dependents, if applicable, in the region.

21. Prepare all SCETP administrative reports and correspondence per
directives (e.g., arrival and departure reports, commencement and
completion reports, academic reports, ITO amendments, and endorsements,
etc.). These reports are critical to SCETP management.

22. Attend academic review boards as necessary.

23. Coordinate IMS mail distribution.

24. Arrange IMS ticketing and transportation to home country or follow-
on LS for IMET, RDFP, Section 333, Global Peace-keeping Operations
Initiative, and FMS and FMF when TLA is paid from the FMS case and other
programs as appropriate.
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25. Provide follow-on LS and home country of IMS travel itinerary.

26. Maintain IMS arrival and on-board recall lists.

27. Perform periodic IMS bachelor enlisted quarters inspections.

28. Assist IMS in resolution of student related problems and
quality of life issues.

29. Provide logistical support to IMS, when applicable (e.g., bank
accounts, car rental, car purchase, driver license, etc.).

30. Manage the regional DoD FSP to ensure it complies with
appropriate DoD directives.  The regional FSP should be
comprehensive with the specific objective of providing IMS with an
awareness and functional understanding of the 11 facets of the FSP,
including the basic issue involving internationally recognized human
rights and the American democratic way of life, per appropriate DoD
directives and public laws.

31. Develop the regional annual FSP budget to include any planned
orientation tours.

32. Serve as U.S. Government Class “A” paying agent, per DoD
directives, to permit advanced withdrawal of FSP funds to defray FSP
activity costs.

33. Implement approved regional FSP activities.

34. Serve as FSP escort officer.

35. Brief assistant FSP escort officers on FSP objectives, the
specific program for each tour, their responsibility for the
program, and methods to be used to attain its objectives.

36. Prepare documentation of FSP events to include IMS critiques,
escort officer critiques, and summary of FSP event.

37. Liquidate funding for each FSP event, according to policy.

38. Submit copy of funding liquidation package, IMS critiques, and
escort officer critiques for each FSP event to NETSAFA FSP Manager
and NETSAFA N84 at PNSC_NETSAFA_FSPMANAGER@us.navy.mil.

39. Prepare and maintain complete personnel and training records
for IMS.  Forward IMS records to follow-on LS or to SCO upon
departure, per applicable guidance.
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40. Verify IMS retainable instructional materials are
legitimate and arrange for shipment to SCO with proper
markings for any classified materials.

41. Ensure DD 2496 (International Student Academic Report)
is uploaded into SC-TMS within 60 days after course 
completion.

42. Meet the certification requirements for an IMSO per
DCSA guidance.

43. Attend the annual DON Maritime IMSO Workshop. Funding
for one IMSO per command is provided by NETSAFA. Complete 
details will be provided by NETSAFA message and e-mails.

44. IMSO offices at San Diego, Hampton Roads, and Great
Lakes serve as SCETP and SCWDP policy consultant and
advisor to regional LCs and LSs on issues relating to IMS 
issues and problems and manage SC training in their 
respective regions.

45. Coordinate with the training activity, NETSAFA, and
NIPO to document all concerns regarding country liaison 
officer performance. 

46. Coordinate IMS arrival with appropriate base security
office to ensure base access.

47. Coordinate with appropriate Corporate enterprise
Training Activity Resource System data entry contacts for 
IMS entry into this system.

48. Complete a DD 1172-2 (Application for Identification
Card/Deers Enrollment) and escort IMS to their transaction 
service center to procure a next generation United States 
identification card for installation access.

49. Collect and submit electronic data interchange
personal identifier or DoD identification number, for IMSs 
who require a non-classified internet protocol router 
network enterprise alternate token system token for learning 
management system access, if required.
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Chapter 4 

International Military Student Administration Pre-Arrival 

4-1 Projected Student Reports.  Real time student projection
reports are available on the SANweb from the Schoolhouse Tab
under Reports/Option select Projection Report by MASL.  After
selecting the report query options, select Preview on the right
of the screen.  It will produce a report reflecting students
programmed and confirmed for training at your location during
the current and next FY.  For Student Report instructions see
the SC-TMS Quick Reference Guide for IMSOs in
Reference Guide D.1.

1. Projections can also be obtained under the Reports Tab.  You
can use Projection by Start Date, Projection by MASL, or Ad Hoc
to get a projection of students for your training activity.
These reports can be used to confirm course availability, plan
future student throughput, assess classroom and instructor
requirements, and develop the FSP budget.

2. Another method for gathering projected student information
is selecting Student Training & Progress Messages on the
Schoolhouse Tab.  Students Confirmed must be selected in the
Search Options.  The limitation of this query is it only
reflects students in Confirmed status, not Programmed.  The
query results will show if an ITO has been published, and
whether the IMS Consolidated Consent Agreement is available or
not.

3. IMSOs should review IMS projection reports carefully and
take the following actions as appropriate:

a. Contact the NETSAFA CPM as listed on the Report if
there are questions or discrepancies regarding specific 
countries or Worksheet Control Numbers (WCNs) or course dates 
for a training line.  

b. Contact NETSAFA (N42) at DSN 459-8798, or COMM (850)

452-8798 for the following issues:

(1) A course is no longer available.

(2) A change in prerequisite training for a

particular course. 

NETSAFA 
  MAY 24 

19



c. Changes in course length, location, or convening dates.
NETSAFA (N-42) will coordinate with the appropriate NETSAFA 
Country Program Manager (CPM) and Quota Manager to pass on information
as necessary.   

4-2 NEATS Tokens.  NIPRNET Enterprise Alternate Token System
(NEATS) is a centralized token management system DoD PKI certificates
on NEATS tokens, also known as Alternate Logon Tokens(ALTs).  These 
are used for IMS because they are not authorized to receive a Common 
Access Card (CAC).  Some but not all IMS will require access to Navy
computers systems and this is done with (NEATS).  If your activity has 
a Learning Management System (LMS) your IMS will require a NEATS
token.  NEATS token flow chart 
Reference Guide D-8.

1. The NEATS request process is as follows:

a. Training Site International Military Student Officer
(IMSO) submits NETSAFA NIPRNET Enterprise Alternate Token System 
(NEATS) Foreign National (FN) Request Spreadsheet via email to 
the Submitting Trusted Agent (STA) on FN Request Spreadsheet.  

b. (NETSAFA STA) submits NETSAFA NEATS FN Request
Spreadsheet requesting “Registration only” to NIWC via email to 
niwc_lant_pki.htra.fct@us.navy.mil 

c. NETSAFA STA forwards NIWC’s approval email with 
attached NETSAFA NEATS FN Request Spreadsheet to Token Issuer 
(TI). 

d. TI responds acknowledging receipt; programs token and 
informs all parties when complete. 

e. TI reviews NEATS with STA-who confirms, records, 
requests overnight shipping label, provides IMSO tracking, then 
TI will package NEATS & initial PIN send out via FEDEX  

f. IMSO verifies International Military Student (IMS) 
NEATS token was received and IMS has access with Learning 
Management System (LMS). 

4-3 IMS Advance Arrival Information.  The (SC-TMS9) Projection 
Report is usually the first notification that an IMS is coming 
to a training installation.  IMSOs should use this Report as a 
trigger mechanism to send Student Information Packets to the IMS 
via mail, e-mail, or website references, as appropriate.  The 
IMSO will verify with the SCO as required, to ensure the 
information is forwarded to the designated IMS.  Packets will
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include such items as school brochures, maps of the local area, 
estimate of living costs, type of clothing required, housing 
facilities, and other information that would be of interest to 
prospective IMS.  Furthermore, a special text containing 
terminology peculiar to the course should be provided to help 
the IMS prepare for the training.  The IMSO should send the 
Student Information Packets in time for the SCO to receive them 
at least 45 days before the IMS report date. 

1. The SCO should enter advance arrival information on the SAN
Web.  The notice should arrive no later than 15 days prior to 
the IMS's scheduled arrival (30 days if an IMS is accompanied by
dependents).  When the SCO has entered the data, IMSOs will
receive an automated e-mail.  The arrival information will
include pertinent information concerning the IMS, e.g., name,
grade, service, WCN, travel itinerary, report date and
accompanying dependents, if any.  Any changes that occur after
the arrival message should also be forwarded to the first
training installation.  Under Student & Training Progress
Message results for confirmed students, a highlighted note with
arrival information will appear under the WCN and Name of the
IMS.

2. Another method to obtain arrival information is to select
the Student Tab, then Arrival Information, then provide query
parameters to narrow or broaden your search.  This allows
gathering arrival information for multiple students
simultaneously.

4-4 IMS Home Country Information.  In addition to sending
information about the school, IMSOs should gain a working
knowledge of the home countries of the IMS attending their
school.  The IMSO (and other staff) at a training site will be
able to better relate to and interact with international
students if they have an understanding of the student’s home
country.  This includes the country’s history, geography,
governmental structure, economy, culture, military, and
relations with the United States.  IMSOs should take advantage
of the following US Government websites to gain an understanding
of a student’s home country:

1. Dept. of State Background Bilateral Relations Fact Sheets:
http://www.state.gov/r/pa/ei/bgn/

2. CIA World Fact Book: https://www.cia.gov/the-world-factbook/
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3. USN Center for Language, Regional Expertise and Culture:
https://www.netc.navy.mil/LREC/

4. The IMSO should also share these websites and/or significant
country information with other training site staff members,
including sponsors, instructors, medical staff, and other key
personnel who interact with the international students.

4-5 IMSO Communications.  One of the most important
responsibilities of an IMSO is to ensure that accurate and timely
information is communicated to the various offices involved in
international military training management.  This includes (but
is not limited to) their own command, NETSAFA, NIPO, DSCA, SCOs,
NETC, and DFAS.  While the IMSO may not regularly communicate
directly with all of these offices, it is important to remember
that the information generated by the IMSO could very well be
passed on to others beyond their immediate points of contact.

1. The IMSO’s initial communication is normally with NETSAFA.
Appendix A of this guide contains common NETSAFA email addresses.
IMSOs can also make direct contact with SCOs for routine 
administrative matters concerning IMS such as non-receipt or 
clarification of arrival information, ITOs, biographical data, 
security clearances, travel arrangements, and personal affairs 
such as dependent or financial problems.  Information copies on 
all correspondence should be sent to the NETSAFA CPM responsible 
for the IMS.

4-6 ITO.  Per the Electronic-Security Assistance Management
Manual (E-SAMM) Chapter 10, the ITO is the controlling training
document provided to international students under SC training
programs.  No student enters a SC-sponsored training program
without a properly completed ITO.  The ITO provides the
authorization for the dates and location the IMS is to receive
training; the accounting fund site that will be used to pay for
the training; the guidance for determining what support the IMS is
entitled to; and the privileges the IMS may be entitled to while
receiving training.  The only ITO document authorized is the SCTMS
generated ITO.  An example of an ITO is shown in Form B.3.  The
SCO is responsible for the preparation, explanation, and issuance 
of an ITO for each IMS. The IMS name on the ITO will be the same 
as on the country-issued passport and visa; no changes to the 
student name on the ITO or within SC-TMS to the name can be made 
until the IMS’ passport and visa are changed.  If the country 
desires, a language translation may be attached to the ITO.
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ITOs are issued only after in-country student screening is 
completed.   

1. Changes to the student name on the ITO or within SC-TMS to
the name can not be made until the IMS’ passport and visa are
changed. If the country desires, a language translation may be 
attached to the ITO.  ITOs are issued only after in-country 
student screening is completed.

If an IMS arrives at a training installation without a signed 
(electronic or hand) original ITO, the IMSO will notify NETSAFA. 
If the original ITO has been lost, a copy may be certified as an 
original. 

If a copy of the ITO for an IMS showing "Confirmed" on the 
Schoolhouse Projection Report is not received two weeks before 
the training report date, the IMSO at the first training 
installation, after coordination with NETSAFA, may query the SCO 
concerned on the ITO's status. 

When the U.S. Government or host country pays living allowance 
and/or travel, the IMET or other Fund Cite block is completed 
(Block 9 of the ITO, generated by the Training Management System 
(TMS)).

2. ITO Amendments and Endorsements.  An ITO amendment is
required whenever there is a change in the planned training
schedule for an IMS.  Because ITOs are published using the SC-
TMS, any subsequent changes to the ITO must be done by
publishing an amendment to the ITO in SC-TMS.  If a change in a
planned training schedule for an IMS requires an ITO amendment, 
after the IMS has arrived at a U.S. training installation, the
IMSO will notify NETSAFA, who will coordinate the preparation of 
the amendment with the SCO.  All ITO amendments will be prepared 
by the SCO using SC-TMS.  IMSOs may contact an SCO directly and 
request an amendment to correct routine administrative issues 
(e.g., misspelled name, rank changes due to promotion, etc.). 
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3. ITO endorsements provide documentation of routine
administrative matters that occur in the course of carrying out
the IMS training plan.  These include arrival at a training
installation, assignment to quarters, receipt of living
allowances, and issue/return of an Identification (ID) card.
IMSOs are authorized to sign endorsements as part of their
regular duties, and should follow the same distribution as
the original ITO.

a. At a minimum, headings will contain the following data:

(1) Office symbol and official address of publishing
activity 

(2) Original ITO number and date

(3) Rank and name (surname (ALL CAPS), first, middle) of
IMS 

(4) Country

(5) Funding and WCN or IMET IMS with FY IMETP and WCN

(6) For FMS IMS, indicate FMS case designator and WCN

(a) Certificates or endorsements indicating that
government quarters and subsistence were or were not available 
will be provided and affixed by appropriate command. 

4-7 Sponsor Program.  The purpose of the Sponsor Program is to
help make IMS and their family feel welcome while undergoing
education and training, and to acquaint them with American
society and way of life.  Sponsors should have a sincere
interest in the purpose of the program and in working with
internationals.  They should be willing to take an active
interest in preparing for the student before he or she arrives
as well as making the student feel at home while in the area.
Training Activity Commanders and IMSOs should encourage other
staff members to serve as sponsors as long as there is not a
conflict of interest, such as instructors responsible for
grading students.
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1. IMSOs should advise sponsors not to assume any financial
obligations for an IMS.  Requests for financial assistance
should always be directed to the IMSO, who can verify the IMS' 
entitlements such as excess baggage allowances, travel expenses, 
or living allowances.  (Indebtedness of an IMS is also addressed 
in para. 11-4).

4-8 Country Liaison Officer (CLO).  An international officer is
sometimes attached to a command to provide assistance in the
administration and control of students from their country.
Senior students from countries that do not have CLOs may assist
with CLO functions.  CLOs can give counsel or guidance to an IMS
in a variety of matters, including academic or disciplinary
problems, student morale, leave and travel arrangements, etc.
More information regarding CLO roles and responsibilities can be
found in SECNAV NOTE 4950 Date 17 Mar 2023 located at:
https://www.dscu.edu/itm.

4-9 Health Insurance Screening Policies.  The DON Process for
Review of Healthcare Insurance Policies for International
Military and Civilian Students and Authorized Dependents was
released on March 22, 2018.  This guidance complements the
requirements, roles and responsibilities outlined in DoD
5105.38M SAMM, Chapter 10 para 10.9, Healthcare Coverage.  The
DON Process for Review of Healthcare Insurance Policies for 
International Military and Civilian Students and Authorized 
Dependents carefully outlines the process for submission of 
commercial medical insurance policies when determined that it is 
required for IMS and authorized dependents and for coverage 
compliance review by NETSAFA.  NETSAFA is designated as the 
maritime service agent to execute the medical review process in 
order to assist the IMSO and SCO in determining that the
healthcare insurance policies purchased by the IMS and 
International Civilian Student (ICS) meet these requirements.
As outlined in the guidance, if it is determined that commercial 
healthcare insurance is necessary, the SCO will obtain a copy of 
the commercial healthcare insurance policy, in English, from the 
IMS and upload for assessment via SC-TMS.  SCOs can upload 
prospective policies for NETSAFA review prior to IMS/ICS
procurement to ensure compliance before purchasing.  IMSOs are 
not responsible for coordinating the health insurance policy 
review.  NETSAFA cannot review policies sent via email before 
the IMS purchases the policy.  The SCO can upload a policy quote 
before the IMS purchases, but the IMSO is not involved in that 
process.  Policies will only be reviewed in SC-TMS (see the 
Reference Guide D.2 for the process of uploading and reviewing 
policies in SC-TMS).  The healthcare insurance policy review will
be completed normally within five working days and compliance 
determination will be sent to the SCO, IMSO, and applicable 
country program manager via progress message in SC-TMS.  
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IMSOs will review ITO before/or upon arrival to verify that IMS and 
authorized dependents have medical insurance deemed compliant with
DoD standards.  If you have any questions, please contact 
the NETSAFA IMSO Manager at:  PNSC NETSAFA IMSOHelpdesk@us.navy.mil.

Reference Guide D.2 is the DON Process for Review of Healthcare
Insurance Policies for International Military and Civilian Students 
and Authorized Dependents. 
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Chapter 5 

International Military Student Travel 

5-1 General Travel Information.  IMS travel can be funded by a
variety of Security Cooperation programs, including FMS, Foreign
Military Financing (FMF), IMET, and Regional Defense Fellowship 
Program.  (See Chapter 10 of DSCA Manual 5105.38-M, E-SAMM for 
details.)  The SCO arranges for the IMS to travel from their 
home nation to the first training installation.  IMSOs are then 
responsible for the travel arrangements from their command to 
the next training installation, and the IMSO at the final 
training installation is responsible for arranging the IMS’s 
travel back home.  IMS in short iteration courses, the SCO will 
normally arrange round trip travel.  It is essential that the 
IMSO ensures that the travel arrangements to the IMS’s next 
destination are in order.  En-route travel message shall be 
prepared for the SCO or the gaining training activity.

5-2 Passports and Visas.  The host nation government is
responsible for issuing necessary passports and for obtaining
visas for entry into the U.S.  It is essential that the
passports and visas for IMS and their dependents are valid for
the entire duration of the IMS training period.  Upon arrival
IMS and dependent visas will be stamped with an oval that has
“D/S” in it.  This stands for Duration of Status and status
termination is determined based on the End Date on the last
training line of the IMS ITO.  IMSOs should check the expiration
dates on passports and visas to ensure the date is after, or at
least on, the last date of the ITO.  IMS and their dependents,
who have passports expiring before the departure should contact
their embassy or consulate for replacements.  For visas that
expire before departure, the need for replacement depends on
circumstances.  IMS can depart the U.S. on expired visas, they
just cannot reenter the U.S.  If IMS is attending long term
courses where they may travel home on leave or emergency leave,
then visa replacement may be prudent.  IMS can coordinate with
their embassy in D.C. to assist in request with U.S. State
Department Diplomatic Liaison Division.  IMS can also work
directly with U.S. State Department.  Details of the process can
be found at:        https://travel.state.gov/content/travel/en/us-
visas/other-visa-categories/renewing-visas-for-foreignmilitary-
stationed-in-u-s.html

1. Foreign visitors arriving via air or sea no longer need to
complete paper Customs and Border Protection (CBP) Form I-94 or
I-94W.  Those who need to prove their legal-visitor status can
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access their CBP arrival/departure record information online.  CBP 
now gathers travelers’ arrival/departure information automatically 
from their electronic travel records.  Because advance information 
is only transmitted for air and sea travelers, CBP will still 
issue a paper Form I-94 at land border ports of entry.  If 
travelers need the information from their Form I-94 admission, 
they will need to get their I-94 number.  To obtain their number 
they should go to the following site: https://i94.cbp.dhs.gov/I94/
#/home.
2. Upon arrival, a CBP officer stamps the travel document of each 
arriving non-immigrant traveler with the admission date, the class 
of admission, and the date that the traveler is admitted until. 
If a traveler would like a paper Form I-94; one can be requested 
during the inspection process.  All
requests will be accommodated in a secondary setting.
Upon exiting the U.S., travelers previously issued a paper Form 
I-94 should surrender it to the commercial carrier or to CBP upon 
departure.  Otherwise, CBP will record the departure 
electronically via manifest information provided by the carrier or 
by CBP.

3. IMSOs at the first training site should review all 
international students’ visas in order to revalidate and ensure 
conditions of automatic revalidation of the I-94 are met to comply 
with Department of Homeland Security (DHS).  SCOs will brief 
students prior to departing country.  The I-94 admission record is 
created electronically and maintained in U.S. CBP systems.  IMSs 
are encouraged to access the website and print out a copy of the 
1-94 as soon as they can.  IMSOs should be prepared to provide 
assistance.  IMSOs will assist IMSs who experience difficulty 
accessing computers and/or printers.  IMSs that have country 
liaison office representation should be assisted by their 
representatives.

4. International students lawfully admitted into the U.S. are no 
longer required to be in possession of a preprinted Form I-94. The 
I-94 admission record is created electronically and maintained in 
CBP systems.  A copy of the admission record printed from the CBP 
website constitutes a lawful record of admission.  For more 
information, go to

5. https://i94.cbp.dhs.gov/I94/#/home.  CBP will verify the I-94 
electronically to validate an expired visa if the traveler 

6. meets the conditions of automatic revalidation.  If entry 
occurred prior to automation, a paper form must be presented in

7. order to comply with validation requirements.  Form B.4 is a 
sample of Form I-102, Application for Replacement /Initial
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Nonimmigrant Arrival-Departure Document and is used to apply for 
a new or replacement Form I-94 Nonimmigrant Arrival-Departure 
Document.  Go to   
https://www.uscis.gov/sites/default/files/document/forms/i-
102.pdf for further instructions.

5. IMS who are members of the Armed Forces of North Atlantic
Treaty Organization (NATO) countries are exempt from any
requirement for visas they will travel on NATO orders instead.
However, “NATO-2” visa issuance will alleviate confusion that
could occur during entry into the U.S. or subsequent check of
legal status within the U.S. Dependents of NATO Armed Forces
personnel are entitled to "NATO-2" visas.  Civilian IMS from NATO
countries and their dependents are entitled to "NATO-6" visas.
IMS from other than NATO countries and their dependents are
authorized and will be issued "A-2" visas.
Note: Taiwan IMS who will be in the U.S. for less than 90 days
may arrive/enter the U.S. under the Electronic System for Travel
Authorization (ESTA), or issued B1/B2 Visas for longer than 90
days.  Pursuant to the Taiwan Relations Act and 9 FAM 402.3-
5(I), Representatives of Taiwan may not receive "A" or "G" non-
immigrant visas.  Instead, representatives of Taiwan (including
their immediate family members) who would otherwise qualify for
an A-2 visa will receive a B-1/B-2 visa.  When adjudicating these
B-1/B-2 visas for representatives of Taiwan and their immediate
family members, Consular officers may annotate the visas to
specify the anticipated period of stay for assignments exceeding
180 days.

6. IMS and dependents who have been admitted to the U.S. on
official visas are exempt from the provisions of the Immigration
and Naturalization Act pertaining to registration, fingerprinting
and reporting of address, unless the IMS’s status changes and
they are no longer pursuing the training as per their ITO.

7. IMS training in the United States are responsible for
securing any necessary in-transit visas needed for return travel
by contacting their embassy.  Flight reservations for return home
travel for IMS with United States Government (USG) funded travel
should be made at an early date to decide necessary routing.
IMSOs should discuss a flight itinerary with an IMS, and based on
the airline routing, the IMS will work with his embassy in
determining if an in-transit visa will be needed. When visas are
required, IMS should forward their passports and documentation to
their embassies early enough to be processed
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and returned before graduating from the last phase of training. 
Some in-transit visas can be obtained online.  

8. Additional information regarding Visa policy can be found at
State Department’s web site:
https://travel.state.gov/content/travel.html.

5-3 Travel Funding for IMS.  Guidance in the appropriate handling
of U.S. funded travel for IMS is defined in the JSCET, the Joint
Travel Regulation (JTR), and DSCA Manual 5105.38-M, E-SAMM.  
Contact NETSAFA CPMs for questions regarding rules and regulations 
of U.S. Government funded travel.

1. When travel/transportation is included in the USG training
program the baggage weight allowances described below are
authorized for IMS when travel costs are charged to the U.S.
funded program, and apply to both oversea travel and travel
to U.S. training installations.  Baggage in excess of the amount
authorized in this regulation will be at the expense of the IMS
or their government. Note: When considering the authorized 
baggage information below , IMSOs should be aware that airlines 
charge passengers for a first and/or second checked bag.  So far, 
minimal change has occurred regarding U.S. Government funded 
travel, provided the passengers are traveling on Unrestricted 
Coach Class (YCA) fares or Capacity Controlled Class (CA) fares.  
IMSOs should ensure that IMS utilized these fare codes and are 
booked on government contract carriers. Inform NETSAFA if an IMS 
experiences any variation in this situation.

2. Baggage is authorized for IMS under certain conditions
(length of training and type of course).  Training duration
indicated in paragraphs (a) through (d) below will be determined
using the report date for the first course and the projected
graduation date for the last course.

a. Two pieces of checked baggage, not to exceed carrier
stipulations, are authorized for IMS receiving Travel and Living 
Allowance (TLA) when education/training is less than 12 weeks.   

b. Three pieces of checked baggage, not to exceed carrier
stipulations, are authorized for IMS receiving TLA when training 
is 13 to 22 weeks.   
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c. Four pieces of checked baggage, not to exceed carrier
stipulations, are authorized for IMS receiving TLA for 24 weeks 
and longer.  

d. In addition to the above allowances, one additional
piece of baggage is allowed for students, with authorized 
accompanied dependents, attending the Professional Military 
Education, Graduate, and Postgraduate Programs (as listed in the 
E-SAMM, Table  C10.T11) and for IMS attending flight training.

e. Baggage size, dimensions, and weight, will conform to
carrier stipulations.  Baggage must accompany the IMS.  No 
change in baggage allowances will be made after students have 
departed country.  

f. Payment for the authorized baggage above the airline
international limits of 2 pieces of luggage and 50 pounds each 
has become more problematic.  A variety of methods can be used, 
and IMSOs should work closely with each IMS to decide the best 
procedure.  

(1) Payment can be done through Miscellaneous Charge
Orders (MCOs), which are general purpose vouchers, accepted by 
the airlines.  However, many travel offices are reluctant to 
prepare and issue an MCO, because they can be an administrative 
burden.  

(2) It may be more expedient for the IMS to pay for
the excess baggage and seek reimbursement.  This can be done in 
two ways:  

(a) The IMS can go to the airport in advance,
pay for the excess baggage, and submit the receipt to the IMSO 
in time to include the charges in the IMS’s final pay voucher. 

(b) The IMS can pay for the excess baggage at
the airport, retain the receipt, and collect reimbursement after 
filing a claim with the SCO upon arrival at their country of 
origin.  

(3) Regardless of the method used to pay for excess
baggage, IMS (or their government) are responsible for the cost 
of all excess pieces and/or weight above and beyond the 
authorized U.S. Government limit. 
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3. When travel/transportation is funded by the country.  The
cost of transporting FMS IMS personal excess baggage is the
responsibility of IMS or their country.

4. Excess Baggage Embargo.  Due to increased security
restrictions excess baggage embargos are routinely imposed by
the airlines thus creating a problem for an IMS who is
authorized excess baggage.  Seasons of baggage embargos are
determined by the airlines and apply to travel to certain
countries.  In these instances, IMSOs should compare the cost to
transport the excess baggage via the postal service and a
courier service, and use the more cost effective service.
Unfortunately, in some instances there may be no way to
transport the excess baggage, as the postal and courier services
do not deliver to certain countries.  Expenses incurred due to
the transportation of excess baggage can be accommodated within
the IMS’s travel expense/pay settlement.

5-4. Travel by Privately Owned Vehicles (POV).  If the ITO
authorizes POV travel, it is important that the IMSO confirm
with the IMS that POV travel to the next destination is desired.
When all or partial travel is performed by POV in CONUS, only
the IMS who is authorized for POV travel and is responsible for
paying for the POV operating expenses is entitled to a monetary
allowance in lieu of transportation.  This monetary allowance
will be paid at the currently authorized rate for official
highway distance per the JTR.

1. Reimbursement will be limited to the official distance from
the departing training installation to the next training
installation or point of departure specified in the ITO, and
should not exceed the normal economy class commercial air fare.
Living allowance will be authorized for a period not to exceed
constructive travel time by air.  If the IMS travels as a
passenger in a POV, they are not entitled to mileage, but are
entitled to living allowance in a travel status.

5-5. IMS Driver's Licenses.  International Military Students
(IMS) on “A”, or “G”, visas are no longer eligible to receive a
U.S. state driver’s license because they may be eligible for
diplomatic privileges and immunities. In order for an IMS to
apply for a U.S. state driver’s license, the IMS must have a
“Non-Eligibility Letter” issued by the Military Activity Per DOS
Note 21-2038 November 19, 2021 Department of State has changed
their policy concerning “Non-Eligibility” letters for NATO visa
holders and NATO IMS will be processed through existing issuance
policies and procedures.
Note: IMSOs should verify individual State requirements.
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Chapter 6  

International Military Student On-Site Administration 

6-1 IMS Arrival Information.  Particular emphasis should be
placed on the initial reception of the IMS at each training
installation.  Whenever possible, personnel of equal rank should
meet arriving IMS, especially in cases of flag rank.  Assistance
to dependents should be provided when necessary and when it does
not create undue expense to the training activity.  An atmosphere
of welcome, courtesy, efficiency, patience, and consideration is
essential.

1. IMSOs will brief all IMS, either individually or as a group,
as soon as possible after the IMS arrive at the training
installation.  JSCET, para 10-13 provides a list of required
topics.  Suggested items to be covered are contained in
the Arrival Briefing Checklist Checklist C.2.

6-2 Student Control Number (SCN) Assignment/U.S. ID Card Issue.
The SCN is used for student tracking in the Security Assistance
Network (SAN), and is automatically assigned to an IMS when the
SCO enters his/her named into the SAN for the first time.  The
SCN remains with the IMS’s name within the SAN system, and is
used again if the IMS is enrolled in the SAN for future training
activities.  The eight character SCN consists of the two alpha-
character Country Code, followed by six numeric characters
(e.g., CN123456.)

1. On 4 June 2020, SECDEF directed DoD to transition IMSs from
Command Access Cards (CAC) to the NEXT GEN USID and as
applicable, NIPRNet Enterprise Alternate Token System (NEATS)
for token access.  IMSO shall submit NEATS token request
directly to NETSAFA refer to section 2.2.2 of the IMSO Guide for
NEATS process.  IMS are not to be issued a CAC.  The only
exceptions are for PEPs and CLOs.  Only NEXT GEN USID cards will
be issued to each IMS and accompanying dependents authorized on
their ITO by the first training installation in accordance with
BUPERSINST 1750.10 series, MCO P5512.11 and other appropriate
directives.  If the ITO does not reflect dates for all training
lines, contact NETSAFA.  IMS's ITOs will be endorsed upon
issuance and return of NEXT GEN USID cards.  IMSOs will
maintain/record log of turn-in and/or destruction of all IMS
NEXT GEN USID cards for a 3-year period.  This is especially
important for IMSs dropped from training (medical,
disenrollment, etc.), should that IMS return for training they
may be re-issued a new NEXT GEN USID card.  A letter of NEXT GEN
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USID card disposition from the previous command may be generated 
citing its accountability.  This action precludes security 
issues at some sites that will NOT re-issue a NEXT GEN USID card 
for a returning IMS unless prior NEXT GEN USID card 
destruction/turn-in is accounted for via formal letter.  
Therefore, IMSOs at the last training installation should 
collect, log and/or destroy the NEXT GEN USID card prior to the 
IMS’s final departure, and report action in SC-TMS SANWeb 
departure report.  IMS may NOT retain an NEXT GEN USID card as a 
souvenir.  

2. DoD Draft Memorandum dated 05 November 2010 addresses
removal of Social Security Number from all DoD issued ID cards.
Changes are being made with issue of new cards as they expire
and new NEXT GEN ID cards will have a 10-digit number visible.
However, IMS I.D. Cards, which are generated by the Real Time
Automated Personnel Identification System (RAPIDS)/Defense
Enrollment Eligibility Reporting System (DEERS) are used to
assign a Foreign ID Number (FIN) for the international student.
The FIN is an alphanumeric designator generated by DEERS for DoD
tracking purposes and is followed by an F (e.g., 900-00-4231F)
so as to not confuse it with a SSN.  The FIN is readily
available for student records when requested by the IMS at time
of ID card issue.  RAPIDS will also enroll the international
student and, if applicable, their family into DEERS.  Their
enrollment in DEERS will be under the IMS FIN, similar to U.S.
dependents association with the military member.  Questions
concerning how to enroll an IMS or dependents should be directed
to the DEERS/RAPIDS Assistance Center, phone 1-800-372-7437.  A
FIN is NOT issued in the following circumstances:

a. International civilian trainees.

b. Students in training for one week or less and
ineligible for an ID Card. 
Note: some PSDs will not issue an ID Card unless training is 
longer than 4 weeks.  

c. International students trained at contractor facilities,
under the sponsorship of the DoD Security Cooperation Education 
and Training Program.  Other students on an exception basis when 
access to RAPIDS is not available.

Note:  In these circumstances when a FIN is not issued, the 
student is assigned a Student Control Number (SCN).  The SCN is
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used as an identification number on the ID Card, and should appear 
underneath the IMS’s photo.  

3. DD Form 1172 is the U.S. military "Application for
Uniformed Services Identification Card/DEERS Enrollment" form
used by Personnel Support Detachments (PSDs)/Personnel
Support Activities (PSAs). Detailed instructions for
completing the form are provided in BUPERSINST 1750.10.
Please note that much of the data requested is not
applicable to IMS.

4. Civilians attending FMS training must have specific benefits
identified on the ITO, such as Exchange and Commissary
privileges.  The PSD preparing their NEXT GEN ID will not
automatically authorize these privileges.  ID cards must be
explicitly registered in the Defense Biometric Identification
Database System (DBIDS).  DBIDS registration will ensure IMS only
have access to the locations IAW the ITO.  Official travel to
military installation not listed in the ITO must be approved by
the sponsoring unit via official orders.  Unofficial
(leisure) travel to other installations must be approved by the
Installation Commander or designee.  IMS cannot sponsor visitors
on DoD installation including dependents who are not authorized
on the ITO.

5. Procedures for obtaining a SCN for the exceptions listed
above are as follows:
If an IMS is not issued a FIN/ID Card, the IMSO should
inform the NETSAFA Quota Manager at DSN 459-8162 or Comm. (850)
452-8162; who will assign a 9-digit control number (SCN) for
enrollment of the IMS into Corporate Enterprise Training
Activity Resource System (CETARS). In the event that the
NETSAFA Quota Manager is not available, contact the Naval
Education and Training Professional Development and Technology
Center (NETPDC), Code N615, DSN 459-1001 ext. 1317, Comm. (850)
452-1001 ext. 1317.

a. IMSOs should ensure that the nine-character SCN appears
below the IMS’s picture on the ID card issued.  Do NOT enter the SCN 
in the block on the ID card reserved for the Social Security or 
Service Number.  Retain a copy of the ID card Application, DD Form 
1172, in the international trainee’s record.  Type on the application 
form “The Student Control Number is not a Social Security Number.” 

6-3 Uniforms, Grooming Standards, and Nametags. IMS will conform to 
the uniform and grooming standards of the training installation to 
which they are assigned.  However, the U.S. Navy
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policy that prohibits beards does not apply to IMS except in 
cases where safety or operational efficiency dictates.  
Noncompliance may be cause for disenrollment.  Situations that 
cannot be resolved locally should be referred to NETSAFA. 

1. IMS should wear a nametag while in training, as it is very
helpful to all personnel connected with training and
administration.  Nametags should indicate the equivalent U.S.
grade or rank, name, and country of the individual.  If not
issued by the IMS’s in-country representative, the IMSO at the
first training installation should ensure one is made for the
IMS.

6-4 Leave.  The foreign country may authorize leave in the U.S.
between the last training installation and the point of entry
for IMS upon completion of training before returning to home
country.  When possible, leave should be approved before the IMS
departs from his/her home country and authority included in the
IMS's ITO.  Requests for leave or leave extension upon
completion of training will not be granted unless the SCO has
amended IMS's ITO by written communication with
school(s)/training installations not later than 15 days prior to
completion of scheduled training.  Living allowance is not
payable while in a post-training leave status.  Support in the
event of medical, legal, or financial issues while in post-
training leave is the responsibility of IMS government.
Students who do not adhere to scheduled return flights will not
be the responsibility of the U.S. Government.

1. Specific regulations governing leave OCONUS and between
consecutive courses, training installations, and the last
training installation and Port of Entry (POE) are contained in
paragraph 10-37 of the JSCET.  All OCONUS leave must be approved
by the Foreign Military/Government.  In the event of an incident
outside the U.S., such as medical and legal issues, the USG
cannot provide support to the IMS.

2. An IMS may request leave for short periods to travel in
CONUS.  This leave may take place between certain courses or
phases of instruction (such as non-applicable phases or
classified phases of instruction from which the IMS is
excluded).  The IMS's request for leave may be jointly approved
by the command and Country Liaison Officer (CLO), or by NETSAFA
with concurrence of the country's representative by telephone or
via e-mail.  Continuation of IMET living allowances is
authorized during these periods.
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3. Requests for emergency leave will be submitted directly to
the SCO concerned by priority message via email, with an
information copy to NETSAFA IMSO Division and the appropriate
NETSAFA CPM, and others as appropriate.

6-5 Holidays.  Installation commanders are authorized to grant
non-chargeable leave, and IMET IMS are authorized living
allowance during the following periods:

1. Authorized holidays observed by the U.S. training
activities.

2. A total of two national or religious holidays of the IMS's
country not to exceed one (1) academic day for each holiday
authorized.  Academic progress will be the deciding factor in
each case.  Refer questionable situations to the respective
major claimant for resolution.  Defense Security Cooperation
Agency (DSCA) publishes an annual list of the two-country-
approved holidays that fall under this category.  This list can
be found at:  https://www.dscu.edu/itm?id=5.

3. Christmas holiday period when activities at training
installations have been curtailed.

4. If additional training is scheduled at another installation
immediately following the Christmas holiday period, the losing
installation will be responsible for IMS during the holiday
period.

6-6 IMSO Visit Coordination.  Periodically, the IMSO is called
upon to coordinate an international visit by dignitaries,
officers, and prospective students from other countries.  These
visits could be either as an Orientation Tour (OT) coordinated
through international training channels, or as a visit arranged
through diplomatic channels.  Some of these visits may be “self-
invited,” which are requested through diplomatic channels and
all expenses are paid by the foreign country.  See JSCET Chapter
12 for further information.

1. For OTs, the command POC will be notified by telephone,
message, e-mail, or letter from either NIPO or NETSAFA advising
of the nature of the visit and the number of people.  For other
official visits, notification will be made through the Office of
Secretary Defense (OSD) Foreign Visits System via message.  It
is very important to establish a POC at the school or activity
being visited prior to their arrival.  The command’s POC should
also establish liaison with the POCs at the activity from which
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the visitors may be arriving, and/or the next activity to be 
visited.  Checklist C.6 is a checklist to assist the IMSO in
being adequately prepared for these various types of visits.   

2. Any classified briefing, handout, or demonstration that is
to be delivered to a foreign visitor requires Navy IPO
disclosure determination and approval.  Access to Restricted
Areas (physical space restrictions), may be authorized by
training activity Commanding Officer if it is determined
classified information will NOT be compromised by visit
environment.

3. Should an IMSO become aware of a request for any foreign
visit that has not been received through the appropriate
channels (as noted above), the IMSO shall notify their
respective chain of command and their respective NETSAFA Country
Program Manager.

4. The IMSO, or visit POC, will coordinate Base Access issues
with Security contacts to confirm and resolve access issues.  To
clarify the role of Foreign Visit Requests (FVR) vice
Invitational Travel Orders (ITOs) for IMS’ on ITOs:

a. ITOs are issued for the IMS by a U.S. SCO at their
Embassy.  Only ITOs are used for IMS provided training.  ITO 
documents are more comprehensive than FVRs, and contain 
personnel details, security clearances, and training-site 
locations.  All IMS’ on ITOs are vetted for security and health 
screening clearance.  The ITOs are signed by the SCO, and the 
quotas approved through NETSAFA.   

b. An FVR request document is initiated by the country
using the DoD Foreign Visits System (FVS), usually from the 
Defense Attaché office of their Embassy in Washington D.C., 
through NIPO, then forwarded to appropriate command for visit 
approval.  This can be a site visit or conferences held on 
military facilities.  No IMS provided training is authorized 
utilizing an FVR document.  FVRs are issued just to meet request 
requirements, and do not include vetting, funding, medical 
screening, or other details listed under course training 
requirements.   

5. The Personnel Exchange Program (PEP), while not an FMS
program, is one which an IMSO may receive questions about from
Base Security, as the program has International Officer/Enlisted
personnel arriving at various commands and facilities.  PEP
personnel arrive with letters from OPNAV and a Foreign Visit

NETSAFA 
  MAY 24 

40



Request vice an ITO, so Base Security may contact you on their 
arrival.  The Command PEP personnel will be available to 
coordinate the appropriate advance check-in with Base Security. 

6-7 Enhanced Security Vetting for Continuous Recurring Access
(CRA).  Security vetting and screening requirements have been
implemented for IMS who come to the U.S. for education and
training.  Guidelines have been established in U.S. law in the
form of the National Defense Authorization Act for Fiscal Year
2021 and DoD policy signed by the Office of Under Secretary of
Defense for Intelligence and Security (OUSD I&S) dated 18 Nov
21. Applicable DoD Security Reference Documents can be found on
SC-TMS under the DoD Security Vetting tab.

1. Key requirements in this guidance are:

a. Issuing IMS next generation USID cards instead of CACs

b. IMS signing a Consolidated Consent Agreement (CCA)
regarding firearms, conduct and consent to monitoring of social 
media, and   

c. Submission of Biographic and Biometric information to
the Defense Counterintelligence and Security Agency (DCSA) for 
enhanced vetting.  These must be done for IMS to have CRA at DoD 
installations, with limited exception due to course duration or 
IMS being from Australia, Canada, New Zealand, United Kingdom 
and the United States (FIVE EYES countries).   

2. IMSOs can check the status of an IMS security vetting in
SC-TMS.  Go to Schoolhouse, select Student Training & Progress
Messages, select the link on the student’s name, select DoD
Security Vetting and Agreements tab.  The CCA, date of
Biographic info submission, date of Biometric Information and
vetting status provided by DCSA can be found on this page.
Additionally, under the Basic Info tab at the very bottom it
will state what level of U.S. equivalent security clearance the
IMS has.  This is especially important for FIVE EYES country IMS
who are not required to have enhanced security vetting if they
possess a U.S. equivalent security clearance.  IMSOs can also
check to see if the CCA is uploaded on the Student Training &
Progress Messages page at the far right of the line containing
WCN and Student Name.  Status will either be a green Available
or a red Unavailable.  If there are questions regarding an IMS’
status, contact the CPM for assistance.  For more information on
Security Screening and Vetting see ESAMM, Chap 10, para 10.8.
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6-8 Biometrics on Arrival (BOA).  Per OUSD I&S memo dated 28 Feb
2022, the exception for SCO collection of data is for countries
that have a small number of IMS traveling to the U.S. each year.
These SCOs do not have the equipment necessary for biometric
collection so they will request Biometric on Arrival (BOA)
waivers to complete collection upon arrival.  IMSOs should be
consulted regarding ability to perform this collection during
the waiver request and coordination process.

1. During these BOA exceptions, IMS must be escorted and not
receive installation Continuous Recurring Access until vetting
results are complete.  IMSOs will contact their local/unit
security manager to see if they have fingerprinting capability.
If your security manager does not have fingerprinting
capability, work with the security manager to schedule
fingerprinting appointments with the fingerprinting location
that supports your unit.  Once the Security Manager (or
supporting fingerprinting function) sends the biometrics to ABIS
(Automated Biometric Identification System) for processing,
IMSOs will need to get the Transaction Control Number (TCN) from
the Security Manager.

2. The TCN is generated when the Security Manager inputs the
biometrics in ABIS.  Once the IMSO has the TCN, go to the Basic
Information tab for the student in Security Cooperation –
Training Management System (SC-TMS).  About halfway down the
page in the Account Information section, you will see a box to

input the TCN.  For more info on TCNs, see Reference Guide D.3 
of this guide.

6-9 Security Manager Fingerprinting Process.  IMSO’s will
coordinate with their local security manager to schedule the
required fingerprints for the IMS and AFM if applicable.

1. Security managers will use the SWFT+ fingerprinting
capability to take the fingerprints.

a. Student Verification: for each student the security
manager will verify their passport and DoD ID Card. 

b. Upon verification the security manager will conduct the
fingerprinting. 

c. Include the DoD EDIPI number in the MISC field in
SWFT+. 
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d. Save the respective fingerprints as PDF files so they
can be transmitted to DoD ABIS via DoD SAFE.  The name of the 
PDF should be the last name of the individual and their EDIPI 
number (ex. GRIFFY0120211).  

2. Once the prints are captured you can either “Complete
Enrollment” or “Save to Server”.  Save the file to the server.

a. Once you have clicked save to Server go to the
Transaction Manager of WebEnroll, find your submission, and 
click the checkbox next to it.  

b. Then click the PDF View Button, select the type of hard
card format (If available select the SF 87 used for hardcopy 
submissions)  

c. Once the type of hard card is selected you will be
prompted to save as a PDF. 

d. DO NOT submit via the SWFT+ WebEnroll application.

e. The PDF fingerprint card should contain the following:
Last Name, First Name, EDIPI number, Passport information to 
include number, Date of Birth, Sex, Race, Height, Weight, Eye 
Color, Hair Color and Place of Birth.  

f. Send all completed fingerprints to ABIS via DoD SAFE
daily: (Please group as many fingerprint PDF’s into a single DoD 
SAFE submission as possible to limit the number of emails being 
sent to the ABIS team)  

(1) DoD SAFE (https://safe.apps.mil/) (You must use
your “Authentication Certificate”) 

(2) ABIS Email to be used in DoD SAFE
(bluedog@abis.biometrics.mil) 

(3) In the notes include: Organization, IMS Vetting
Fingerprint DON, ORI: IMSNAVY0M and file name (ex. IMS Vetting 
Fingerprint DON – GRIFFY012021)  

(4) Once completed send the random password to
bluedog@abis.biometrics.mil.  This email address cannot accept 
encrypted emails.  Also, include in the email: Organization, IMS 
Vetting Fingerprint DON, and ORI: IMSNAVY0M and file name (ex. 
IMS Vetting Fingerprint DON – GRIFFY012021)  
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(5) Security Management POC: DUSN S&I Personnel
Vetting: Dr. Thomas J. Griffy, thomas.griffy@navy.mil 

6-10 English Comprehension Level (ECL) Testing Requirements.     
Every IMS must be sufficiently proficient in English to participate
in and successfully complete their course of instruction.  DLIELC,
at Joint Base San Antonio (JBSA) Lackland, San Antonio TX, is
responsible for the Defense English Language Program and for
ensuring that IMS have the proper level of English comprehension.
Same applies in cases where Test of English as a Foreign Language
(TOEFL) is required, i.e., Naval Postgraduate School (NPS).

1. SCOs are responsible for conducting in-country screening of IMS
candidates before they depart their home country for the US.
The results of the in-country proficiency examination are recorded 
in Block 10 of the ITO.  However, certain country-specific waivers 
and exemptions are authorized, as a result of an annual review of 
ECL requirements.  The list of ECL, TOEFL, & OPI Exemptions is 
promulgated by DSCA, and can be found at: https://www.dscu.edu/itm.

IMSOs should review each ITO closely, ensuring that the IMS is
properly qualified to begin their training, and that any 
exemptions or waivers are in accordance with the annual DSCA 
message.  IMSOs can also get IMS ECL scores in SC-TMS.  Under 
Schoolhouse, select Student Training & Progress Messages link, 
select link on IMS name, select Test Scores tab.   

2. The IMSO or the Command Test Control Officer (TCO) must
administer the direct entry (meaning IMS did not attend DLIELC)
proficiency test within 3-5 days of IMS arrival.  If the IMS
achieves the required ECL score, they are entered into training.
Inform NETSAFA if the IMS does not achieve the required ECL
score, and schedule a second test in 1-2 working days (never the
same day).  IMSOs at initial training installations should pay
particular attention to IMS from countries that are authorized a
waiver from in-country screening ECL test, but with mandatory
direct entry ECL testing.

3. If the second test (retest) is not successful, the IMSO (or
TCO) should inform DLIELC and NETSAFA CPM.  Both must approve a
third test.  Each military service has the authority to waive
the prerequisite score or cancel training and assess penalty
charges.
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4. 332 Training Squadron Instruction (TRSI) 16-1051, 11 Dec 20,
provides updated guidance regarding English Instruction, Curriculum,
and Testing, including On-Line ECL testing.  332 TRSI can be found
at: https://www.dscu.edu/itm

5. DLIELC Instruction 1025.15, 1 Jul 17 provides ECL Test
Guidelines.  It can be found at: https://www.dlielc.edu/testing/
testing.php

6. TCOs can now choose the Online Computer Adaptive Testing
(CAT) rather than the paper version to test ECLs of international
students.  Details are located in Para 5.3.3.2 of 332 TRSI16-1051.

7. For more information, contact the DLIELC English Testing
Flight (ETF) at dli.testing@us.af.mil or (210) 671-4889.  Or
visit DLIELC website at: https://www.dscu.edu.

6-11 Distance Learning.  The DON Section of the SECNAVINST
4950.4B (3-50) has been updated to provide guidance on the policy
and implementation of Distance Learning (DL) for IMS.

1. IMS no longer have access to Navy Knowledge Online (NKO).
Students may access the following training directly through the
public DOD Cyber Exchange website https://public.cyber.mil.  If
any additional courses are needed, notify the NETSAFA Point of
Contact (POC).  Courses available to students:

a. DOD-PII-2.0 - Privacy and Personally Identifiable
Information (PII) Awareness Training

b. DOD-IAA-V12.034 - DOD Cyber Awareness Challenge 2024

Note:  Specific questions or issues will be directed to NETSAFA
IMSO Manager at usn.pensacola.netsafapensacolafl.mbx.netsafa-
imso-mgr@us.navy.mil. 
Note:  Requests for additional courses must be made by a U.S.
Military or Civilian.  IMS cannot directly request courses 
through NETSAFA.  

6-12 Contractor Provided Training.  Some of the Navy’s
international military training and education courses are
conducted by contractors at non-U.S. Government facilities.  IMS
attending courses at these training sites must have ITOs, and
their activities must be coordinated and supported in much the
same way as they are on a Navy facility.  There may be occasions
when an IMSO may either be receiving an IMS from, or sending an
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IMS to, a contractor provided training site.  When this occurs, 
IMSOs should refer to the JSCET and the E-SAMM for detailed
guidance regarding contractor-provided training.  

6-13 Requests for Information.  All requests from the media for
interviews or photographs of IMS will be referred to NETSAFA,
who will forward the request to NIPO, who in turn will forward
the request to the Assistant Secretary of Defense (Public
Affairs), for evaluation before making any commitment.  Also,
IMSOs should ensure that IMS inform their embassy prior to any
contacts with the press.  Current policy regarding the
disclosure of information is contained in the Department of the
Navy Public Affairs Policy and Regulations Manual (SECNAVINST
5720.44C).

1. Other U.S. Government Agencies.  DoD cooperates with other
U.S. Government agencies, as appropriate, in the interest of
national security.  However, to avoid undermining Security
Cooperation program objectives, training installations will not
provide non-routine information on IMS to local or other U.S.
government agencies.  IMSOs (or other staff members) at training
installations receiving requests for personal information on an
IMS from other U.S. government agencies will refer the request
to the NETSAFA CPM for action.  In addition, request for copies
of Invitational Travel Orders and background data concerning
individual IMS from local and federal government organizations
should also be forwarded to the NETSAFA CPM for action.  These
procedures will ensure that the personal requests are reviewed
by the appropriate organization, and the integrity of our
Security Cooperation programs is maintained.

2. Non-U.S. government agencies.  Requests for IMS information
submitted by non-U.S. government agencies will continue to be
processed under the Freedom of Information Act, per instructions
contained in applicable public affairs publications.

3. Out-of Channel International Requests.

a. Responding to an out-of-channel request for course
information/quotas from an international may be perceived as a 
commitment to provide U.S. training, which could undermine the 
quota allocation process and result in unauthorized/non-
releasable training being provided to a country.  Out-of-channel 
requests could include electronic, written correspondence, 
telephone, or a request received from an international military 
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student (IMS) or a foreign exchange officer assigned to a U.S. 
activity.  

b. IMSOs (or other staff members) at training
installations receiving out-of-channels requests must advise the 
requestor that the training installation is not authorized to 
provide the information.  Training installations must advise the 
requestor that their request must be forwarded to the country’s 
Ministry of Defense for submission through the U.S. Embassy to 
the appropriate U.S. military organization.  (The foreign 
country and USG organizations responsible for requesting, 
reviewing, and approving the release of course information may 
vary slightly, based on the sponsoring program.)  

4. Any questions regarding the releasability of information
regarding IMS should be resolved by the NETSAFA CPM.

6-14 Insider Threat Awareness.  The purpose of Insider Threat
Awareness is to aid international military students in
understanding how to identify and report insider threat
indicators.  The goal is to deter threats and detect potential
issues early on before a problem occurs.  At the first training
installation, during orientation and arrival briefings, IMSOs
should ensure IMS watch the Insider Threat Awareness Video.  The
video can be found at DSCU website.
https://www.dscu.edu/learning-guides?id=43 Completion should be
recorded using a Free Text Progress Message in SC-TMS so that
subsequent training activities can determine if an IMS needs to
view the video or not.

Behaviors/Activities Considered Potential Risk Indicators.
1. The following are behaviors and actions considered potential
risk indicators for insider threat:

a. Drug or alcohol abuse

b. Undiagnosed or untreated medical or mental health
conditions 

c. Criminal activity

d. Interest in weapons or purchase of weapons

e. Unexplained travel
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f. Attempting to access information not necessary to
studies or mission 

g. Unexplained absences

h. Financial problems

i. Sudden outbursts of anger or threats of violence

j. Unexplained affluence/money

k. Failure to follow security protocol

l. Signs of recruitment or elicitation

2. If students observe any of the previously-mentioned
behaviors or activities, (see Form B.5) they should:

a. Report it to an instructor

b. Report it to support personnel

c. Report it to the IMSO
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Chapter 7  

International Military Student Health Matters 

7-1 Medical and Dental Care.  The JSCET Chapter 8 and ESAMM Chapter 10,
para.  10.8 & 10.9, provide detailed guidance concerning Medical
Requirements and Healthcare.  These policy documents cover the required
examinations, eligibility, benefits and reimbursement for healthcare, 
hospitalization, and other medical topics.  The JSCET and ESAMM will be 
used as a guide for those involved in the administration of IMS at 
various levels, including SCOs, IMSOs, training field activities, and 
DoD health care providers.  The JSCET and ESAMM can be found on the 
International Training Management Website: https://www.dscu.edu/itm

1. The ESAMM C10.9 and JSCET Chapter 8 describe a variety of
circumstances regarding health care for IMS and their dependents.
Regardless of the situation, however, IMSOs should remember the
fundamental policy regarding IMS health care:  “All IMS and family
members authorized on the ITO must have health care coverage for the
duration of their training. Failure to have health care coverage on IMS
and authorized dependent(s) will result in IMS being withdrawn from
training and returned home.  Family members cannot be authorized on the
ITO without health care coverage."

2. Many military treatment facilities are not familiar with medical
benefits authorized foreign personnel.  A POC should be established
between the IMSO and the military treatment facility MTFs) and civilian
healthcare facilities that treat students. Health care benefits and
financial considerations covering most IMS medical and dental
contingencies are outlined in ESAMM C10.9 and Chapter 8 of the JSCET.
They cover most contingencies but are not all inclusive.  IMSOs should
provide the treatment facility with a copy of the JSCET chapter that
pertains to medical and dental care.  Bureau of Medicine (BUMED)
guidance is provided in NAVMEDCOMINST 6320.3B.  IMSOs should inform the
student what to provide to the MTF or civilian healthcare facility and
help them to know how to explain their ITO for care and billing
purposes.  This will help to ensure proper billing so that a good
partnership is maintained with MTFs and civilian healthcare facilities.
Improper billing in the past has damaged partnerships with healthcare
facilities and they have denied treating IMSs.  IMS should provide their
ITO to the front desk and show them the responsible party for billing
which is under section 12.b.  The quickest way for a bill to be paid is
IMSO submission via email to the medical billing address.  POCs at the
treatment facilities should be informed that the medical billing office
at NETSAFA may call the billing office on the IMS’s behalf.
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3. Prosthetic devices, hearing aids, orthopedic footwear, and
similar adjuncts are not authorized for non-NATO IMS. Dental care is
provided for non-NATO IMS only on an emergency, reimbursable basis
where needed for relief of painful or acute conditions.  Routine dental
care must be received from civilian sources.  NATO IMS receive the same
dental care as U.S. military personnel.  Eyeglasses are furnished when
required for training only if not available through civilian sources.  

7-2 Serious Illness, Injury, or Death.  Chapter 8 of the JSCET provides
detailed guidance regarding major medical cases or fatalities of an IMS or
dependent.  Chapter 8 of the JSCET also provides information in the event
that an IMS requires hospitalization.  IMSOs should review this important
information carefully, and work with other members of their training
activity staff to develop Standard Operating Procedures (SOPs) for such an
incident.  The SOPs should reflect a training activity’s current
procedures for responding to an injury or illness of a U.S. student, but
should also reflect an awareness of the potential diplomatic, political,
and media sensitivities involved in an international student incident.
Initial steps should include:

a. Record the date and time of the notification and the name,
organization, and telephone number of the individual making the 
notification.  

b. Get the details of the incident, to include:

c. Name and country.

d. Nature of the Incident (Illness, Injury or Death).

e. Other Circumstances (DUI/DWI, accident, or other
(specify))

f. Location of incident.

g. Others involved in the incident/witness (name, address, and
telephone number).

h. Description of the incident.

1. Action(s) taken after receiving the incident report:

a. Record the name, position, date and time of persons
notified. 

b. Record other actions taken.

c. Contact the NETSAFA CPM by phone.
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d. Keep a log of everything that occurs (including date
and time of occurrence). 

e. Report to the chain of command on a daily basis until
the final report. 

2. MILDEP medical facilities will retain IMS inpatient records,
as required, and will ensure a copy is included in the IMS's
medical records returned to the country.

3. NETSAFA will be notified via message when an IMS's
authorized dependents are hospitalized due to illness, injury,
or a condition that affects IMS's training, has political
implications, or will result in excessive medical charges.  The
notification will include all pertinent information, prognosis,
estimated charges and whether or not the medical conditions will
preclude the IMS from successful completion of his or her
training.

4. If an IMS under DON sponsorship dies while undergoing
training with U.S. forces or while traveling in relation to the
training, the remains will generally become the responsibility
of the DON until return to the home country's custody can be
made.  The cognizant command will send a casualty report, by
immediate message, to NIPO, NETSAFA, the foreign Attaché, and
other agencies in the chain of command as appropriate.  Basic
guidance is contained in the Decedent Affairs Manual
(NAVMEDCOMINST 5360.1).  Detailed instructions on actions to be
taken with respect to the remains will be provided by United
States Navy Mortuary Affairs Office (MAO), Great Lakes, IL,
after coordination with NIPO.

5. Bills for services in connection with the disposition of a
deceased IMS under the IMET, and other grant programs will be
forwarded to NETSAFA for addition of the appropriate accounting
data before submitting for payment.  Bills for services in
connection with the disposition of remains of IMS in FMS
training will be forwarded to NETSAFA, the appropriate embassy,
or healthcare insurance provider, whichever is listed on the
Invitational Travel Orders for payment of medical expenses.

7-3 Medical Billing Procedures.  The ITO (Block 12b of the TMS
generated ITO) must specify the correct source for reimbursement
of medical costs.  If the IMS is covered under a reciprocal
health care agreement between the U.S. and the IMS’s country,
the agreement will take precedence over the charges listed in
the JSCET.  NATO IMS authorized accompanying dependents are
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entitled to the same medical care (with the exception of TRICARE 
for inpatient care) as U.S. military dependents.  Non-NATO IMS 
may be provided medical care on a space available basis when 
facilities and staffing permit.  Eligibility does not mean free 
care.  Figure 2.8 outlines medical care entitlements and 
reimbursement sources for IMS and their ITO-authorized 
dependents.  

1. Military Clinics and Hospital Medical Care:  Military
medical treatment facilities must forward medical bills to:
NETSAFA N81 (for IMET/grant program and specified FMS cases
whereby agreement is in place for NETSAFA to charge the case;
RSNF bills are an example of this scenario), the Foreign
Government (for other FMS cases), or the student, as appropriate
and indicated in the ITO.

2. IMET/Grant Program.  If a Government Treatment Facility
treats an IMET/grant program IMS, the ITO indicates that the
IMET/grant program is responsible for payment, and criteria for
treatment under the JSCET are met, the Military Treatment
Facility will forward invoices to their Central Billing Office A
complete ITO should accompany all invoices.  These invoices are
forwarded to the NETSAFA CPM and NETSAFA N81.
The following billing address (which is found in Block 12b of
the ITO):

Commanding Officer (Code N-8)  
Naval Education and Training Security Assistance Field 
Activity  
250 Dallas Street, Suite B  
Pensacola, FL  32508-5269  

3. When reimbursement is the responsibility of the FMS case or
the foreign government, the Military Treatment Facility forwards
invoices to their Central Billing Office –A complete ITO should
accompany invoices.  These invoices are forwarded to the
appropriate office for payment (if chargeable to the FMS case –
as directed on the ITO; if chargeable to foreign government
representative in Washington, D.C., to the address on the ITO).
Before forwarding FMS IMS medical bills to NETSAFA for payment,
contact the NETSAFA CPM and NETSAFA N81 to verify that a medical
line is included in the case.  Billing for dependents is done at
the local level, with bills being sent to private insurance
companies or foreign government as per the ITO.  Dependent bills
will not be forwarded to NETSAFA. Ultimate payment
responsibility resides with the student.

NETSAFA 
  MAY 24 

53



4. Civilian Clinic and Hospital Medical Care.  IMSOs should brief
IMS on the difference between Emergency, Urgent, Referred and
Routine care.  The distinction between Inpatient and Outpatient
should also be discussed.  IMSOs shall follow  emergency care and
billing procedures as outlined in Chapter 8 of the JSCET
Procedures may be printed for emergency reference.  A link for the
JSCET can be found on the International Training Management
website: https://www.dscu.edu/itm

5. IMET/grant program.  If a Civilian Treatment Facility treats
an IMET/grant program IMS, the ITO indicates that the IMET/grant
program is responsible for payment, and criteria for
treatment under the JSCET are met, civilian facilities will
forward invoice, ITO and OMB 0938-1197 Form 1500 to NETSAF N81.
For referred care, the bill and ITO with completed NAVMED Form
2161 (Referral for Civilian Care) are required.  The following is
the billing address (which is found in Block 12b of the ITO):(same
as above)

6. When reimbursement is the responsibility of the FMS case or
the foreign government, the Civilian Treatment Facility forwards
invoices to the appropriate office for payment (if chargeable to
the FMS case, as directed on the ITO; if chargeable to foreign
government representative in Washington, D.C., to the address on 
the ITO).  If IMS has private medical insurance, bills will be 
sent to the insurance company.

7. Billing for dependents is done at the local level, with bills
being sent to private insurance companies or foreign government
as per the ITO.  Dependent bills will not be forwarded to
NETSAFA.  Ultimate payment responsibility resides with the
student.

8. NATO/PfP unique coverage.  If stated as authorized in the
ITO, NATO/PfP IMS and/or dependents may have their bills sent to
Tricare for outpatient care that is a referral from a MTF.
Inpatient care is not covered by Tricare and IMS must procure
private insurance to cover this type of care.  For care in
civilian facilities, bill and ITO with completed NAVMED Form 2161
(Referral for Civilian Care) are required.

9. For general questions regarding billing process, procedures,
and entitlements, NETSAFA N81 billing POCs can be reached at:
usn.pensacola.netsafapensacolafl.mbx.netsafa-medical-
billing@us.navy.mil

Note: Do not send PII or HIPPA info to this address.  This
information will be encrypted and sent via DOD Safe.  This email 
address
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should be provided to MTF Central Billing Office and may 
be provided to Civilian Treatment Facility as needed. 

10. If a bill is sent to the student, they should
immediately bring the bill to the IMSO who shall in turn
will forward the bill via the email address in paragraph
7-3.9 or through the mail at the address found in Block
12b of the ITO.
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Chapter 8  

IMS Training and Academic Records and Reports 

8-1 IMS Training Records.  The IMSO at the first training
activity will initiate a training record on each IMS.  IMSOs at 
successive training installations will maintain IMS records, and 
will ensure that all necessary and appropriate documents are 
included.  As a minimum, this record will contain the following: 

a. Copy of ITO, amendments, and endorsements.

b. Application for ID cards for IMS and their authorized
accompanying dependents. 

c. Instructor comments on the IMS's performance.

d. Record of courses attended.

e. International Student Academic Reports.

f. Correspondence relating to indebtedness, traffic
violations, civil law violations and charges, and other 
disciplinary incidents.  

g. Record of individual counseling given the IMS.

h. Record of DoD FSP activities that IMS either
participated in or were given the opportunity to participate in. 

i. Any other documents that would be beneficial to IMSOs
at subsequent training locations.  
Note:  Records will be maintained and disposed IAW Navy records 
management instructions.  

8-2 Biographical Records.  The IMSO will maintain biographical
records on IMS within SC-TMS.  The IMSO will maintain a copy of
biographical records that are useful for training activity and
student admission.  The IMSO must report infractions, incidents
of a serious nature, or serious medical conditions or
emergencies involving either IMS or their Family members.  The
initial report will be by telephone followed immediately by a
priority message.  For Navy sponsored IMS, reports will be made
to NIPO via the chain of command and NETSAFA.  For Marine Corps
sponsored IMS, reports will be made to USMC/CG, Marine Corps
Security Cooperation Group (MCSCG) via the chain of command,
with information copies to NIPO and NETSAFA.  For Coast Guard
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sponsored IMS, reports will be made to USCG International 
Affairs (G–CI) via the chain of command, with information copies 
to NIPO and NETSAFA.  

8-3 IMS Progress Reports.  IMSOs should use the SAN/SC-TMS9 to
provide student Arrival, Enrollment, Completion, Attrition,
Delay and other type Progress Messages.  The cognizant reporting
activity will send these reports to NETSAFA via the SAN/SC-TMS.
Information copies are sent to the respective major claimant (if
other than NETC), the functional commander, and other addressees
as required.  A copy of all progress reports will be placed in
the student’s file.

1. Arrival/Enrollment Reports.  Arrival messages should be
sent once student arrives at the training location.  Enrollment
messages are prepared when students actually begin training, and
should be submitted within three working days after course
commencement.  IMSOs should ensure IMS are fully qualified per
MASL prerequisites, such as ECL scores and physical/mental
fitness before enrolling the IMS in training.  If IMS does meet
the prerequisites, the NETSAFA CPM should be notified.  These
messages are sent automatically to the NETSAFA CPM and the SCOs
who desire these reports.  The next senior in the IMSOs chain of
command should also be forwarded an information copy.  IMSOs are
only able to update blank fields on the SAN/SC-TMS:

a. Progress reports should be sent by the IMSO at the
first training installation after the FIN has been assigned. 

b. After the Arrival/Enrollment Message are sent, a red
check mark should appear over the report icon (handshake). 

c. Departure/Completion Message.  Use the SAN/SC-TMS to
send Departure/Completion Messages when students graduate and 
travel to their next training or return home.  Updates should be 
submitted within three working days after course completion or 
termination.  

d. Include the route travel information in the remarks
section of the message if the student is returning to home 
country or going to another installation for follow-on training. 

e. After the Departure/Completion Message is sent, a red
check mark will appear over the report icon (airplane). 

2. It is not necessary to include the SCO on completion
reports.  Progress reports of a negative nature (i.e., student
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disciplinary problems) should be coordinated with higher 
authority prior to submission.  NIPO is normally not an 
information addressee on routine commencement or intermediate 
completion reports, but should be included if a failure report 
is issued due to an academic, disciplinary, or medical reason. 

3. The Embassy of Egypt is to be included on all completion
reports for Egyptian students.

4. No-Show, Failure, Delayed Completion, Correction or Student
Progress Issues.  These issues are outlined in the JSCET.
Messages should be submitted within one working day after
determination of course failure, no-show, or for delayed
completion caused by nonacademic or non-disciplinary factors.
Please note that the IMSO cannot change data once it is entered.
If data has been entered incorrectly, send a Progress Report and
note the change in the remarks.

8-4 IMS Navy Flight Training Reports.  Simulator hours should be
reported in the same manner as aircraft hours.  Notify the
NETSAFA CPM for a change in Estimated Completion Date (ECD) of
one week or more and the reason for the change.  Get approval
via telephone or in writing prior to any extension in training
or additional flight/simulator hours.  An estimate of those
additional flight hours is required if an ECD change is required
and additional flight hours or simulator hours will exceed the
programmed syllabus hours.  Additional hours will not be flown
until authorized by appropriate CPM.  The Completion Message
should include the following:

a. Actual syllabus hours flown by aircraft type and FY.

b. Actual syllabus simulator hours by simulator type and
FY.

c. Dates of holidays observed during course enrollment.

d. Dates of student’s sick leave taken during course
enrollment.

e. Dates of student’s annual leave taken during course
enrollment.

f. Incomplete or lack of document of {(4 a-e) above},
items will delay financial action.

g. Exceptions to preparing International Trainee Progress
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Messages for each course of instruction are as follows: 

1. Aircrew and Fleet Replacement Aviation Maintenance Program
training.  International Trainee Status Reports for aircrew and
training under COMUSFLTCOM, COMPACFLT, and COMNAVAIRESFOR will
be the responsibility of COMNAVAIRLANT, COMNAVAIRPAC, or
COMNAVAIRESFOR respectively, and will be provided at the
following intervals:

a. Within three working days after commencement of the
first training line. 

b. Within three working days after completion of the
last training line or termination.  The completion report will 
contain the following statement in the remarks section: "All 
training was completed according to student's original 
schedule."  The actual dates and types of leave taken by the 
student since enrollment will also be shown in the remarks 
section.  

c. Within one working day after determination of
 course failure or no-show. 

d. Within one working day after determination of delayed
 completion caused by non-academic or non-disciplinary 
 factors.  

e. Within one working day after determination of
 deviation from student's original schedule.  
Note:  The Naval Air Maintenance Training Group Detachments and
Units under the Commanding Officer (CO) Naval Air Maintenance 
Training Group and NETC will continue to report as per d. above.  

2. Naval Systems Command training.  Multiple training sites
(for example, Naval Ordnance Management Training for senior
officers or OJT supply) billed or tracked as one line of
training under the Systems Commands will be reported in
accordance with para.1. above.

3. Contractor training reports.  On a quarterly basis, the
contractor and the program manager will provide the NETSAFA,
MCSCG, or COMDT COGARD (CG-ACO-I), a report listing all IMS
currently receiving training and all students expected to
receive training within the next six months.  IMSOs should refer
to NIPO Instruction 4950.1 of April 6, 2005 for detailed
guidance.
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4. Training under materiel case.  Training under a materiel case
should be reported in accordance with the procedures outlined in
this section, or as directed by the cognizant major claimant.  If
unique training situations should occur, the major claimants will
provide reporting guidelines.
Note:  Progress Messages serve as NETSAFA’s standard IMS incident
reporting method.  Progress Messages (PM) at a minimum must 
include:

IMSO has notified their Commanding Officer (CO) of the following 5 
W’s (Who, What, When, Where, Why)   

 1 - Who (IMS LAST NAME, FIRST NAME, ITO#)   

2 - What (Incident Description/PM Details)   

3 - When (Time/DD/MMM/YY)   

4 - Where (PMASL assigned and Specific Location of Incident) 

5 - Why (Justification/Reason/COA)   

IMSOs must review Progress Message Glossary and Appendix I (IMSO 
Category 1-4) Desk Top Reference provides Progress Message as well 
as required IMSO actions to include reporting guidance and time 
constraints.  

8-5 IMS Academic Reporting.  The International Student Academic
Report (DD Form 2496) provides the major source of information
available to the SCO and the foreign government to assess the IMS's 
academic achievement.  The reports are required for all IMS in all 
types training conducted under the DON SCTP including classroom 
training, on-the-job training, observer ship training, and 
contractor training.  The training installation should designate a 
faculty member or other staff member as the Evaluator, responsible 
for completing the academic report.  The IMSO is responsible for 
ensuring that an academic report is completed for every course in 
which an IMS is enrolled and there should be one academic report 
for each line of training.  The IMSO must also ensure that each 
academic report is included in the IMS Training Record, IAW para. 
10-28 of the JSCET.

1. The SANWeb is used to upload the IMS Academic Report.  This
will enable the SCOs, Combatant Command (COCOM) staff, and other
authorized persons to view the academic report as soon as the
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IMS has completed a course, and eliminates the need for hard 
copy documents.  The system will also generate an automatic e-
mail to the SCO and the Military Service office when an academic 
report is uploaded into the SAN.  IMSOs should begin utilizing 
the online academic report capability of the SANWeb.  Academic 
report can be uploaded to the SANWeb as follows:  

a. Log onto the SANWeb under Training Tab.

b. Go to “Students” tab, Arrow down to Academic Report
(DD2496). 

c. There can only be one report upload per student per
training line. 

d. Perform ONE UPLOAD at a time.

e. The maximum file size is 25MB, but the ZIP File should
be used for files of this size.  "Save as other" may be used to 
reduce size of the PDF as well

f. The “Select File” column allows you to view an uploaded
academic report.  The “Action” column allows you to save, update 
or delete an academic report.  

g. When a hard copy Student Academic Report is submitted,
the following instructions relate to the parts (or elements) in 
Figure 2.11, which may be reproduced as needed.  

(1) Forwarding Address.  The next training site if
subsequent training is scheduled, or the country SCO if course is 
the last training sequence.  

(2) From.  Name and address of training installation
preparing the form. 

(3) Name.  Enter trainee's name (last, first, middle)
as shown on student's ITO. 

(4) Grade.  Enter trainee's rate or rank (if
civilian, enter CIV).  Also enter trainee's U.S. paygrade 
equivalency (for example, CAPT, 0-6; SGT, E-5; CIV, GS-13). 

(5) Country.  Enter trainee's country.

(6) FMS Case or IMET FY and WCN.  Enter FMS case
number or trainee's worksheet control number as shown on student 
ITO.  

 
NETSAFA 

  MAY 24 

62



(7) Course Title.  Official long title assigned to
course. 

(8) Course I.D. Number.  Course Identification Number
(CIN) assigned. 

(9) Course MASL.  The Military Articles and Services
List (MASL) number assigned to the course. 

(10) Duration of Course.  The convening (from) and
graduation (to) dates of the course in year, month and day 
format.  

(11) Did Student Complete Course?  Check appropriate
block (yes or no).  In this instance, the word “complete" means 
the student was physically in class from convening to 
graduation.  Type of completion will be indicated in Block 12.  
Note the circumstances in Block 15 if a student did not complete 
a course.  

(12) Student Was Awarded.  Check appropriate block.
If other, specify in Block 15. 

(13) English Comprehension Level (ECL).  Only for
countries required to take either in-country or CONUS ECL test 
(or both).  Enter test scores in applicable blocks.  Enter "DLI 
Entry" if student attended DLI.  

(14) Student's Academic Evaluation.

(a) Enter the evaluation code from Block (14a)
rating scale that best describes the student’s   
performance in the areas listed in Blocks (14b) and (14c).  
Assignment of Unsatisfactory and Not Observed codes require an 
explanation in Block 15.  

(b) Training will be evaluated for both language
proficiency and performance in class.  Note that Block 
14.c.6 is for “Potential as Instructor” and should be completed
only in Instructor Training courses.  Mark N/A for not
applicable for all other training.

(15) Remarks on Academic Performance, Awards and
Other Information.  Provide the following when appropriate: 

(a) Required by Blocks 11, 12, or 14a above.
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(b) Comments providing additional insight into
the trainee's performance or failure. 

(c) Explanation for the trainee's attrition or
reasons for termination of training. 

(d) Recommendation or explanation for trainee
disposition. 

(e) Significant accomplishments or awards.

(f) Flight training only: For training
activities conducting flight training, enter number of hours 
flown by fiscal year and aircraft/simulator type.   

(g) If specifically directed by NETSAFA to
provide final grade and class standing, this data will be 
entered in Block 15.  This will only be used in limited cases 
where the country has specifically stated they require this 
information.  

(16) Remarks on Student's Participation in Extra-
Curricular and Community Affairs.  This block can be useful if 
the trainee is scheduled for follow-on training to ensure that 
scheduling of duplicative events does not occur.  Do not mention 
the “Field Studies Program” or “FSP” per se.  However, you may 
list the major activities such as “visited Fourth Circuit 
Court,” “participated in tour of local newspaper office” etc. 

(17) Evaluator Fill in and Sign.  Each person signing
as an evaluator must be equal in rank or senior to the student. 

(18) IMSO Signature.  Indicates form has been placed
in the student training record or is being forwarded to address 
in Block 1. 

8-6. Classified Materials.  Disclosure authorizations are issued
for each country scheduled for training that includes Classified
Military Information (CMI) and/or Controlled Unclassified
Information (CUI) with an established “Need to Know” and are
valid until the course content or the political relationship
between the U.S. and the respective country changes.  See the E-
SAMM Chapter 10 (para. 10.3.4) for additional details.

1. Disclosure of CMI and CUI during instruction may occur only
after receipt of a Delegation of Disclosure Authority Letter
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from NIPO (Code 01B2), the Naval Intelligence Command, Naval 
Education and Training Security Assistance Field Activity 
(NETSAFA) or a command delegated authority in the SECNAVINST 
5510.34 series.  NETSAFA has been provided general disclosure 
authority from NIPO which may be delegated in support of 
International Training through a Delegation of Disclosure 
Authority Letter (DDL).  Under no circumstances will classified 
training or information be provided without a disclosure 
authorization.  

2. Disclosure authorizations are issued for "appropriately
cleared" representatives of the attending country.  However, at
no time does an ITO authorize the disclosure of CMI.  IMSOs must
ensure the access granted to the IMS on the ITO by the country
is at least equal to the level granted by the disclosure
authorization.  If the ITO grants a lower level of clearance
than is contained in the disclosure authorization, or if no
access is authorized, the IMSO must contact NETSAFA Foreign
Disclosure Officer (FDO) for determination if the training
should be conducted at a lower level of classification, or if
the training should be cancelled.

3. Classified Training Material and Student Notes (ref. SECNAV
M-5510.1, DoN Foreign Disclosure Manual, Chap. 10, pgs. 10-10
and 10-11, para. c)  DON training activities can supply only
classified student notes and locally prepared course materials
to the pertinent SCO, with appropriate release forms.  Other
classified publications used during instruction of the
classified course such as texts and schematics must be requested
by the foreign Government through normal channels.

4. Before shipping classified student notes and locally
prepared course materials, the training activity will ensure
these materials are reviewed and bear the appropriate U.S.
security classification markings.  Student notes and course
materials that cannot be reviewed because they are written in a
foreign language should be marked with the highest
classification of information disclosed during the course.  All
classified materials will be conspicuously marked by stamp or
other means, to indicate the following information:

a. Highest classification of included material

b. Date of review

c. Name and rank of reviewing official
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d. Name of cognizant activity

e. Training course involved

f. Student’s name and service

5. The "Third Country" marking required by SECNAVINST 5510.34
will also be applied to the cover of each classified document.
After the appropriate markings are applied, the material will be
forwarded to the SCO for transmittal to the foreign Government.
(If the authorized address in the Standard Navy Distribution
List is other than the SCO's, passing instructions should be
included.)  In the case of ship's crew training, classified
student notes and locally prepared material may be delivered
directly to the ship if it is accessible.

6. Classified material containing Communications Security
(COMSEC) information must be forwarded via Naval Network Warfare
Command (NAVNETWARCOM) to the SCO for transmittal.

8-7. Training Program Records Disposition.  As FMS Training Case
and IMET Program Administrator, NETSAFA is responsible for the
disposition of all Security Assistance Training Program records
dealing with individual IMS and individual country training
programs.  This includes, but is not limited to: ITOs, progress
reports, correspondence, messages, etc.  If NETSAFA is an info
addressee on any such correspondence, training activities may
destroy their copy when no longer needed.  If NETSAFA is not in
receipt, the report/document should be forwarded to NETSAFA for
determination as to further disposition on a case-by-case basis.

1. Reports dealing with the IMS academic evaluation should be
included in the individual IMS training jacket that is
eventually forwarded to the SCO, who in turn keeps a permanent
copy.  Training activities may destroy their copy of evaluation
records as directed in the Navy Records Management Manual
(SECNAV M-5210.1).
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Chapter 9  

Disciplinary Actions and Special Incident Reporting 

9-1 IMS infractions and incidents.  Infractions or incidents of
a serious nature involving either IMS or their dependents
include, but are not necessarily limited to:

a. Serious breaches of discipline

b. Matters involving civil authorities

c. Incidents considered to have politico-military
implications 

d. Situations considered outside the purview of local
commands or installations.  (I.e. Immigrations and Customs, Off 
Base Schools/Businesses/Citizens)  

1. Due to the sensitive nature of such reports, distribution
will be limited to the following organizations or activities. An
incident should be reported by telephone to the appropriate
NETSAFA CPM and the flag rank command supervising the training.
Telephone notification should be followed-up by priority e-mail.
Ensure email is sent as Controlled Unclassified Information
(CUI).  Prior to describing the incident and providing pertinent
information, include statement “This is an official IMSO
notification”.  For Navy sponsored IMS, reports will be made to
NIPO via the chain of command and NETSAFA.  For Coast Guard
training, ensure USCG International Affairs is notified.  The
report will include appropriate recommendations.

2. If the IMS is hospitalized, include all pertinent
information concerning the IMS's condition, as well as
prognosis.  Prognosis should include initial comment regarding
feasibility of IMS to successfully complete current training.

3. Matters involving the possible application of criminal
jurisdiction by U.S. civilian authorities will be coordinated
with the respective service's Judge Advocate General (JAG)
office, as appropriate.

4. Student Incident Report Form B.7 is available for reporting
infractions or problems involving IMS that do not warrant
special incident reporting.  Contact the NETSAFA IMSO Division 
for additional information and guidance.

 
NETSAFA 

  MAY 24 

68



9-2 Unauthorized Absence.  IMSOs will carefully check student
accountability records before making a determination of
Unauthorized Absence (UA), to ensure that the IMS is not absent
because of misunderstanding the schedule, sick in quarters, or
for other plausible reasons.  Note: When a student is
determined to be in an UA status while in travel from one
training installation to a follow-on training elsewhere, the
student’s last installation is responsible for completion of
IMSO responsibilities.)  Refer to Checklist C.3

1. IMSO Actions: When it has been determined that an IMS is UA,
the IMSO will take the following actions:

a. Initial/Immediate notification of the following offices
Provide initial notification by telephone with as much 
information as available at the time.  This will be followed by 
an official email notification.   

b. NETSAFA CPM.  Notification or questions should be made
immediately after determination of UA status.  If the UA occurs 
after hours or during a weekend, contact the NETC Senior Duty   
Officer (SDO) at 850-554-5312.  

c. NETSAFA IMSO Manager:
usn.pensacola.netsafapensacolafl.mbx.netsafa-imso-
mgr@us.navy.mil  

d. Local Naval Criminal Investigative Service (NCIS)

e. Immigration and Customs Enforcement (ICE) office

f. Training activity chain of command.

2. The notification information should include, but is not
limited to:

a. IMS name and country

b. Passport and visa information

c. Known variations in name spelling

d. Effective date and time of absence

e. Last known location

f. Date of birth
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g. Place of birth

h. Last known mobile telephone number of IMS

i. Case Identification/Work Control Number (WCN)

j. Type of training and any follow on training for which
IMS is programmed

k. Travel circumstances (flight arrangements, layovers)

l. Any information concerning events that may have
contributed to the situation

m. Known relatives in the United States

n. Information on U.S. driver’s license (e.g. number,
issuing State, expiration date)

o. Information and copy of any DOD identification (ID)
cards issued

3. Official notification should be sent as Controlled
Unclassified Information (CUI).  Include WCN, IMS name and UA in
subject line.  Prior to listing information in para. 2 above,
include statement “This is an official IMSO notification”.

4. Secondary Notification for the following:

a. Notify the appropriate DoD ID card office to ensure
the ID card is cancelled. 

b. Notify the local Defense Finance and Accounting Center
facility and finance officer to post UA information to the IMS 
DD Form 1588 to cancel service to preclude unauthorized 
payments.  

c. Notify installation lodging and cancel service.

d. Notify the base Staff Judge Advocate who should be
aware of U.S. Government consular notification requirements if 
the IMS is later arrested.  

5. Additional actions required:
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a. Ensure the proper progress message (AWOL-TG) is entered
in the Security Assistance Network (SAN) database. 

b. Request designated Security Cooperation Officer (SCO)
provide instructions for disposition of IMS personal effects 
from Ministry of Defense (MOD) of IMS.  Cost for shipping and 
handling will be charged to corresponding funding line of IMS. 

6. If the IMS returns to a DOD training installation or is
known to be detained by local authorities; notify the local and
national ICE/DHS office, and appropriate MILSRV CPM.

7. In the event an IMSO is notified of an IMS failing to return
to home country after completion of training, NETSAFA should be
notified.  NETSAFA will verify the circumstances with IMS' home
country and take appropriate action.

8. Additional information:

a. Media inquiries regarding the UA should be directed to
the NETC Public Affairs Office (PAO)at 850-452-4858.  The base 
PAO should also be informed of the UA.  IMSOs should not make 
statements or provide information to the media.  

b. In the course of the Training Site Arrival Briefing, IMS
should be informed of the 24 Hour Notification Policy.  The IMSO 
Guide Arrival Briefing Checklist Checklist C.2 will be amended
to reinforce this time limit.  

9. NETSAFA N3 will notify NIPO with initial email.  Forward
official notification upon receipt.  Verify that NIPO forwarded
reporting to:

a. Defense Security Cooperation Agency (DSCA): {Building
Partner Capacity (BPC) Institutional Capacity Building
(ICB) Division}: 703-601-3655.

b. Defense Counterintelligence and Security Agency (DCSA)
at dcsa.quantico.dcsa.mbx.esc@mail.mil.

c. Department of Homeland Security/Immigration and Customs
Enforcement (DHS/ICE) Counter Threat Development Unit
(CTLD) by email at CTLD@ice.dhs.gov.

d. Provide IMSO with appropriate policy, guides and
checklist, as necessary.
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9-3  IMS Behavior and Academic Issues.  A primary purpose of
Security Assistance Training is to encourage effective and
mutually beneficial relations and increased understanding
between the United States and foreign nations.  It is U.S.
policy that every reasonable effort should be made to ensure
that an IMS completes scheduled training and attains the
required level of skills and professional competence.  However,
it is not intended that the IMS be passed or graduated solely as
a gesture of goodwill.  Within prescribed limitations concerning
access and security of classified or protected USG information,
the IMS will be treated in the same manner as U.S. military
students.

1. It is important to consider the IMS's aptitude, application,
sincerity, diligence of effort, and demonstrated understanding,
as well as their numerical grades.  All of these factors
contribute to the evaluation as to whether the IMS can
accomplish the training objectives.  DON policy on this subject
is outlined in the following paragraphs.

2. Occasions or situations may arise which could be detrimental
to the IMS's successful completion of training but which are not
serious enough to be classified as discipline or disenrollment.
Examples of this are unique situations related to grooming
standards, religious principles, or minor indebtedness.  In
these cases, training activities should initiate action through
the chain of command, NETSAFA and NIPO, to resolve these issues.
The decision to notify the Combatant Command or the SCO resides
with NIPO for Navy.  In most cases, the situation can be
resolved within the Continent of the United States (CONUS)
Security Assistance community.

3. In the absence of standard agreements with countries
involved in Security Cooperation Education and Training, the IMS
cannot be disciplined in accordance with the Uniform Code of
Military Justice (UCMJ).  Disenrollment is the only option
available in the case of an IMS who has demonstrated an
inability to conform to the rules and regulations at the command
where training takes place.  Authority to disenroll an IMS will
be executed by the NIPO Country Desk Officer for a Navy
sponsored IMS.  See JSCET para. 1093 for details.

4. While disenrollment may be the only available option, it
must be viewed as the last resort.  Disenrollment of an IMS
indicates that the training authorized and approved under an
IMET or FMS training program has not been accomplished.
Experience has shown that contact with an IMS by officials of
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his/her own government can resolve most disciplinary problems.  
In many cases such contacts can also have a positive influence 
on academic problems, especially where the cause may be the 
IMS's attitude in pursuing the course of instruction.  In order 
for this contact to be effective, disciplinary and/or academic 
problems must be brought to the attention of SC training POC 
within the chain of command, and NETSAFA, as early as possible. 

5. To facilitate the proper documentation, reporting, and
resolution of academic and disciplinary problems, the following
system will be implemented by all DON activities providing SA
training to IMS.

6. When an IMS demonstrates non-conformity to established
standards of behavior or has failed to achieve the required
academic progress, the IMSO will formally counsel the IMS
concerning these shortcomings.  The counseling will include:

a. The exact nature of the behavior or performance that
has failed to meet established or required standards. 

b. The exact nature of the change required.

c. The time period the IMS is being given to make the
required change. 

d. A warning that change is required to avoid the IMS's
placement on probation (the last stage before 
disenrollment).  

e. That the counseling session is considered an official
warning to the IMS. 

f. The IMSO will make an official record of the counseling
session and enter it into the IMS's training record.  The IMS 
will be informed that if the required changes in either behavior 
or academic performance is made within the time period 
specified, the official record of the counseling session will be 
removed from the IMS's training record upon the IMS's successful 
completion of the current course of instruction.  

7. When an IMS fails to make the changes in either behavior or
academic performance required as a result of being formally
placed on warning status, or when an IMS indicates serious non-
conformity to established standards of behavior, the IMS will be
officially placed on probation.  If an IMS is placed on
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probation, the training activity Commanding Officer (CO) will 
formally counsel the IMS.  The IMS will be advised:  

a. They are officially being placed on probation, that the
IMS must change his/her behavior to avoid recommendation for 
disenrollment.  

b. The exact nature of the behavior or performance that
has failed to meet established or required standards. 

c. The exact nature of the change required.

d. The time period in which the change must occur.

e. The IMS's Washington, DC-based Attaché or government
official will be notified of this action. 

8. The details of the probation will be recorded in an official
letter to the IMS from the CO, which will be provided to the IMS
during the official counseling session.  A copy of this letter
will be placed in the IMS's training record, and will remain in
that record until the IMS successfully completes all CONUS based
training.  If the IMS's conduct/academic progress so warrants,
the IMSO at the last activity or installation providing training
to the IMS will remove this letter from the training record
prior to forwarding the training record to the SCO.  NETSAFA and
NIPO should also be provided a copy of the letter.  NIPO will
make notification to the Washington, DC-based representative of
the IMS's government.

9-4 Disenrollment.  When an IMS fails to make the changes in
either behavior or academic performance required as a
result of being formally placed on probation, or when an IMS
exhibits behavior prejudicial to good order and discipline, the
CO of the training activity is authorized to recommend
disenrollment.  This recommendation will be made through the
chain of command to NIPO.  Commanding Officer and the Executive
Director of NETSAFA will be responsible for uncontested IMS
disenrollment determinations related to IMS academic
deficiencies.  This is defined as a situation where a Navy
sponsored IMS is not succeeding academically, has received
appropriate counseling, the cognizant Navy Office of General
Counsel or Office of the Judge Advocate General Attorney reviews
the proposed determination of legal sufficiency, and the
Training Activity’s disenrollment recommendation is uncontested.
The Executive Director of NIPO will retain sole authority and
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responsibility for IMS disenrollment determinations related to 
the following:  

a. Contested Determinations.  Contested circumstances
occur when there is not a unanimous opinion between all 
concerned Navy commands and the IMS defense establishment 
concerning the disenrollment recommendation under consideration. 

b. Extenuating Circumstances.  Extenuating circumstances
occur when the reason for disenrollment is outside of the 
control of the IMS.  Examples include, but are not limited to, a 
significant illness or bereavements, being a victim of a crime 
or another acute trauma.   

1. Copies of all record correspondence relating to
disenrollment will become a permanent part of the IMS' training
record and will be forwarded to the SCO after the IMS returns to
homeland.  See para.  10-93 of the JSCET, for governing
authority to disenrollment an IMS.

2. NIPO will notify the Washington, DC, based representative of
the IMS's government.

3. NETSAFA CPM will provide disposition instructions to the
training activity involved.  Copies will be provided to NIPO,
the Combatant Command, the SCO and the Washington, DC based
representative of the IMS government.

4. Humanitarian Disenrollment.  Occasions may arise when an IMS
cannot complete a course because of injury, illness, or personal
hardship.  IMSO should notify NETSAFA CPM with details of
circumstances preventing course completion.  When such an event
occurs and is confirmed, the IMS should be disenrolled, and the
circumstances surrounding the disenrollment should be documented
in the Academic Report.  The IMS should be provided a copy of
the Academic Report upon departure from the training site.

9-5 Political Asylum.  Requests by IMS for political asylum in
the U.S., or for temporary refuge, must be treated with urgent
but careful attention.  Uniform policies and procedures and
assignment of responsibilities for handling requests for
political asylum or temporary refuge are found in SECNAVINST
5710.22.  The POC for supervising implementation of these
policies shall be the Deputy Chief of Naval Operations (CNO),
Operations, Plans and Strategy (N3/5) or CMC Deputy Commandant
for Plans Policy and Operations, as appropriate.
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1. IMSOs should ensure instructors and training staff know to
refer any questions or comments from IMS regarding political
asylum immediately to the IMSO.

2. Before the request is officially made, the IMSO should first
brief the IMS on the following:

a. This request is a serious matter and is irreversible
once made official. 

b. The IMS will immediately be disenrolled from training
and turned over to proper authorities per DoD instructions. 

c. IMS will lose all military privileges, including living
allowance, living on base, and ID card. 

d. Not all requests for political asylum are approved.

3. IMSOs are reminded not to discuss any political asylum
requests with other students, the public, or the media.  IMSOs
should afford reasonable care and protection to the IMS.

4. Distribution of messages concerning this subject should be
strictly limited to protect the confidentiality of the IMS.  In
no case shall a training activity include in-country addressees.
Messages should be addressed to as follows:

a. Navy activities should address reports to CNO (N525),
info NETSAFA, NIPO and the chain of command. 

b. Further dissemination of information will be determined
at the SECNAV, CNO, or COCOM levels. 
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CHAPTER 10  

Field Studies Program 

10-1 Field Studies Program (FSP) Introduction.  The following
references apply in the planning and execution of the Field
Studies Program (FSP):

a. DoD Instruction 5410.17, dated 15 September 2006

b. JSCET, Chapter 11

c. E-SAMM Chapter 10

d. NETCINST 4950.1F, 2 August 2019

1. Reference (1) updates DoD policy for a FSP to enhance the
formal training courses and orientation of the international
military and civilian students and military–sponsored visitors 
under the Security Assistance Training Program and other 
programs administered through Security Assistance/Security 
Cooperation Channels.

2. Each international student attending a course in the United
States has the opportunity to participate in the FSP.  The
objective of the FSP is to assist International Military
Students (IMS) in acquiring a balanced understanding of U.S.
society, institutions, and goals, in conjunction with their
training experience.  The program should include explanations and
free discussion with the students about our government
structure, the judicial system, the political party system, the
role of a free press, and other communications media, cultural
issues associated with minorities, the purpose and scope of
labor unions, our economic system, educational institutions, and
how these elements reflect the U.S. commitment to the basic
principles of internationally recognized human rights.
Activities such as visits to, local industries, industrial and
cultural exhibits, farms, schools, historical points of
interest, and civic activities are encouraged.

3. The DOD FSP Guide is a particularly valuable resource for
planning and conducting FSP activities and events.  The DoD FSP
Guide is available on the International Training Management
website at: https://www.dscu.edu/itm.  While the DoD FSP Guide
focuses primarily on FSP programming, this chapter in the IMSO
Guide will address the administrative, logistical, and funding
aspects of the FSP.  The NETSAFA FSP Handbook complements and
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supplements this guide and other references for Navy activities, 
especially with regard to budgeting and fund execution.  

4. Execution of the FSP varies by major claimants and executive
agencies within the DON, so IMSOs should follow the FSP guidance
issued by their respective major claimants and executive agent.
U.S. Marine Corps and U.S. Coast Guard guidance can be found in
their respective IMSO Handbook.  Major Claimant FSP POC are as
follows:

OFFICE DSN COMMERCIAL 
NETC / NETSAFA  459-8874 850-452-8874
NAVSUP N/A 401-481-4847
USMC 378-5321  703-432-5321
USCG N/A 202-372-4490

Note:  Contact NETSAFA, CODE N3 if your organization is not
under the listed Major Claimants.   

10-2 FSP Overview.  Training installation commanders and IMSOs
should remember that exposure of the IMS to the non-military
aspects of life in the U.S. is important to the SCTP, second
only to the strictly military training and education of the 
program.  IMS participation in FSP activities is encouraged, but 
not required unless it is part of the curriculum.  FSP
activities occur in addition to normal academic/military 
requirements at the training installation, and it is important 
for the commands to ensure FSP activities are interesting, 
educational, and attractive, so that each IMS will give their 
full support to the program.  FSP topics, activities, and events 
should be tailored, when possible to fit the character and 
background of the IMS involved in the training.

1. FSP is intended for IMSs attending training in the U.S. or
participating in an Orientation Tour arranged under SCTP
sponsorship.  Dependents of IMS are eligible to participate in
FSP activities, but at no cost to the FSP or the U.S. Government
(dependents are generally discouraged to participate in
overnight FSP events).

2. The DoD Components shall ensure the FSP promotes an
understanding of U.S. society, institutions, and ideals and the
way in which these elements reflect U.S. commitment to basic
principles of internationally recognized human rights.  To
achieve this objective, the FSP will provide students and
visitors with an understanding of the following 11
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facets of American life, within the limits of time and available 
resources (see references 1 and 2):  

a. Human Rights.  U.S. commitment to basic principles of
internationally recognized human rights per the United Nations 
Universal Declaration of Human Rights, the Geneva Convention, 
and the U.S. Constitution, and Bill of Rights.  This aspect of 
American life shall be emphasized in conjunction with all 
subsequent FSP topics.  

b. International Peace & Security.  How the United States
accomplishes effective and mutually beneficial relations and 
increased understanding with foreign countries in furtherance of 
the goals of international peace and security.  

c. U.S. Government Institutions.  U.S. institutions of
democratic governance, including electoral and legislative 
processes and civilian control of the military; the institution 
and improvement of public administration at the national, 
intergovernmental, regional and local levels.  

d. Political Processes.  American democracy and political
reform, including opening the political process to all members 
of society, the practice of free elections, freedom of 
association, and the influence of grass-roots and non-
governmental organizations promoting democracy, the rule of law, 
transparency, and accountability in the political process.  

e. The Judicial System.  The American establishment of the
rule of law, and an effective judicial system; the correct role 
of the military justice system and its procedures, termination 
of extremist violence as well as vigorous action to prosecute 
those guilty of crimes.  

f. The Free Market System.  The success of the American
economy due to land reform, reform in tax systems, encouragement 
of private enterprise and individual initiative, creation of 
favorable investment climates, curbing corruption where it 
exists, and spurring balanced trade; the independent roles of 
labor and management in negotiating pay, working hours and 
conditions, and other benefits associated with employment; the 
factors underlying industrial and agricultural production, and 
how environmental protection has altered each; and the role of 
environmental protection. 

g. Media.  The role of a free press and other
communications media in American life; how diversity of media 
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ensures people of all races, creeds and political persuasions 
can be heard (editorials, letters to the editor) and ensures 
diverse, pluralistic culture.  

h. Education.  The purpose and range of educational
institutions, the value of an educated and responsible 
citizenry, and the educational opportunities available to all 
citizens.  

i. Health and Human Services.  American institutions that
provide quality health care and voluntary family planning 
services, housing, and other services; policies that are 
components of a social safety net, particularly for infants, 
children, the elderly and people with disabilities.  

j. Diversity & American Life.  How America fosters
political, economic, and social pluralism; the geographic, 
religious, and social diversity of American life; progress in 
applying American ideals to ethnic and other minorities 
including women.  How American families live and work in cities, 
towns and rural areas; how Americans function in communities, 
worship, work together in organizations, participate in and 
support cultural and historical events; volunteerism.  

k. Law of War.  The part of international law that
regulates the conduct of armed hostilities, often called the 
“law of armed conflict”.  For the purposes of this facet, the 
law of war encompasses all international law for the conduct of 
hostilities binding on the United States or its individual 
citizens, including treaties and international agreements to 
which the United States is a part, and applicably customary 
international law.  

3. Each training installation shall designate the IMSO as the
FSP Coordinator.  In addition, and if practical, each IMS should
have a military and a civilian sponsor.  The military sponsor is
usually another member of the training installation staff who is
of equal or higher military rank, and who can serve as a
liaison/facilitator for the IMS at the training installation.
The civilian sponsor can be a dependent, civilian employee, or a
member of the community who can help the IMS understand the non-
military aspects of life in America.

4. In addition, the support of all training installation
activities is essential to the successful fulfillment of the
Navy’s responsibilities for the FSP.  While IMSOs are the focal
points for FSP activities, they require the cooperation and
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assistance of finance, transportation, public affairs, and other 
installation representatives to carry out an effective program.  To 
ensure a general understanding of the FSP and its relationship to the 
Security Cooperation Training Program, Training Installations should 
schedule periodic briefings to ensure that U.S. personnel are 
familiar with program objectives and functions.  

5. It is also important that key people in the surrounding
community, government officials, museum directors, business leaders,
etc. are aware and supportive of the training installation’s FSP 
efforts.

10-3 FSP Planning.  The FSP begins with the in-country departure
briefing of IMS by the SCO, and continues throughout the training
period.  IMSOs should ensure that appropriate FSP information is
included in the Student Information Package sent to the SCO upon
initial notification of an IMS’s planned training.  An overview of
the FSP should also be included in the IMS’s Arrival Briefing at the 
training installation.

1. The IMSO should plan FSP activities and events in conjunction
with the IMS’s academic schedule.  Where possible, FSP events should
be conducted when the IMS is excused from classified portions of the
courses.  Also, those portions of a course from which an IMS will be
excused should be consolidated to permit time for FSP activities.
IMSOs should obtain authorization from NETSAFA to conduct the FSP
activity (see Section 10.6 for details regarding funding and
authorization).

2. Possible FSP activities, locations, and events should be
identified as far in advance as possible, especially those
events that are time sensitive.  Again, the DoD FSP Guide is a
valuable reference in selecting appropriate activities that will
support the FSP goals.  FSP planning should focus on local
events and activities as much as possible.  Travel is limited to
a 300-mile radius; exceptions to this limit require a mileage
waiver from NIPO (04B).  All waiver requests, should be
forwarded with the annual budget submissions.

3. As the various FSP activities and events are planned, the
IMSO shall establish liaison with appropriate POCs at the
activity location.  The POCs can help arrange tours, and assist
with arranging and determining cost of lodging, food,
transportation, etc.
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4. In addition to the IMSO, a command may designate military or
civilian personnel to serve as Escort Officers for an FSP
activity.  The Escort Officer should be knowledgeable and
experienced in international training, and have a firm
understanding of the goals and objectives of FSP.  IMSOs should
ensure that Escort Officers are fully briefed on the FSP
activity, and the FSP objectives and topics to be covered.  The
recommended ratio of Escort Officers to IMS is as follows:

 1 to 10 participants  
 11 to 20 participants 
 20 plus participants  

2 Escorts   
3 Escorts  
1 Additional escort for every 10  
  participants above 20 

5. Requests for additional Escort Officers above the required
table above may be requested though the FSP manager, for
example: if training for newly assigned personnel is required or
for safety of the IMS/IMSO.

6. IMS participating in FSP activities are considered to be in
a duty status.  Therefore, appropriate Temporary Additional Duty
(TAD) Travel Orders should be prepared for FSP activities that
are in excess of 10 hours.  TAD Orders should include the
correct fund cite.  No cost to the government blanket travel
orders should be used for IMS.  Escorts should use official
travel orders utilizing the pertinent FSP accounting data, with
the following remark to be included in the orders:

“Lodging, transportation, meals, and miscellaneous/incidental 
expenses have been paid in full under the Field Studies 
Program utilizing an SF 1164.  Traveler(s) will not claim 
additional reimbursements associated with the event.”  

Note:  Although Defense Travel System (DTS) can be used to 
create group orders manually, DTS should never be used for IMS 
individual authorizations.  

Note:  Guest on overnight FSP activities will not incur 
additional cost to the FSP program.  

Note:  Contract Bus driver expenses should be included in the 
transportation contract.  (They should not be listed as a 
guest in SANweb.)  

10-4 FSP Activity Execution.  As the FSP activity is conducted, the
IMSO’s responsibilities include:

a. Conduct a pre-briefing for IMS before departure, to ensure
they understand the objectives of the FSP activity. 
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b. Brief escorts on their responsibilities, ensuring that
they understand the objectives of the FSP and the topics to be 
covered.  

c. Provide IMS with emergency and assistance phone numbers
while on the FSP trip. 

d. Inform the appropriate funding claims representative of
any significant changes involving participants, itinerary, or 
funding requirements.  

1. Government transportation shall be used to the fullest extent
possible.  Furthermore, ground transportation should be the primary
means of transporting IMS, to provide a close-up look at the American
countryside.

2. Local or ‘No-Cost’ FSP events are strongly encouraged. These include
visits to, local industry, cultural and industrial exhibits, farms,
schools, historic points of interest, civic activities, or having guest
speakers who are subject matter experts.  These local area programs
provide the best possible exposure to FSP topics at minimal cost.  All
No-Cost events must also be input into the Security Assistance Network
Web (SC-TMS) with the following information:

a. Name of activity

b. Name of individual reporting no cost event

c. Date of the event

d. Number of IMSs

e. Number of guests

f. Number of escorts

g. Nature of event

h. Facets to be attained

3. At the completion of the FSP event, conduct a thorough debrief, once
again emphasizing the objective of the FSP event (refer to the FSP
Handbook).  At least 50% of IMS should complete a Student Evaluation
Sheet, and the Senior Escort Officer should complete an Escort
Assessment of the FSP activity See Figures 3.1 and 3.2.  IMSOs shall
complete the event with
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updated actual numbers and cost in SC-TMS within 5 calendar days 
of completion of event.  

4. IMSOs at activities using NETC Line of Accounting (LOA) for
execution of their program should prepare a liquidation package
with all identified items in Chapter 11 of this guide. Packages
should be sent to NETSAFA at:
usn.pensacola.netsafapensacolafl.mbx.netsafa-fsp-
settlements@us.navy.mil to complete liquidation/reconciliation 
of the FSP event within 10 calendar days after completion of the 
event.

10-5 Trips to Washington, DC.  Subject to the availability of
time and funding, a tour of Washington D.C. should be made
available to IMSs attending senior, career, and other
significant courses as designated by NIPO.  A maximum of four
days is authorized, plus travel time.  A pre-tour briefing is
required for each day’s itinerary, and a post-tour debrief
following the visit.  The Washington D.C. tour is NOT meant to be
a vehicle for the IMS to visit their own national embassy, and
free time should not be included in the trip for this purpose.

1. An itinerary of Washington D.C. tours (including mileage
waivers) must be provided to NETSAFA with the FSP liquidation
package.

10-6 Restrictions and Limitations to FSP.  FSP Funds are not to
be used to pay for the following items or activities:

a. Alcoholic beverages

b. Entertainment or activities which are substantially
recreational in nature, including entrance fees at sporting 
events, theatrical and musical productions, and amusement theme 
parks.  

c. Activities of a purely academic objective (such as
field trips), which are an integral part of the training or 
education course curriculum.  

d. Transportation to and from classes, field trips, and
other activities that are primarily of an academic nature and 
are an integral part of the training or education course 
curriculum.  
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1. FSP Funds may be used for FSP events conducted in
conjunction with academic trips.  These FSP events need to have
enough detail in the request submitted in SC-TMS to clarify the
relationship between the event, course activities and associated
cost.

2. FSP funds may be used to fund presentation mementos, limited
to one item per IMS at each training installation, at a cost not
to exceed $25.00.  Exceptions must be approved by appropriate
military service.  Mementos will be of a permanent nature,
except for photographs.  Ball caps and t-shirts are not
considered to be of a permanent nature.  Note: FSP credit cards
are not authorized for the purchase of mementos.

3. Social activities with participation by U.S. personnel, who
are guests at FSP functions such as breakfasts, luncheons,
dinners, gatherings, and receptions, are authorized provided
that these functions directly relate to at least one of the 11
FSP facet areas.  However, discretion must be used to maintain a
proper ratio between IMS and U.S. guests.  Normally, the
proportion of U.S. official personnel and guests at such
functions should not exceed three times the total number of IMS.
Depending upon the occasion, this recommended proportion may be
exceeded if approval is obtained in advance from NETSAFA.
Note:  Guests are not authorized on FSP events other than those
listed above, in which addition cost may be incurred to the FSP 
program)

10-7 Representational Activities.  Representation Funds are
available to flag-level officers who have command
responsibilities to host official events (luncheons, receptions,
etc.) for high-level international visitors.  These funds can
also occasionally be used to host international personnel under
the SA Program, and can be requested through the major claimant.
These funds are not the same as FSP funds collected through
course tuition.

10-8 FSP Funding and Financial Management.  Note:  NETC LOA
activities, see NETCINST 4950.1F for detailed information of the
financial and accounting matters involved in the FSP)

1. NIPO authorizes expenditures of FSP Funds within the DON.
U.S. Navy major claimants will implement and manage FSPs for
their respective commands and activities.
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2. Funds for FSP are derived from tuition costs.  During the
fourth quarter of each fiscal year, activities must provide NIPO
(IPO-04B), via the appropriate chain of command, with a budget
estimate of their current FSP efforts and an estimate of FSP/
Extraordinary Expense (EE)(see JSCET 11-18 for EE policies).
Funds required during the next fiscal year.  Activities will
provide their submission to NETSAFA N8 for review, endorsement,
calculation of tuition collection rates and forwarding to NIPO.

3. SMC and non-NETC LOA activities will provide their
submission to NETSAFA N8 for calculation of tuition rates.  The
budget estimate should include:

a. Planned FSP activities with estimated cost

b. Estimated number of IMSs to be trained during the next
reporting period 

c. Estimated total number IMS weeks of training during the
next training cycle 

d. Quarterly breakout of the next fiscal year FSP/EE
funding requirements. 

4. For non-NETC Activities, NETSAFA N8 will provide funds using a
Military Inter-Departmental Purchase Request (MIPR) or a Work Request
(WR) or NETSAFA N42 will send funds via advance collection voucher to
comptrollers for execution as funding availability permits in the
first quarter and then quarterly after IAW with the activities
approved annual budget.

5. For activities using NETC LOAs, after an IMSO has planned an FSP
function or event, they should submit the following information to
NETSAFA via the Security Assistance Network
(SANWeb)/SCTMS:

a. Name of Activity

b. Dates of planned function

c. Number of IMSs

d. Number of guests (to be funded by the FSP)

e. Number of escorts

f. Topic(s) Area(s) that apply
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g. Estimated cost categories (IMSO View/Actual Cost
Descriptions) 

h. Support Cost = Extraordinary cost (EE funds) (see
JSCET 11-18) 

i. Admission Cost = Tour Director Cost

Event requests can be submitted via SC-TMS prior to funds flow, 
but may not be authorized and funded until funding is available. 

6. NETSAFA will then assign a 15-digit authorization number for the
approved FSP event.  The disbursements of funds during an FSP event
will be made by the designated escort officer.  At no time will FSP
funds be given to an IMS.

7. Each MILDEP provides unit card profiles that outline unit card
entitlements for use in conducting the command’s Field Studies
Program.  Cash advances will be authorized.  In addition, to resolve
problems experienced by IMSOs during the conduct of FSP events (when
meals are taken in facilities where multiple vendors are used, such
as food courts), it is recommended that:

a. IMSOs brief IMS of the maximum amount authorized for
the meal. 

b. IMS purchase his/her meal using their own funds.

c. IMS submit meal receipt to IMSO.

d. As authorized paying agent, IMSO reimburses IMS for meal.

All activities using a NETC LOA will use credit cards to pay for 
FSP events and activities.  For information on obtaining cards, 
send an email to: PNSC_NETSAFA_FSPMANAGER@navy.mil and it will 
be actioned by the appropriate N84 POC.   
Note:  FSP Credit Cards are Centrally Billed Account (CBA).  
Most states provide tax exemption for hotel, merchant and/or 
vendor purchases, refer to https://smartpay.gsa.gov/smarttax/
tax-information-by-state.
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8. All NETC Learning Centers or Activities within 10 calendar days
after completion of FSP event, the IMSO (or other designated
individual) will prepare a detailed FSP Expense Documentation Sheet
(NETC 4950/3), copies of all receipts, along with post-event
evaluations, and authorizing email. The liquidation package should
be submitted to NETSAFA: usn.pensacola.netsafapensacolafl
.mbx.netsafafspsettlements@us.navy.mil.
Any cash advanced funds not used, should be returned via money
order or check made out to “The U.S. Treasury.” The IMSO may mail
the check/money order to the following address:

Commanding Officer
ATTN: NETSAFA N84 FSP Division
250 Dallas Street, Suite B
Pensacola, FL.  32508

Once NETSAFA processes the liquidation package and completes the 
settlement in the SANWeb/SC-TMS, N84 FSP Division will liquidate 
the FSP event claim. If NETSAFA does not receive a copy of a 
liquidated claim within 90 calendar days of the completion of an 
FSP event, an outstanding FSP liquidation letter will be sent by 
NETSAFA to the activity. Additionally, approvals and funding of 
further FSP event requests may be suspended until liquidation 
packages are received IOT ensure funding availability calculations.

9. IMSOs should ensure that at least 50% IMS and escorts complete
a post-event evaluation, using the forms found at Form B.8 and B.9.
IMS and escorts should be instructed to provide substantive 
comments that will enable the IMSO and others to
assess the success of the FSP event and to consider recommendations 
for improvement.  These evaluations should accompany the IMSO’ Claim 
for Reimbursement package to NETSAFA: 
usn.pensacola.netsafapensacolafl.mbx.netsafafspsettlements@us.navy. 
mil.  

10-9 FSP Reporting in the SANWeb.  IMSOs who request their funds
directly from NETSAFA (NETC Line of Accounting training site IMSOs)
should enter their FSP events Requests via the SANWeb:

a. Log onto the SANWeb

b. Select “Training” and click “SC-TMS” Schoolhouse-specific tab
comes up; 

c. Select FSP (Field Studies Program)

d. Select the appropriate Fiscal Year
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e. Five tabs are now available: Update Template, New
Event, Assign Students, Edit Event and Delete 

f. Select the appropriate tab.  Once you’ve built an
event, add in all information as required, i.e., Cost or No 
Cost, Type of Event, number of IMSs, number of guests (funded by 
FSP), number of Escorts; select facets to be achieved, costs 
where needed (transportation, meals, parking, bank fees, 
entrance fees, etc.).   

g. IMSOs only need to build a particular template once;
multiple/future activities can be created from each particular 
template.  

h. Once all information is input, the IMSO must select the
‘pending’ tab and then select “Save/Update.”  This will generate 
an email to NETSAFA PNSC_NETSAFA_FSPMANAGER@navy.mil to 
review/authorize your 'requested' FSP event.  

i. N34 reviews for policy compliance and the IMSO will
receive an email saying it is compliant with policy and standby 
for funding authorization.   

j. N84 will check available funding and will send a second
email with authorization number and funding documents to be used 
when executing the event.   

1. All changes to events must be made through SC-TMS using the
Edit tab.  When events are cancelled due to various reasons such
as illness, weather, unavailability of students, please use the
Edit Event tab and change the status to cancel.  This is
especially important for events that have already received
authorization and funding.  The Delete tab should only be used
early in the planning stage of program development.  Updates
will not take effect unless saved/submitted.  Once the event is
completed, it is imperative the IMSO submit the Final Review
within 5 calendar days in the SANWeb/SC-TMS.

a. Go to Edit Event tab; enter all data, final costs,
numbers of IMSs/Guests/Escorts 

b. Select “Completed” Tab next to Event Status

c. Add key information from the IMSs and sponsor
evaluations in the “Remarks” section 

NETSAFA 
  MAY 24 

90



d. Select “Save/Update” tab; this will generate final
email to NETSAFA PNSC_NETSAFA_FSPMANAGER@navy.mil informing 
the event is now finalized.  
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Chapter 11 

Financial Management 

11-1 Living Allowance Rates.  It is imperative that the IMSO
confirm that entitled IMS receives the authorized living
allowance, as stated in the ITO generated by the Security
Cooperation-Training Management System (SC-TMS).  IMSOs should
note that certain countries pay all or part of IMS’s living
expenses.

1. Table C10.T12 of the E-SAMM shows the Living Allowances for
IMS.  This includes students under both the IMET Program (when
the U.S. pays all living allowances) and FMS (when the living 
allowance is specifically stated in the FMS case, as approved by 
DSCA).  These rates are based upon the Joint Federal Travel 
Regulations, which can be found at: https://www.travel.dod.mil/
Policy-Regulations/Joint-Travel-Regulations

2. IMSOs should ensure debit cards are ordered within 0-10 days
prior to IMS arrival.  Procedures for ordering can be found in
the NETSAFA TLA Handbook.

3. IMSOs should ensure that living allowance payments are
computed for the correct amount.  Procedures for travel and
living allowances payments can be found in the NETSAFA TLA 
Handbook.

4. Living allowance for FMS IMS must be approved by DSCA in the
FMS case.  Living allowance under an FMS case will be paid at
the same authorized rate for IMET students, unless waiver is
granted by DSCA.  Waiver approved rates will be specified on the
ITO.

5. For IMET IMS going to follow-on Coast Guard OJT, the living
allowance is paid by the losing training command before the IMS
departs.  The living allowance payment will cover the OJT period
and/or through return to home country.

6. When IMS are on a cross-country training flight or TDY in
connection with a required course of training, IMS are eligible
for TDY entitlements, which will be included in the course
tuition.  When an IMS is authorized TLA and is concurrently TDY,
the IMS will be reimbursed for travel and per diem (lodging,
subsistence, and incidentals) in accordance with the JTR rate
for the TDY location, plus the TLA authorize at the training
location, which will be charged to the fund cite on the ITO.
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11-2 Dependents.  IMS are encouraged to bring their dependents
to the U.S. ONLY when they are attending certain PME courses.  A
list of these courses is found at C10.T11 of the ESAMM.
Authorized dependents should be identified on the ITO.
Regardless of this list, there are occasions when IMS arrive at
other training sites with their dependents.  IMSOs should have a
contingency plan to address these circumstances should they
arise, including lodging, meals, transportation, and medical
matters.

1. The living allowance rates for accompanied IMET IMS will not
be increased solely because they have dependents with them.

2. Dependents of IMS are not allowed to seek employment during
their stay in the U.S.

3. ID cards, commissary, exchange and medical privileges are
authorized only for dependents authorized on the ITO.

11-3 Commissary and Exchange Privileges.  Commissary, exchange,
recreational and other privileges ordinarily available to U.S.
military personnel and their dependents will be extended to IMS
of equal rank and their authorized accompanying dependents.
Military equivalent ranks for civilian IMS should to be added to 
ITO before IMS arrival. 

11-4 Indebtedness.  During the IMS out-processing from the
training installation, IMSOs are responsible for identifying
those IMS with delinquent debts.  The IMSO should employ the
assistance of the Country Liaison Officer (CLO), if available,
in resolving overdue debts.  If unable to settle locally,
forward indebtedness issues to NETSAFA CPM for resolution, with
info copies to the chain of command.  Student Indebtedness
Policy is covered in the JSCET, Para.  10-31.

11-5 Identity Theft.  IMS can be particularly vulnerability to
possible electronic identify theft.  IMSOs should ensure that
IMS are warned of such illegal activities during their time in
the U.S.

1. When an IMS arrives at a Training Site, IMS should be
briefed on the potential for identity theft.  IMS should be
cautioned not to divulge personal information to anyone who does
not have an official, legitimate reason for having the
information.  This information includes:

a. Full Name

b. Date/Place of Birth
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c. FIN/SSN

d. Bank/Checking/Savings Account Numbers C.  In
particular, IMS should be advised to: 

e. Safeguard personal papers/information against theft

f. Shred bank statements and other papers with personal
information before discarding 

g. Never divulge information by phone, e-mail, or over the
internet to strangers 

h. Never click on links sent in unsolicited e-mails

i. Check bank statements and other records for any
unexpected/unknown transactions 

j. Report any suspicious requests for information or
activity immediately 

k. Contact the IMSO to discuss any questionable or
suspicious situation 

2. The U.S. Federal Trade Commission has a brochure with
additional information regarding identity theft.  This brochure
is available at:  https://www.bulkorder.ftc.gov/system/files/
publications/677a_idt_what_to_know_wtd.pdf

11-6 Purchase and Use of Privately Owned Vehicles (POV).
IMS may purchase POVs unless such purchase is specifically
prohibited in their ITO.  IMS who want to purchase a POV should
consult the IMSO before signing any purchase contract if they
have a question regarding prohibitions against purchase.

1. IMS must comply with training installation and State
regulations for registration and operation of such vehicles. IMS
will be required to purchase and maintain public liability and
property damage insurance.
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11-7 IMS Casualties.  If an IMS under DoD Security Cooperation
Education and Training Program (SCETP) dies, the IMSO should
immediately notify chain of command and NETSAFA CPM.  If unable
to contact the CPM, contact the appropriate NETSAFA Region
Division Lead.  If notification is outside normal duty hours,
contact the NETC Senior Duty Officer (SDO) at 850-554-5312.
JSCET para 10-48 has detailed guidance of actions to take.
NAVMEDCOMINST 5360.1 contains more detailed information.

1. How the IMSO and training activity handle this type of event
can have significant impact upon U.S. relations with a particular
country.  Timely requests for disposition of remains can be
critical, especially if there are unique cultural or religious
requirements.  Consult with Navy Mortuary Affairs
(Medical Support Office) Great Lakes, IL, and Chaplains as
necessary.

2. When a USG-funded IMS under DON sponsorship dies while
undergoing training with U.S. forces or while traveling as part
of the training, the repatriation of remains is the

responsibility of the DON.  See JSCET para 10-92 for more
details.

3. To assist IMSOs in the response and actions after an IMS
fatality, IMSOs can use the Casualty Checklist C.4 of this guide.

4. For IMS or authorized dependent hospitalization, refer to
JSCET para 10-49.c for reporting and actions.
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11-8  Final Training Installation Actions Completion/Termination of Training.  
For completion or termination of training, adhere to the following 
guidelines:

1.  Items listed in the Departure Briefing Checklist, Checklist C.5, will be 
covered with the IMS.
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2. ID Card will be surrendered by IMS during out-processing at the last 
training activity.  IMSO will turn-in the card in to the local ID card 
office for destruction of NEXT GEN USID card. 

3.  Unless approved by NETSAFA, IMS will not be allowed to remain in U.S.         
Government quarters for a period longer than one week after termination of 
the last training course scheduled at an installation.  

4.  Students whose Travel and/or Living Allowance (TLA) is paid by U.S. 
Government funds will be scheduled to depart the day following graduation; 
however, if a delay is caused by extenuating circumstances, IMSOs may 
request an exception to this policy.  Requests for exceptions should be 
addressed to NETSAFA.  If the exception is granted, student may continue to 
draw living allowance and remain in military quarters until departure.

5.  A International Trainee Progress Message shall be completed within three 
days after course completion. 

11-9 Return Travel.  The last training installation to which the
IMS is assigned is responsible for making arrangements for the
return travel to country, and for notifying the SCO of return
itinerary by message.  See section 11-1 for information on
arranging travel for IMS whose travel is funded by the USG.

1. Particular attention should be given to baggage limitations,
since it is very typical for an IMS to return home with excess
baggage.

2. If airline scheduling requires and overnight stay, the IMSO
at the last training installation should arrange the necessary
hotel reservation prior to an IMS' departure, and process the
IMS' final voucher with payment for lodging expense.  The
maximum lodging amounts found in the JTR will be used in lieu of
actual lodging amounts.

3. In most instances, students will not be permitted to remove
checked baggage during overnight stays/rest stops.  Students
should use "carry-on" bags for clothing/personal items during
this time.  Students should be briefed accordingly prior to
their departure from the training installation.
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4. An IMS will be authorized a rest stop in accordance with the 
JTR.  Rest stops will be scheduled at a point enroute where 
carriers permit free stopovers.

11-10  Shipment of Retainable Instructional Materials (RIM).  A 
shipment weight allowance is authorized for each IMS for 
instructional material issued to and retained by the IMS for use in 
home country.  The cost of shipment of RIM is included in the 
tuition rates for all formal courses based on standard rates.

1. IMSO's will ensure that no personal effects are packaged with
RIM, and ensure that only unclassified books, pamphlets, maps,
charts, or other course material issued to the IMS are shipped. It
will not include articles procured by the IMS for personal use, or
materials not directly related to the course of instruction.  The
cost of packing and shipping personal items and household goods
will be borne by the IMS.  The IMS is not permitted to ship these
items with RIM by paying for excess charges over the authorized
weight.

2. Materials are packaged and labeled at the training installation
and shipped to the country SCO for delivery to the IMS, or to the
official address for classified material, or to the student
directly as indicated on the ITO via the most economical method
available.  DoS Pouch service is not authorized.  A copy of the
student’s ITO is placed inside the package.  Use of the Army and
Air Force Post Office or Fleet Post Office address of the
sponsoring SCO is authorized if available.  Packages shipped via
the SCO should be addressed to the SCO (student’s name must not be
entered on address label) and include (on the side of the package)
the WCN and Program Year for IMET IMS and the WCN and FMS case for
FMS IMS.

3. An endorsement to the ITO will cite the weight shipped.  The
weight allowance for RIM is 100 pounds for PME, postgraduate
education, and 50 pounds for all other courses.  IMS desiring to
send RIM via international mail or over the total authorized weight
allowance will do so at their own expense.

4. RIM for IMS’s from Germany is shipped to the following address:
(Student's Name) 
(Student's Office Address in Germany) C/O German Armed Forces 
Command 
Traffic and Transportation Division Dulles International Airport 
Dulles, Virginia 20166 (The weight allowance for RIM is 100 pounds 
for PME, postgraduate education, and 50 pounds for all other 
courses).
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Chapter 12 

IMSO Periodic and Annual T-MASL Review 

12-1  Changes to course and activity information.  Changes to
course and activity information included in the DON Training-
Military Articles and Services Listing (T-MASL) should be made 
by the IMSO or designated Learning Center/Curriculum Manager via 
the SANweb.  Updates/changes to T-MASLs are critical in order 
for our international partners to understand exactly what 
training is being offered and where it is being conducted. 
Reference Guide D.7 contains instructions to update the T-MASL
on the IMSO Website.

1. IAW NETCINST 4950.2F, dated 3 Feb 22, NETC will ensure that the
Learning Centers designate a point of contact for International
training matters.  The POC will either request access to the SANweb
to review and update MASLs or coordinate this responsibility with
the IMSO for updates to the T-MASL and activity information.
NETSAFA will email the annual review of courses on the MASL every
year in late September/early October to the LC Training Officer
with a copy provided to the IMSO and any other designated POC.

2. In addition to the regular T-MASL updates, training activities
should ensure that their respective course data and activity
location information is current in SC-TMS as of November 30th each
year.  Especially important are dining/billeting notes related to
costs per student.  This will enable NETSAFA to conduct its annual
review of the T-MASL, as required by the JSCET.

3. When the IMSO does not have access to information needed to 
update and request changes to courses in the T-MASL, the IMSO 
shall contact the appropriate individual at the training 
activity and request that the appropriate individual register 
for SANweb access and review course and activity information. 
Additionally, the IMSO should provide the name of this 
individual to NETSAFA (N-425, 850-452-8798, DSN 459-8798).

4. LC POCs should coordinate with NETSAFA regarding quotas for 
international students.  They should ensure international 
training quotas and requirements are considered and inform 
NETSAFA before changing curriculum, canceling courses, and 
rendering training equipment and curriculum obsolete.
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5. LC POCs should coordinate with NETSAFA and NIPO regarding 
foreign disclosure of material, especially classified materials.
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IMSO Websites/Points of Contact

1. The NETSAFA website https://www.netc.navy.mil/NETSAFA/
continues to serve the Security Cooperation (SC) community by
providing training catalogs and other informative links. Primary
customers include, but are not limited to, international
governments, SCOs, IMSOs, and commands or activities with
Security Cooperation Training Programs (SCTPs).

a. Please note that a CAC is required to access selected
links within the NETSAFA website.  Furthermore, the website may 
have .mil restrictions for those accessing from Outside the 
Continental United States (OCONUS).  

b. The following items are available on the NETSAFA website:

(1) On-line version of the U.S. Navy International
Training Catalog (public document).  Access to the catalog, requires a CAC.  
Once at the NETSAFA SharePoint site, the Catalog should be selected under the 
IMSO Information Tab.  In the catalog, links to training facilities have been 
included when available.  Listings in this catalog do not constitute a promise 
(implied or actual) to supply U.S. SC; it provides information for use when 
making inquiries through prescribed official channels NETSAFA or NIPO). 

(2) Information on courses and SCWD certification are provided at
the link to Defense Security Cooperation University (DSCU)/School of Security 
Cooperation Studies (DSCU/SSCS).

(3) Links to other applications (i.e. CANTRAC, SANweb, DSAMS) require a CAC
to access and also a separate logon. 

(4) Useful SC Organization links.  (i.e. DSCA, NIPO)

(5) The Microsoft Teams IMSO Group Page which requires
users to have Flank Speed account to access.  This includes links to 
the IMSO Guide, policy and guidance information.  
https://dod.teams.microsoft.us/l/team/19%3adod%3a4815593f321c4ce
b6ad-45e942de175049176617178b2a93b%40thread.tacv2/conversations?
groupId=2a07f047-f021-42d1-ad0f-3b4138407bca&tenantId=e3333e00-
c8774b87-
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2. The International Training Management Site, can be accessed through
DSCU https://dscu.edu.  The ITM website includes the latest references and 
policy information regarding International Military Students (IMS).  Under 
the IMSO link, all service IMSO guides can be located, including the NAVY 
IMSO guide.  Memos regarding ECL Exemptions and country approved holidays are
available on the International Training Management (ITM) as well.  The ITM is 
accessed through (DSCU) website under tab School of SC Studies 
(SSCS) then select ITM category needed.

3. All Military Services and U.S. Embassy Security
Cooperation Offices use the SANWeb System, which is found at https://
san.dsca.mil/SANweb/.  It is the authoritative data source for the Security
Cooperation Training Program.  Data and documents such as ITOs, enhanced
security vetting, progress messages, and academic training reports are
routinely moved between SCOs, training activities, and MILDEP
management.  You must be a registered user of the Security Assistance
Network (SAN) before you can use the SANweb Security Cooperation-Training
Management System (SC-TMS) system.

4. SANweb SC-TMS Access Request: IMSOs who are not currently a registered
user of the SAN should request registration by calling a SAN Web User Group
administrator at one of the numbers below: East Coast (850) 452-8993 West
Coast (619) 556-8368 - OR DSN 526-8368

The IMSO should be prepared to provide: Name, Rank, Organization, Office 
Code, Work mailing address, Telephone Numbers, E-mail Address, Training 
Location Code.  Once registered by the User Group administrator, users need 
to login in and change their password, and/or associate their CAC for login.  

Once individuals are fully registered users of the SAN, they can request 
access for new or additional user(s) by the following steps:  

a. Login to SANweb Cloud by entering username and password, or CAC, at
https://san.dsca.mil/SANweb/login/MainUP.aspx?dt=20220802T183416 

b. Once logged in:

c. Click on “User Information” on SAN Web screen.

d. Click on “Request New SANweb user.”

e. Complete the “New User Request Form.”

f. Click on “Save/Submit”
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5. Steps for getting to the SANWeb SC-TMS after registration:

a. Login with username and password, or associated CAC, at: https://
san.dsca.mil/SANweb/login/MainUP.aspx?dt=20220802=T183416

b. Hover over “Training" on the SAN Web screen.

c. Click on the "SC-TMS."

d. SC-TMS should display a dashboard with course and student
information related to your location. 

e. Additional information found on the SC-TMS page: Under Schoolhouse
Tab, contact information for the training activity can be located and 
updated.  IMSO turnover should be reflected as soon as practical.  

f. Projection and progress information for IMS, MASLs available for
IMS training, location details. 

g. If experiencing difficulties with SANweb, IMSOs may send an e-mail
to dsca.mechanicsburg.imt.mbx.servicedesk@mail.mil describing their 
problem/issue, and a SAN Web Administrator will respond.  A link to this 
email is provided at the bottom of the SANweb Cloud page.  

6. IMSOs should utilize the SANWeb SC-TMS as their IT system for

IMS administration.  It serves as an interface portal for both entering 
and extracting data into and out of Defense Security Assistance 
Management System (DSAMS).  In order to help IMSOs utilize the SC-TMS, 
DSCU has developed a series of “IMSO Web Cheat Sheets,” which provide 
step-by-step instructions to accomplish various tasks.  See the SC-TMS 
9 Quick Reference Guide for IMSOs.
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1. IMSOs will be required to communicate across various departments
and divisions of NETSAFA depending on the nature of business or
issue at hand.

2. The following is a list of common NETSAFA work centers and
the current email for contacting them:

a. IMSO Program Management (N34): IMSO appointment / training /
policy usn.pensacola.netsafapensacolafl.mbx.NETSAFA-IMSO-
MGR@us.navy.mil Country Program Managers (N3):  ITO, entitlements, 
programmed training, student issues.  Varies by country of IMS, 
need most recent NETSAFA CPM roster. Can also get emails to auto-
populate by selecting link inside SC-TMS.  Go to Schoolhouse, then 
Student Training & Progress Messages, then select the envelope 
next to appropriate student name (right one).   

b. Quota Managers (N34):  capacity/seats for courses/classes
usn.pensacola.netsafapensacolafl.mbx.netsafa-quota-
mgr@us.navy.mil

b. TLA (N84):  TLA vouchers, payment queries
usn.pensacola.netsafapensacolafl.mbx.netsafa-tla-
voucher@us.navy.mil

c. MASL Analysis (N42):  MASL updates, tuition pricing
updates webmasl@navy.mil

d. FSP Management (N34, N84):  N34 policy, authorization,
N84 funding authorization: PNSC_NETSAFA_FSPMANAGER@navy.mil
FSP event requests: SC-TMS will auto generate an email to  
PNSC_NETSAFA_FSPMANAGR@navy.mil for events loaded into SC-TMS 

FSP event settlement packages are forwarded to:   
usn.pensacola.netsafapensacolafl.mbx.netsafa-fsp-
settlements@us.navy.mil  

3. IMSOs may also need to communicate with SCOs on routine
matters such as ITO details, and arrival/departure travel.  SC-
TMS progress messages are often the primary means of
communication.  SCO email addresses to auto-populate by
selecting link inside SC-TMS.  Go to Schoolhouse, then Student
Training & Progress Messages, then select the envelope next to
the student training line number (the left one).

IMSO Points of Contact 
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4. IMSOs should avoid any communication with SCOs that could
be construed as an obligation of the U.S. government that has
not been coordinated and approved by appropriate MILDEP, DoD,
and if necessary, State Dept., agencies.

5. IMSOs should be especially aware of Out-of-Channel
International communications sensitivity.  IMSOs will
routinely communicate with IMS or Foreign Exchange Officers
assigned to their location on day-to-day student support and
administration.  Even these communications might need to be 
referred to the appropriate office.
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DEPARTMENT OF THE NAVY 
COMMAND LETTERHEAD 

COMMAND ADDRESS AND ZIP CODE 

IN REPLY REFER TO: 

4950 
Ser 00/XXXX 
Date 

From: Commanding Officer/Officer-in-Charge, [Command Name] 
To: [IMSO Name and Rank] 

Subj: DESIGNATION AS INTERNATIONAL MILITARY STUDENT OFFICER 

Ref: (a) SECNAVINST 4950.4B 
(b) SECNAVNOTE 4950 dtd MAR 17 2023
(c) NIPO letter, Ser 230T/21U0707 dtd 14 Sep 21
(d) NETCINST 4950.2F (as applicable)
(e) [Any applicable command instruction]

1. You are hereby designated as [NAME OF ACTIVITY] International Military
Student Officer effective this date. Your designation will remain in effect
throughout your tour at [NAME OF ACTIVITY] unless specifically revoked by the
Commanding Officer/Officer-in-Charge

2. In the performance of your duties in this capacity, you are directed to frequently review
the appropriate sections of references (a), (b), (c), (d as applicable) and (e as applicable),
and any other directives, as circumstances may dictate.

I. M. SKIPPER
(CO or OIC Signature)

I acknowledge the designation of [NAME OF ACTIVITY] International Military Student 
Officer. 

 [IMSO Name and Rank]  
(IMSO Signature) 

Copy to: 
NETSAFA 

Form B.1
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IMSO DESINGATION & IDENTIFICATION FORM
COMMAND NAME / UNIT IDENTICATION CODE

ADDRESS LINE 1

ADDRESS LINE 2

CITY / STATE / ZIP

PHONE

IMMEDIATE SUPERIOR IN CHARGE (ISIC)

IMSO INFORMATION

FULL NAME RANK/GRADE & 
SERIES

 STATUS (AD/CIV/CTR) SC/SA CERTIFICATION 
STATUS

OFFICE PHONE PROJ ROTATION 
DATE

YOUR EMAIL BILLET IDENTIFICATION 
NUMBER

SUPERVISOR NAME 
& EMAIL

 ADMIN or CIVPERS POC

FULL TIME OR PART TIME BILLET FUNDING 
SOURCE

DOD ID/EDIPI CONTACT RELIEF (IF 
APPLICABLE)

NETC DOMAIN SPECIFIC

Position Description 
(CIVPERS) JOB TITLE

KEY BILLET (Y/N) SC/SA CERTIFICATION 
LEVEL REQUIRED

ADDITONAL REMARKS

Form B.2 

PROJ ROTATION 
DATE
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INSTRUCTIONS 

IMSO INFORMATION NETC DOMAIN SPECIFIC 

FULL TIME OR PART TIME: A full 
time IMSO is defined as a military, 
civilian, or contractor who spends 
80% of their time in their 
professional duties in the 
performance of IMSO tasks. 

POSITION DESCRIPTION:  This 
applies to civilian personnel only 
– what is your PD number. You
may need to reach out to your
N1/Manpower/HR POC.

BILLET IDENTIFICATION 
NUMBER: Refer to your local 
Activity Manpower Document or 
reach out to your 
N1/Manpower/HR POC. 

KEY BILLET (Y/N): If unsure, input 
“N” 

BILLET FUNDING SOURCE: How is 
your position paid for? OM&N? 
FMS? FMF? You may need to 
reach out to your 
N1/Manpower/HR POC. 

SC/SA CERTIFICATION LEVEL 
REQUIRED: If you are FULL TIME 
IMSO you are required to have 
“Intermediate” level certification. 
If you are PART TIME then you are 
required to have “BASIC” level 
certification. 

IMSO DESIGNATION & IDENTIFICATION FORM (BACK) 

Form B.2
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Form B.3

Invitational Travel Order (ITO) for International Military Student (IMS) 

1.ITO Number: BND14I0016003 2.Country/Organization: Bandaria 3. Date: 16-May-14

The U.S. Government hereby issues this ITO for the IMS herein named to attend the course(s) 
of instruction herein listed, subject to the terms and conditions contained herein, and as may be 
amended by competent authority. This ITO is the only document that will be used and is valid 
only for the IMS entering u.s. training under the Foreign Assistance Act of 1961, as amended, or the 
Arms Export Control Act. 

Definitions of acronyms and abbreviations contained in this document, and instructions for completing 
this form are provided in the Joint security cooperation Education and Training Regulation, 
JSCETR / Joint security Assistance Training Regulation, JSATR (SECNAVINST 4950.4A/AR 12-15/AFI 
16-105). This computer generated, letter format ITO is authorized in accordance with the Security
Assistance Management Manual (SAMM), DoD 5105.38-M.

4. Issuing Security Cooperation Organization (SCO).
a. Name of Organization: sco Bandaria
b. Mailing Address: 123 Bandaria Place 

Washington, DC 55555-5555 

c. E-mail Address: disamer@mail.mil 

5.Program Type: IMET: 1-Year Intl. Military Education and Training BN-D-141001

6. 

7. 

8. 

IMS Information:
a. surname: vulke

First Name: Hadin
b. sex: MALE
c. country service Rank: captain
d. U.S. Equivalent Rank/Pay Grade: 03
e. country service: Army
f. country service Number: o-123456

t 
Date of Birth: 01-May-79
Place of Birth: Blinz, Bandaria 

i. Passport Number: BN34567

a: 
country of Citizenship: Bandaria
visa Number: F76543 

l. visa Type: A-2
m. Miltitary unit/Organization: 1st Army Division

Invitation. 
The secretary of Department of the Air Force invites the IMS listed in Item 6 of this 

order, to proceed from Bandaria to KEESLER AFB, MS 39534, reporting on ll-Jun-14 for the 
purpose of commencing training listed in Item 8 of this order. 

a. Authorized Training: No additional training to that specified in this order will be provided. 
CASE: 141001
a. WCN: 6003A 439634.1 MASL: Dl21008 

Military Service course No: E8ABR1W031 OAl 
Location: KEESLER AFB, MS 39534 

Title: WEATHER FORECASTER APPR 
School: KEESLER AFB, MS 

Report Date: 11-Jun-14 End Date: 21-Jan-15 
*****Last Line***** 

9. Fundi n!J,
Fund c,te: 57-55635677 494 8815 NlOBN 4676633 345454 (FSR 033485) (PSR 875685) TLA AMT

$20297. SO Travel order Number: Pseudo SSN: 

10. Language Prerequisites:
a. Highest Required ECL: 70
b. IMS completed in-country English language testing as follows:

ECL Exam No: 12D Date completed: 15-Feb-14 score: 90 

11. Security and Student Screening:

a. Human Rights, Security and Medical Screening have been completed in accordance with the
E-SAMM Paragraphs 10.8.1 and 10.8.5 and JSCET 10-39 for IMS listed in Item 6 of this order.

c. U.S. security requirements have been complied with. The home government has granted
the IMS a security clearance. This of itself does not permit the disclosure of classified
u.s. information. such disclosure must be specifically authorized by an officially
delegated authority and u.s. foreign disclosure regulations or directives.
(1) The highest u.s. classification level required for training is unclassified.
(2) The u.s. equivalent classification level of the security classification granted by the
home government is Secret.

12. Conditions:
a. Dependents: Dependents are authorized by U.S. authority to accompany the IMS or join

the IMS while in training. Dependents are not authorized to be transported or
subsisted at
u.s. Government expense. only the following authorized dependents will be issued the
u.s. DOD/Uniformed Services Identification and Privilege card.
Accompanying Dependents:
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Name 
Harare vulke 

b. Medical Services.
IMS:

IMS under IMET.

Relation 
Wife 

DOB 
04-Jun-81

Passport No. 
BN567890 

visa No. 
F54321 

VISA 
Type 
A-2

charges for DoD and Military Treatment Facility-referred civilian medical and emergency dental
char�eable to the IMET program and will be forwarded to the appropriate MILDEP for processing.
Billing Address: Air Force:

Air Force security Assistance Training squadron/FM 
315 J Street west 
Randolph AFB, TX 78150-4302 

(d) Medical Examinations (Before CONUS Arrival)
Medical examination, to include HIV Test, was completed on 16-Apr-14.

Dependents: 
Dependents. 
Non-NATO/PfP SOFA Authorized Dependents-Insurance. Dependent has acquired IMSO-verified 
qualifying health insurance for DoD and civilian medical care covering the entire period 
he/she will be present in the u.s. for scheduled training. 

Health Insurance: 
Company: First Health Premium 

Policy Number: A56789 
Address: First Health Premium123 second st.Wadi, Bandaria 

Phone: 555-333-4482 

c. Participation in Hazardous Duty.
IMS is authorized to participate in hazardous duty training.

d. Physical Fitness Training.
Participation in physical fitness training is required. check SC-TMS course Description,
International Notes, and Prerequisites for prerequisite physical fitness requirements.

e. Leave.
upon completion of training, IMS is not authorized leave, and will proceed immediately as
directed to home country.

f. Living Allowances.
Living allowance is authorized during period covered by this order, from day of departure
from, to day of return arrival in home country, excluding period covered by leave, in
accordance with SAMM Table c10.T3, and is chargeable to the fund cite in Item 9 of this
order.

g. Travel.
Travel covered by this order, overseas and CONUS, is chargeable to the fund cite in
Item 9 of this order.

h. Travel by POV.
IMS is not authorized to travel by POV.

i. Bag�a�e.
Training is 24 to 35 weeks in total duration: IMS authorized 4 pieces not to exceed
50 pounds (22.7 kilograms) each.

13. Terms:
a. Prior to departure from home country, the IMS and dependents listed herein are required to

be medically examined and found physically acceptable in accordance with the health
provisions of the Immigration and Nationalit¥ Act (8 usc 1182(A)(l)-(7); Public Health
service, Department of Health and Human services, 42 CFR Part 34, Medical Examination of
Aliens, and 42 CFR Part
71, Foreign Quarantine; applicable U.S. MILDEP regulations; and other U.S. laws or DoD
directives and regulations which may be enacted from time to time.

b. The home country will ensure that the IMS has sufficient funds in united States dollar
instruments to meet all expenses while en route to and to include living allowance for
not
less than the first 2 weeks and not more than 30 days of training, pending receipt of
applicable pay and allowances by the IMS.

c. IMS will be responsible for custodial fees and personal debts incurred by self or
family members. IMSs unable to meet these financial obligations may be withdrawn
from training and returned to home country.

d. The IMS will bring adequate uniforms and work clothing for field duty or technical work.
u.s. fatigue uniforms and footwear will be purchased by the IMS in the event that the
country work uniforms are inadequate. when flying training is involved, required special
flight clothing and individual equipment will accompany the IMS, or provisions will be
made by the home country or the IMS to obtain the use of all necessary equipment prior to
start of training. The IMS will also possess adequate civilian clothing for off-duty
wear.

e. The Government of the united States is responsible for IMS travel which is part of
the training program and for which costs are part of the course tuition.

f. The IMS will comply with all applicable u.s. Military Service regulations.
g. The united States may cancel training and return to country IMSs who violate U.S. law

or Military Service regulation or who are found otherwise unsatisfactory. The IMS
government will be alerted to such action in accordance with U.S. MILDEP regulations.

h. The Government of the united States disclaims any liability or financial
responsibility for injuries received by the IMS listed herein while in transit to
and from the training installation, while undergoing training or while in leave

care are 
MilDep 
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status, and any liability or financial responsibility for personal injury claims or 
property damage claims resulting from the IMS action. 

i. The IMS will participate in flights of u.s. military aircraft as required for
scheduled course(s) or as specified in U.S. MILDEP regulations.

j. The acceptance of this order by the host country constitutes agreement that an IMET
funded student will be utilized, upon return to the host country, in the skills for
which he was trained for a period of time sufficient to warrant the expense to the
U.S. Government, in accordance with the SAMM, chapter 10.

14. Implementing Authority:
a. MILDEP AUTHORIZATION: 0419714 b. Date: 05-Mar-14

15. special Remarks:

Mr. Raylan Crowder (AFSAT) and Maj Roxie Richards (IMSO) have authorized Captain vulke to bring bring his
wife with him as an accompanying dependent. 

16. Distribution: KEESLER
AFB, MS

KEESLER AFB, MS 39534 
1 - US Emb, RP 

1 - GHQ/J8 
1 - PAF/A8; PN/N8; PA/G8 

1 - JPJS-RM 
1 - AFSAT/TOC & FMF 

1 - JPSC-TNG 
6 - IMS 

1 - RP Emb, US 
1 - AMEXCO 

17. ITO Authorization:

a. Signature of U.S. Authority Authenticating orders:
// SIGNED // 

b. Title:
Max Prec1s1on, colonel, USAF 
sco Training chief 

Form B.3
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Form I-102   Edition   12/02/21 Page 1 of 6

For
USCIS

Use
Only

Action Block

START HERE.  Type or print in black ink

Part 1.  Information About You

USCIS
Form I-102 

OMB No. 1615-0079 
Expires 12/31/2023

To Be Completed by an 
Attorney or Accredited 

Representative,
if any.

Select this box if Form 
G-28 is attached to 
represent the applicant.

Attorney State 
License Number

3.b.

3.c.

3.a. Family Name
(Last Name) 

Given Name 
(First Name) 

Middle Name

New I-94 Number

Remarks

Receipt

ZIP Code5.f.State5.e.

City or Town5.d.

Street Number and Name5.b.

5.c Ste. Flr.Apt.

If you answered "No" to Item Number 6., provide your
U.S. physical address in Item Numbers 7.a. - 7.f.

6. Is your current U.S. mailing address the same as your
U.S. physical address? Yes No

A-

Alien Registration Number (A-Number)1.

USCIS Online Account Number (if any)2.

Your Full Legal Name

7.a.

U.S. Physical Address 

In Care Of Name 

ZIP Code7.f.State7.e.

City or Town7.d.

Street Number and Name7.b.

7.c. Ste. Flr.Apt.Family Name 
(Last Name) 

4.a.

Given Name 
(First Name)

4.b.

Middle Name4.c.

Provide all other names used.  Include nicknames, aliases, 
maiden name, and names from previous marriages.  Provide 
evidence of any name changes.

Other Names Used (if any)

5.a.

U.S. Mailing Address 

In Care Of Name 8. Date of Birth (mm/dd/yyyy)

Other Information

10. Country of Citizenship

9. Country of Birth

Form B.4

Application for Replacement/Initial Nonimmigrant Arrival-
Departure Document Department of Homeland Security

U.S. Citizenship and Immigration Services
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Form I-102   Edition   12/02/21 Page 2 of 6

12.

(mm/dd/yyyy)

Date of Last Entry into the United States

Place of Last Entry into the United States (City and State)13.

Class of Admission at Last Entry Into the United States14.

15.

AirportLand border Seaport

Indicate the type of Port-of-Entry at which you last 
entered the United States:

17. Date Status Expires (mm/dd/yyyy)

Form I-94, Form I-94W, or Form I-95 Arrival-Departure
Record Number

18.a.

Passport Number18.b.

Travel Document Number18.c.

18.d. Country of Issuance for Passport or Travel Document

18.e. Expiration Date for Passport or Travel Document

(mm/dd/yyyy)

Current Nonimmigrant Status16.

19.b.

19.a. Family Name
(Last Name)

Given Name 
(First Name) 

Provide your name exactly as it appears on Form I-94, Form 
I-94W, or Form I-95.  If the name on the form is different than
your current legal name as entered in Part 1., Item Numbers 
3.a. - 3.c, provide evidence of the name change.

19.c. Middle Name

I am applying to replace my Form I-95 because it was 
mutilated.  I have attached my original Form I-95.

1.d.

1.g. I was not issued Form I-94 when I entered as a 
nonimmigrant member of the military, and I am filing 
this application for an initial Form I-94.

1.f. I was issued Form I-94, Form I-94W, or Form I-95 by 
USCIS with an error or incorrect information, and I 
am requesting that USCIS correct the document.  I 
have attached my original Form I-94, Form I-94W, or 
Form I-95.

1.e. I was not issued Form I-94 when I was admitted by 
CBP at a port-of-entry in the United States (whether
at a land border, airport, or seaport).

Provide an explanation of the error or incorrect 
information entered on Form I-94, Form I-94W, or 
Form I-95 at the time of issuance.

Part 3.   Processing Information

1.a. Are you filing this application with any other petition or
application?

USCIS Form Number and Name1.b.

NoYes

If you answered "Yes" to Items Number 1.a., provide the 
USCIS form number and name of the application or 
petition you are filing in Item Number 1.b.

1.c. I am applying to replace my Form I-94 or Form 
I-94W because it was mutilated.  I have attached my
original Form I-94 or Form I-94W.

11. U.S. Social Security Number (if any)

I am applying to replace my lost or stolen Form I-95.1.b.
Entry Information

Part 1.  Information About You (continued) Part 2.   Reason for Application

Select the box that best describes your reason for requesting an 
initial or replacement document.  (Select only one box)

1.a. I am applying to replace my lost or stolen Form I-94 
or Form I-94W.

Form B.4
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Form I-102   Edition   12/02/21 Page 3 of 6

Part 3.   Processing Information (continued)

Are you now in removal proceedings?2.a. NoYes

Provide detailed information regarding the proceedings.
If you need extra space to complete this section, use the 
space provided in Part 7. Additional Information.

2.b.

If  you answered "Yes" to Item Number 2.a., complete
Item Number 2.b. 

Applicant's Statement

Part 4.  Applicant's Statement, Contact 
Information, Certification, and Signature 

I can read and understand English, and I have read 
and understand every question and instruction on this 
application and my answer to every question.

1.b. The interpreter named in Part 5. read to me every 
question and instruction on this application and my 
answer to every question, in 

1.a.

a language in which I am fluent, and I understood 
everything.

,

NOTE: Select the box for either Item Number 1.a. or 1.b. If
applicable, select the box for Item Number 2.

NOTE:  Read the Penalties section of the Form I-102 
Instructions before completing this section.

You must file Form I-102 while in the United States.

2. At my request, the preparer named in Part 6.,

prepared this application for me based only upon 
information provided or authorized.

,

3.

Applicant's Mobile Telephone Number (if any)4.

Applicant's Daytime Telephone Number

Applicant's Contact Information

5. Applicant's Email Address (if any)

Copies of any documents I have submitted are exact 
photocopies of unaltered, original documents, and I understand 
that USCIS may require that I submit original documents to 
USCIS at a later date.  Furthermore, I authorize the release of 
any information from any and all of my records that USCIS 
may need to determine my eligibility for the immigration 
benefit that I seek.

Applicant's Certification

I furthermore authorize release of information contained in this 
application, in supporting documents, and in my USCIS 
records, to other entities and persons where necessary for the 
administration and enforcement of U.S. immigration law.

I certify, under penalty of perjury, that I provided or authorized 
all of the information in my application, I understand all of the 
information contained in, and submitted with, my application, 
and that all of this information is complete, true, and correct.

Applicant's Signature

6.a. Applicant's Signature

6.b. Date of Signature (mm/dd/yyyy)

NOTE TO ALL APPLICANTS:  If you do not completely fill 
out this application or fail to submit required documents listed 
in the Instructions, USCIS may deny your application.

Part 5.  Interpreter's Contact Information, 
Certification, and Signature

Interpreter's Given Name (First Name)1.b.

Interpreter's Family Name (Last Name)1.a.

Interpreter's Business or Organization Name (if any)2.

Interpreter's Full Name

Provide the following information about the interpreter.

Form B.4
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Form I-102   Edition   12/02/21 Page 4 of 6

Part 5.  Interpreter's Contact Information, 
Certification, and Signature (continued)

Interpreter's Mailing Address

3.c. City or Town

3.d. State 3.e. ZIP Code

Street Number and Name3.a.

3.b. Ste. Flr.Apt.

3.h.

3.f. Province

Country

3.g. Postal Code

4.

Interpreter's Mobile Telephone Number (if any)5.

Interpreter's Daytime Telephone Number

6. Interpreter's E-mail Address (if any)

Interpreter's Contact Information

Interpreter's Certification

I certify under penalty of perjury, that:

which is the same language specified in Part 4., Item Number 
1.b., and I have read to this applicant in the identified language
every question and instruction on this application and his or her
answer to every question.  The applicant informed me that he or
she understands every instruction, question, and answer on the
application, including the Applicant's Certification, and has
verified the accuracy of every answer.

I am fluent in English and ,

Date of Signature (mm/dd/yyyy)7.b.

Interpreter's Signature7.a.

Interpreter's Signature

Provide the following information about the preparer.

1.a. Preparer's Family Name (Last Name)

Preparer's Given Name (First Name)1.b.

Part 6. Contact Information, Declaration, and 
Signature of the Person Preparing this 
Application, If Other than the Applicant

Preparer's Business or Organization Name (if any)2.

Preparer's Mailing Address

3.c. City or Town

3.d. State 3.e. ZIP Code

Street Number and Name3.a.

3.b. Ste. Flr.Apt.

3.h.

3.f. Province

Country

3.g. Postal Code

Preparer's Full Name

Preparer's Contact Information

4. Preparer's Daytime Telephone Number

6. Preparer's Email Address (if any)

5. Preparer's Mobile Telephone Number (if any)

Form B.4
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Form I-102   Edition   12/02/21 Page 5 of 6

Part 6. Contact Information, Declaration, and 
Signature of the Person Preparing this 
Application, If Other than the Applicant 
(continued)

I am not an attorney or accredited representative but 
have prepared this application on behalf of the 
applicant and with the applicant's consent.

7.a.

7.b.

beyond the preparation of this application.

I am an attorney or accredited representative and my 
representation of the applicant in this case
extends does not extend

8.a. Preparer's Signature

8.b. Date of Signature (mm/dd/yyyy)

Preparer's Certification

By my signature, I certify, under penalty of perjury, that I prepared
this application at the request of the applicant.  The applicant then 
reviewed this completed application and informed me that he or 
she understands all of the information contained in, and submitted 
with, his or her application, including the Applicant's 
Certification, and that all of this information is complete, true, 
and correct.  I completed this application based only on 
information that the applicant provided to me or authorized me to 
obtain or use.

Preparer's Statement

Preparer's Signature

NOTE:  If you are an attorney or accredited representative, you 
may need to submit a completed Form G-28, Notice of Entry of 
Appearance as Attorney or Accredited Representative, with this 
application.

Form B.4
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Form I-102   Edition   12/02/21 Page 6 of 6

Part 7.  Additional Information 

If you need extra space to provide any additional information 
within this application, use the space below.  If you need more 
space than what is provided, you may make copies of this page 
to complete and file with this application or attach a separate 
sheet of paper.  Type or print your name and A-Number (if any) 
at the top of each sheet; indicate the Page Number, Part
Number, and Item Number to which your answer refers; and 
sign and date each sheet.

3.d.

1.a. Family Name
(Last Name) 

1.b. Given Name
(First Name) 

1.c. Middle Name

3.a. 3.b. 3.c.Page Number Part Number Item Number

A-A-Number (if any)2.

4.d.

4.a. 4.b. 4.c.Page Number Part Number Item Number

5.d.

5.a. 5.b. 5.c.Page Number Part Number Item Number

Item NumberPart NumberPage Number 7.c.7.b.7.a.

7.d.

6.d.

6.a. 6.b. 6.c.Page Number Part Number Item Number

Form B.4
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IMSO Name: 

Security 

Office Name: 

Other 

Staff Name: 

OBSERVE ANY OF THE FOLLOWING BEHAVIORS: 

Failure to Com I with Securit Rules 

Substance Abuse 

Financial Issues 

Violent or A ressive Behavior 

Criminal Activit 

Erratic or Unusual Behavior 

Problems with Work or Family 

Threats of Harm to Self or Others 

Unauthorized Absences 

Sudden Influx of Cash 

Undiagnosed or Untreated Medical 
or Mental Health Conditions 

Any Behavior of Concern or Unusual for a 
Specific Individual 

IMMEDIATELY CONTACT THE FOLLOWING: 

Phone: Email: 

Phone: Email: 

Phone: Email: 

REMEMBER DIAL 9-1-1, IN AN EMERGENCY AND FOLLOW SECURITY SOP 

While not all behaviors are indicative of a threat, they do increase vulnerability. 

Reporting risk indicators allows appropriate intervention and can provide assistance to those in 

need. You cannot underestimate the role you play in protecting against insider threats. 

* You are the first line of defense. *

B-12
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Form B.6
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Form B.6
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Form B.7
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Form B.8 

Field Studies Program (FSP) Escort FSP 
Event Evaluation 

Escort Name: Rank/Rate: Command/Unit: 
FSP Event: 
Date of Event: Total No. of IMS: YES NO 

Yes    No 
1. (If IMSO is Escort) Do you feel you were adequately prepared for this FSP Event?

2. (If Escort is other than IMSO) Do you feel you were adequately prepared and
briefed prior to the FSP Event?  If No, please explain.

a. About the International Military Students?

b. About the goals/objectives of the FSP Event? If no, please explain.

c. Were you provided information for your pre-/post-brief to the IMS?

d. Was FSP Event information provided for distribution to the IMS?

3. Do you feel the FSP event achieved the planned goals/objectives? If No, please
explain.

4. What were the strong points of the FSP Event?

5. How could the event be strengthened or modified?

6. Would you recommend this FSP Event be conducted in the future? If No, please
explain.

7. What unexpected problems did you encounter and did they impact your ability to
meet the FSP objectives?

Escort Signature:                 Date: 
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Form B.9

 Field Studies Program (FSP) 
International Student FSP Event Evaluation 

Directions: This survey is required per DoD 5108.38-M and the JSCET. The feedback you provide is 
critical to program management and for improving the FSP. The data collection is designed to be 
anonymous, but you may provide your name if you want. For each question, select the response that you 
feel is MOST applicable. Written comments are highly ENCOURAGED – please provide comments to 
the open-ended questions at the end of this critique. Thank you for your time and response.  

Indicate whether the events listed met the associated 
FSP objectives. 

Strongly 
Agree 

Agree Disagree Strongly 
Disagree 

Date, Place, FSP Activity and Objective(s): 
(IMSO/Escort to fill in- e.g. 10/20/20; Atlanta, GA, Visit 
to Martin Luther King Memorial: Human Rights and 
The U.S. Constitution.  
Date, Place, FSP Activity and Objective(s): 
Date, Place, FSP Activity and Objective(s): 
Date, Place, FSP Activity and Objective(s): 
Date, Place, FSP Activity and Objective(s): 
Date, Place, FSP Activity and Objective(s): 
Date, Place, FSP Activity and Objective(s): 
Overall Ratings Strongly 

Agree 
Agree Disagree Strongly 

Disagree 

The pre-brief and post-brief helped me understand FSP 
objectives. 
I understood the relationship between the FSP objectives 
and the purpose of visiting each site. 
This event helped to better my understanding of 
American culture, ideals and society. 
I would recommend this FSP event in the future 

1. How could this FSP event be improved or strengthened?

2. What did you learn about life in the U.S. that you did not know before this event?

3. Do you have any other comments about this FSP event/activity?

      (Optional) Name/Rank/Country: _______________________________________________________ 
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Appendix C 

IMSO Checklists
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Checklist C.1 
 IMSO SUMMARY CHECKLIST 

This checklist can serve as a guide for all the tasks and events an IMSO should consider throughout the cycle of an IMS’s 

training.  This checklist is not all inclusive, and may be modified to reflect the circumstances at a particular training 

installation. 

IMS NAME: ___________________________________  COUNTRY: ________________ 

RANK/RATE: _______________________  USN EQUIVALENT: ____________________ 

COURSE: __________________________________________ARRIVAL DATE: ________ 

CHECK FOR NEW IMS. 
Check the SAN Projection Report, updated on the 1st of each month. 

Go to https://tms.san.dsca.mil/student/rdfp/rdfp_projection.aspx?LOC=011B 

During the month, check SAN SC-TMS weekly for updated schedule of prospective students.  Again, 

go to Schoolhouse, then Student Training & Progress Messages, select Confirmed for inbound 

students. 

If an IMS is scheduled for your training installation, is the course appropriate? 

Are there prerequisite courses? 

Is the training pipeline correct & complete? 

Are the reporting/start dates correct? 

Is the course length/duration correct? 

Are there disclosure issues?  Are the country and the student cleared for the training?  Is the Command 

in receipt of message authorizing disclosure? 

Inform instructor/other academic staff. 

PREPARATION BEFORE IMS ARRIVES. 
Send Welcome Aboard Package to SCO. 

Receive ITO at least 14 days prior to scheduled IMS arrival date. 

Contact SCO or NETSAFA CPM if ITO does not arrive. 

Confirm ITO is complete and accurate. 

Confirm transportation arrangements for IMS arrival. 

Arrange for an escort to meet at airport if appropriate (equal rank preferred). 

Confirm living quarters are available/reservations made. 

Are there dependents?  (Insure ITO lists, for base access/health insurance) 

Reconfirm quarter’s reservations prior to IMS arrival. 

Confirm dining facilities can accommodate any special dietary needs. 

Recruit/select Sponsor. 

Inform Country Liaison Officer (if available.) 

Request Debit Cards, as needed 

IMS ARRIVAL. 
Meet at airport/other transportation connection (if required). 

Meet at main gate if IMS arrives by vehicle without escort. 

ITO confirmed and endorsed as necessary. 

Check passport/visa (and D/S stamp presence) for accuracy if first training site. 

Offer to hold for safekeeping if appropriate. 

ID Card reviewed for accuracy – and next generation USID is issued at the first training site. 

Take photo and upload to San Web. 

IMS (and dependents) checked into quarters. 

Confirm medical/healthcare issues are identified and addressed. 
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Arrival Briefing conducted. 

IMS ARRIVAL (CONT.) 
Review Training Record. 

Establish Training Record if first training site. 

Ensure IMS receives necessary funds if living allowance is authorized. 

Arrange for TCO administer English Language Test if applicable. 

Introduce sponsor as appropriate. 

Introduce CLO as appropriate. 

Give medical card to IMS (when available/Saudi only) 

Provide NEATS token if necessary for training 

DURING TRAINING. 
Prepare commencement report (enroll student in SAN WEB). 

Maintain IMS Training Record as necessary. 

Prepare ITO endorsements as necessary. 

Administer Field Studies Program. 

Be aware of IMS problems and notify NETSAFA as necessary.  Problems could include: 

Disciplinary problems (cannot discipline, can only recommend disenrollment) 

Academic problems 

Civilian fines/legal matters 

Language deficiencies 

IMS personal problems 

Dependent problems 

Medical problems 

PREPARATION FOR IMS DEPARTURE 
Review ITO, and confirm follow-on travel arrangements to next destination. 

POV authorized? 

Arrange for escort to airport if appropriate. 

Notify follow-on training activity 14 days prior to departure. 

If gap in training dates, gaining activity determines arrival date. 

Discuss itinerary with IMS. 

Prepare student to check-out of quarters. 

Obtain/prepare Graduation Certificates or Letters of Attendance. 

IMS DEPARTURE 
Departure Briefing conducted with IMS. 

Collect USID from IMS 

Within five days of departure, mail training record/medical record to follow-on training site (or mail 

to SCO if last training installation.) 

Mail/ship RIM to SCO (don’t mail with training/medical record.  Ensure the WCN is on the outside 

of the package.) 

Prepare completion/departure in SC-TMS and academic reports within three days after departure 

Checklist C.1
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INTERNATIONAL MILITARY STUDENT (IMS) 

ARRIVAL BRIEFING CHECKLIST 

IMSs are to be briefed within two days after arrival at a training installation.  This checklist is intended to 
serve as a guideline for such briefings.  Briefings may be conducted either on an individual basis or in a 
group.  Actual topics may be modified as necessary to reflect the individual requirements, policies, and 
circumstances at a training activity.    Each IMS should sign the Checklist to confirm that he/she has 
received the Arrival Briefing.  A copy of the Checklist will be filed in the IMS Training Record. 

IMS NAME: ___________________________________  COUNTRY: ________________ 

RANK/RATE: _______________________  USN EQUIVALENT: ____________________ 

TRAINING INSTALLATION: _________________________________________________ 

ARRIVAL DATE: _______  BRIEFING DATE: _______  IMSO: _____________________ 

ARRIVAL INFORMATION 
___ ITO reviewed and correct; original orders signed 
___ Passport/Visa examined and correct 
___ ID Card examined and correct 

SCN Required?  YES ___  NO ___ 
___ IMS Training Record established (initial Training Installation) or reviewed 
___ Country Liaison Officer identified (if applicable) 
___ Sponsor identified (if applicable) 
___ Special needs of IMS identified and addressed as necessary 
___ IMS Security Clearance confirmed 
___ Key base and local area facilities located (housing, classrooms, post office, 

fire/police, commissary/exchange, places of worship, recreation, etc.) 
___ 
___      

Name entered in Base Locator File 
Insider Threat Video reviewed 

ACADEMICS 
___ Academic Standards confirmed 
___ ECL Level confirmed.  Direct Entry Exam required?  YES___  NO___ 
___ Cheating Policy reviewed (See Figure ____) 
___ Field Studies Program (FSP) reviewed 
___ Additional or gap filling training explained 
___ Library location and procedures reviewed 
___ Academic Warning, Probation, and Disenrollment policy reviewed 

HOUSING 
___ Housing arrangements confirmed for duration of training 
___ Off Base/Dependent Housing explained (if appropriate) 

Checklist C.2 
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Messing facilities located; privileges and procedures reviewed 

TRANSPORTATION 

Privately Owned Vehicle Issues Reviewed (cost, safety, insurance, registration) 
SSN required for State Driver's License? YES_ NO_ 
On Base and Off Base transportation explained. 

HEALTH 

Medical/Dental care facilities located, procedures reviewed 
Dependent medical/dental care reviewed (if applicable) 
Billing information reviewed 

EMERGENCY PROCEDURES 

Reporting a fire 
Police emergencies 
Medical emergencies 
List of emergency phone numbers given to IMS 

BASE POLICIES 

Base Regulations reviewed 
Uniform/grooming standards reviewed 
Civilian clothing policy reviewed 
Media/public information matters reviewed 
Equal Employment Opportunity policy reviewed 
Commissary & Exchange located; privileges reviewed and confirmed 
On-base Clubs (Officer, NCO, Enlisted) located; use policy reviewed 
Alcohol abuse policy reviewed 
Unauthorized Absence policy reviewed (24-hour notification policy) 
Sexual Harassment/Gender Equality policies reviewed 

PERSONAL MATTERS 

Living Allowance payment procedures confirmed 
Checking account started as necessary 
Identity Theft concerns reviewed 
Leave/holiday schedule reviewed 

I have received the Arrival Briefing, and I understand the information provided to me. 

International Military Student Signature Date 

Arrival Checklist filed in IMS Training Record. IMSO initials: ___ Date: 
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UNIT 

Checklist C.3
QUICK REACTION 

CHECKLIST 

xxxx 

TITLE 

UNAUTHORIZED ABSENCE (UA) 

STUDENT NAME/ITO#: 

PAGE 1 OF 4 

STEPS ACTIONS 

_ 1. Date/Time Initiated ____ __cl _____ _ 

2. 

3. 

Note: As soon as the IMSO has suspicion that the IMS is UA, run the checklist! 

Notified By: ____________ Phone#: _______ Remarks: _________ _ 

Research and collect information & start making calls to find the IMS: 

__ Let your Training Activity CO know of potential UA 

__ Try to locate student through communication networks (check all cell phone #'s, FACEBOOK, 
Whatsapp, other social media?) 

__ Quarters (Lodging - ( ) xxx-xxxx) Check room for belongings etc. 

__ Class president or senior ranking officer / fellow students - ask if anyone knows anything 

__ Base hospital for possible admission/fatality (Emergency Room - xxx-xxxx) 

__ Check with all course instructors to ensure student did not enter the wrong class. 

__ If IMS is just arriving, and if other IMSOs are on the base, check to make sure they did not pick 
them up from the airport or end up in another unit on base. 

__ Call local hospitals for possible admission/fatality 

( ) xxx-xxxx__ I ( ) xxx-xxxx __ 

__ Check with Installation Security Forces to inquire about unidentified persons which may be your 
student (xxx-xxxx) 

__ Call local law enforcement to inquire about unidentified persons which may be your student 

( ) xxx-xxxx __ / ( ) xxx-xxxx __ 

__ Call NETSAF A CPM and let them know of potential UA 

*When a student is determined to be in a UA status while in travel from one training installation to a follow-on
training location, the IMSO at the student's last installation is responsible for notification and reporting.

REFERENCE'S 
E-SAMM ChlO, Para 10.19,
SECNA VINST 4950.48, Ch 10,
Paras 10-47&10-91, Navy IMSO
Guide, Para 2.10.2

DATE 
(YYYMMDD): 

15 Sep 22 

Checklist Current as of 

23 Nov 2022 
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UNIT 
xxxx 

TITLE 

UNAUTHORIZED ABSENCE (UA) 

STUDENT NAME/ITO#: 

PAGE 2 OF 4 

STEPS 

4. 

ACTIONS 

After reasonable attempts to determine IMS location and status reveals IMS is UA, or after 24 hrs without 

contact (whichever comes first), IMS is designated in UA status. Inform your leadership and contact 

NETSAFA by phone to let them know you are preparing official UA email notification. Do not forward 

the e-mail until NETSAFA has been notified by phone. Follow up with the remainder of notifications/ac­

tions in Step 5. Begin collection of information listed on this page for inclusion in email notification. 

_ Contact Training Activity CO and inform them IMS is now considered UA. Determine who will contact 

next level of chain of command. *Ensure leadership is aware of high potential for media interest. 

_ Notify the NETSAFA Country Program Manager immediately by phone. If unable to contact the CPM, 
contact the appropriate NETS AF A Region Division Lead. If notification is outside normal duty hours, contact 

the NETC Senior Duty Officer (SDO) at 850-554-5312. 

_Provide the information below on the official e-mail notification: (Send as Controlled Unclassified 
Information (CUI). Ensure WCN, IMS name, and UA are in subject line) 

• IMS full name and country of citizenship/origin ( on ITO or SAN Web)
• Passport and visa information (on ITO or SAN Web)

• Effective date and time of absence

• Date of birth / Place of birth (on ITO or SAN Web)

• Last known location

• Last known mobile telephone number of IMS

• Case identification or Work Control Number (WCN) or ITO number (on ITO or SAN Web)

• Type of training and any follow on training for which the IMS is programmed ( on ITO or SAN Web)

• Travel circumstances (flight arrangements, layovers)

• Any information concerning events that may have contributed to the UA status

• Known variations in name spelling or alias - check against passport and visa

• Known relatives or friends and contact information in the United States

• Information on U.S. driver's license (e.g., number, issuing State, expiration date)

• Information and copy of any DoD identification (ID) cards issued ( check with supporting FSS)

• Available financial information, including bank accounts, Credit/Debit card information

• Foreign Identification Number (FIN) (on SAN Web or DEERS/RAPIDS record)

The following are mandatory recipients: NETSAFA Country Program Manager; NETSAFA IMSO 

Manager Lead, local NCIS office; with courtesy copies to your CO; NETSAFA CO; NETSAFA 

N3. For Marine Corps training, ensure USMC TECOM is notified. For Coast Guard training, 

ensure USCG International Affairs is notified. NETSAFA will ensure notification is for­

warded to NIPO, DSCA, DCSA, and National ICE offices. 

Also include other addressee's as necessary: local JAG Office, local security forces 

REFERENCE'S 
E-SAMM ChlO, Para 10.19, SEC­
NA VINST 4950.4B, Ch 10, Paras
10-47&10-91, Navy IMSO Guide,
Para2.10.2

DATE 
(YYYMMDD): 

15 Sep 22 

Checklist Current as of 

23 Nov 2022 
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UNIT 

xxxxx 

CHECKLIST NUM­

BER 

TITLE 

UNAUTHORIZED ABSENCE (UA) 

STUDENT NAME/ITO#: 

PAGE 3 OF 4 

STEPS ACTIONS 

5. In addition to the e-mail notification in Step 4, make the following notifications ifnot already done:

6. 

__ Notify local area Immigration and Custom Enforcement (ICE) office at ( ) XXX-XXXX. 

__ Notify local NCIS office XXX-XXXX. Add to e-mail in item 4. 

__ Notify installation DEERS/RAPIDS office and ensure IDs are terminated for both IMS and author­

ized dependents 

__ Notify local Staff Judge Advocate office who should be aware of USG consular notification require­

ments if the IMS is later arrested. Commercial: XXX-XXXX. Can add to e-mail. 

__ Notify installation Security to update DBIDS status. #: XXX-XXXX. Can add to e-mail 

__ As required, notify NETSAFA N84 at DSN: 459-3017 or 8745 or local finance office to post UA 
information and preclude unauthorized payments. Local FM: XXX-XXXX. 

__ Notify base service agencies ofUA to stop any services (lodging, MTF, library, etc.) Be sure IMS 
did not leave an unpaid lodging bill. If debit card is on file, check if it can be charged. 

__ Request NETSAF A CPM contact SCO to provide instructions for disposition ofIMS personal 
effects, if any. May be chargeable to ITO, work with NETSAFA CPM for details. 

After coordination with NETSAF A CPM: 

__ Update progress message in SAN Web, use A.W.O.L. (TG). 

__ Update progress reports as appropriate if any other information is received. 

*Note: Hold personal effects of a UA IMS for 7 days - Refer to Step 5
**Note: If a UA IMS voluntary returns to U.S. military control or is detained by local police see Step 4. Be sure

to inform your training activity CO & notify NETSAF A by phone, and resend e-mail notification to all recipients
with added situation updates.

REFERENCE'S 
E-SAMM Chl0, Para 10.19,
SECNA VINST 4950.4B, Ch 10,
Paras 10-47&10-91, Navy IMSO
Guide, Para 2.10.2

DATE (YYYMMDD): 

15 Sep 22 

Checklist Current as of 

23 Nov 2022 
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UNIT 

xxxxx 

TITLE 

UNAUTHORIZED ABSENCE (UA) 

STUDENT NAME/ITO#: 

PAGE 4 OF 4 

STEPS Example E-Mail 
Attach copies of ITO, PassportNisa, USID and unused ticket itinerary (if available) to your e-mail. 

TO: E-mail addresses listed in Step 4. 
Subject line for e-mail: CUI//Unauthorized Absence (UA) Notification - BD-D-17I00I-2002, Dan Smith 

THIS IS AN OFFICIAL IMSO NOTIFICATION 

Per the VP-111/CO, Cdr John Doe, the following student from Bandaria has been declared an absconder from his official place of duty at 
VP-111, 1234 First Street, NAS-Pensacola 32508. 

VP-111 IMSO provided the student with an airline ticket to his Follow-on-Training at New Naval Base, OK with a departure date of DD 

MMM YYYY. VP-111 IMSO was notified by SATO via e-mail that the IMS did not use the airline ticket. The IMSO office at New Naval 
Base, OK reported that the student did not arrive via other transportation means. The student did not answer his cell phone, all social me­
dial accounts were turned off and other methods of contact were unsuccessful. IMSO made all efforts to ensure checks were made with 
local hospitals, police etc. before declaring the IMS UA. 

a) IMS full name and country of citizenship/origin: Smith, Dan D. / BANDARIA

b) Passport and visa information: PASSPORT NUMBER - 12345678, VISA NUMBER - 87654321

c) Effective date and time of absence: 2 FEB 2018, 1100 HRS

d) Date of birth: 01 Jan 2000

e) Place of birth: New Town, Bandaria

f) Last known location and IMS's address: Lodging Rm# 1549, NAS Pensacola FL 32508

g) Last known mobile telephone number ofIMS: 210-123-4567

h) Case identification/work control number (WCN): BN-D-17l001-2002

i) Type of training and any follow-on training for which IMS is programmed:
FLIGHT TRAINING START DATE DD MMM YYYY (MASL Dl23456), NAS PENSACOLA, FL
PHYSIO TRAINING START DATE DD MMM YYYY (MASL D654321), NEW NAVAL BASE, OK

j) Travel circumstances (flight arrangements, layovers): See attached itinerary (student did not board the flight)

k) Any information concerning events that may have contributed to IMS absence: UNKNOWN

I) Known variations in name spelling or alias - check against passport and visa: UNKNOWN

m) Known relatives in the United States: Interview conducted with the resident senior student indicated that the IMS had a close relative
living in Houston. Name and contact info unknown.

n) Information on US driver's license (e.g., number, issuing state, expiration date): UNKNOWN

o) Information and copy of any DoD identification cards issued: ATTACHED

p) Available financial information, including bank accounts, Credit/Debit card information: Metabank Debit Card, Acct# 123-45-6789

q) Foreign Identification Number (FIN): 911-92-l l l IF

Please contact me if there are any questions or concerns. 

VP-111 IMSO 

1234 First Street West 
NAS Pensacola FL 32508 
Commercial: 850-123-4567 DSN: 459-4567 
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1. Encrypt the document first using DoD Encryption Wizard then upload it to DoD SAFE. Send the pass­
word to the recipient in a separate email.

OR

2. Password protect the document in DoD SAFE. Send the password in a separate
email to the recipient.

Checklist C.3 QUICK
 REACTION CHECKLIST

If you receive encryption errors when transmitting the UA message, please remove 

attachments and transmit the message unencrypted. Let the recipients know that 

attachments will be forwarded using Encryption Wizard. 

The new DoD SAFE website, https://safe.apps.mil/ is active and readily available for use, follow the guidance be­

low on how to send sensitive information and or large files (PII, PHI, FOUO, CUI), using extra precaution for DoD 

Safe. 
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TITLE 

Checklist C.4 
CASUALTY 
CHECKLIST

XXXXXIMSO 

CASUALTY NOTIFICATION 

STUDENT NAME/ITO# 

CHECKLIST NUMBER 

UNIT 

PAGE 1 OF 5 

Refer to SECNA VINST 4950.4B, paragraphs 10-48, 10-49.c., 10-90, and 10-92 

STEPS 

1. 

2. 

ACTIONS 

**Caution: Do not release information outside of official channels. Advise personnel and/or other IMS' not to 
release/discuss or post on social media until all official notifications are complete** 

When notified, complete as much information as provided) 
Who notified you of the incident: _________ Date/Time of notification: ________ _ 

IMS Rank and Name: _____________ Does the IMS belong to your activity? YIN

ITO Case/Line/WCN: 
---------------

Training Activity Assigned to: ___________ _ 

Base/Location: _____________ _ 

Date/Time of Death: ________________ Place of Death: __________ _ 

Circumstances 
----------------------------------

NOTIFICATIONS: 
__ Ensure your chain of command/training activity CO has been notified as soon as possible 

__ Immediately notify appropriate NETSAF A Country Manager by phone, followed by an e-mail with information 
listed on item 3. Ifunable to contact the CPM, contact the appropriate NETSAFA Region Division Lead. If 
notification is outside normal duty hours, contact the NETC Senior Duty Officer (SDO) at 850-554-5312. 

__ IA W SECNA VINST 4950.4B para 10-90, the initial report will be by telephone followed immediately by a 
priority message. For Navy-sponsored IMS, reports will be made to Navy IPO via the chain of command and Naval 
Education and Training Security Assistance Field Activity. For Marine Corps-sponsored IMS, reports will be made to 
TECOM with information copies to CMC, Navy IPO and Naval Education and Training Security Assistance Field 
Activity. For Coast Guard-sponsored IMS, reports will be made to USCG International Affairs (G-CI) with 
information copies to Navy IPO. Due to the sensitive nature of such reports, distribution will be limited to only these 
organizations or activities. 

Additional Personnel to be notified by the IMSO: 

__ Notify base casualty office, they may be able to assist you 
__ Notify Local Security Forces, NCIS, PSD (ID card) 

__ Notify Local Funeral Home/Base Mortuary Affairs Office (whatever is applicable) You can find out from 
the base mortuary affairs information on local funeral homes who may assist for FMS IMS. 

__ Notify Local Public Affairs office to ensure information is contained (shut down social media if needed). 

__ IfIMS was accompanied, form a team to notify spouse/dependents. Recommend CO, clergy, and fellow country 
IMS be present. Identify agencies to provide grief counseling for family/fellow IMS. 

RFERENCE 

SECNA VINST4950.4B, 
Ch 10, Paras 10-48, 10-
49 .c, 10-90, 10-92 

DA TE (YYYMMDD): 

15 Sep 22 

DOWNGRADING INSTRUCTIONS 

NIA 

CLASSIFICATION 

UNCLASSIFIED 
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CLASSIFICATION UNIT 

UNCLASSIFIED XXXXX IMSO 
TITLE 

STEPS 

3. 

4. 

5. 

6. 

7. 

8. 

9. 

10. 

11. 

CASUALTY NOTIFICATION 

STUDENT NAME/ITO# 

ACTIONS 

PAGE 2 OF 5 

__ IMSO will prepare a Casualty report and it should be sent to NETSAF A and will include: 
- Name of IMS/ITO number and date/WCN/Country
- Request for instructions for disposition of remains (if death)
- Request for permission to perform autopsy if required (if death)
- Identification and location of next of kin if available (check ITO/SAN Web)
- Include the details of the incident (who notified you of the incident, is it an illness, injury or death? Were

other circumstances involved (i.e, DUI/DWI, other?). Were there other IMS or US military/civilians
involved? Any witnesses? Is there a police report?

The following are mandatory recipients: NETSAFA Country Program Manager; NETSAFA IMSO 

Manager Lead; with courtesy copies to your CO; NETSAFA CO; NETSAFA N3. For Marine 

Corps training, ensure USMC TECOM is notified. For Coast Guard training, ensure USCG 

International Affairs is notified. NETSAFA will ensure notification is forwarded to NIPO. 

**If you don't have all the info immediately please note that to the CPM and follow-up as needed 

Coordinate with the base mortuary affairs office in obtaining a death certificate, please forward copy to 
NETSAF A and SCO. A death certificate will be vital for finalizing IMS affairs. 

Funeral or memorial services will not be conducted for IMS until instructions concerning the disposition of the 
remains have been received from NETSAF A and/or NIPO desk officer. NIPO will obtain special instructions on 
the disposition ofremains from the IMS government/Embassy. 

The training installation will coordinate the preparation and transportation of the remains of IMS according to 
authorized disposition instructions. If a local funeral home is utilized to assist in the arrangements for preparation 
and transportation of the remains, the IMSO at the current training installation ( or last training installation if the 
IMS was on leave when the death occurred) should coordinate payment of the funeral home expenses. See 
SECNAVINST 4950.4B, para 10-92.a.(2) for details. 

If an escort is desired, the official representative of the country concerned may designate a staff member and/or 
an IMS to accompany the remains. US personnel are not authorized to escort IMS back to country. IMSO may 

be asked to escort the IMS to the departing US location/base or local airport. 

Per diem and travel costs of the foreign escort accompanying the remains of a USG-funded IMS, (i.e., IMET, 
etc . . .  ) within the U.S. are chargeable to USG funds. Please coordinate with the appropriate NETSAFA CPM and 
NS for funds. 

Travel and transportation expenses for escorts accompanying the remains of an FMS IMS will be borne by the 
foreign government. 

The IMET provided fund cite on the deceased IMS ITO will be used to defray preparation expenses and costs for 
transportation of the remains to the home country. Overseas return transportation costs will be paid from IMET 
funds only for deceased IMS from countries for which travel costs are defrayed from IMET funds. For 
transportation to a country which defrays all or part of the IMS travel costs, the country concerned must arrange 
and pay for that portion, either through the CLO or the official foreign government representative. Coordinate 
the preparation and transportation of remains according to authorized disposition instructions. Coordinate the 
payment of expenses if local funeral home is used for preparation of remains. 

Expenses involved in the death of an FMS IMS are the responsibility of the foreign government. The training 
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CLASSIFICATION UNIT CHECKLIST NUMBER 

UNCLASSIFIED XXXXXIMSO 
TITLE 

STEPS 

CASUALTY NOTIFICATION 

STUDENT NAME/ITO# 

ACTIONS 

PAGE 5 OF 5 

ADDITIONAL REFERENCES - MARITIME - SECNA VINST 4950.4B: 

10-90. Incident reporting 

a. Infractions or incidents of a serious nature, or serious medical conditions or emergencies, involving either IMS
or their Family members will be reported immediately. The initial report will be by telephone followed

immediately by a priority message. For Navy-sponsored IMS, reports will be made to Navy IPO via the chain of
command and Naval Education and Training Security Assistance Field Activity. For Marine Corps-sponsored

IMS, reports will be made to Security Cooperation Education and Training Center with information copies to
CMC, Navy IPO and Naval Education and Training Security Assistance Field Activity. For Coast Guard­
sponsored IMS, reports will be made to USCG International Affairs (G-CI) with information copies to Navy
IPO. Due to the sensitive nature of such reports, distribution will be limited to only these organizations or

activities. Refer to paragraph 10--48 for further instructions.

b. The following will be immediately reported as outlined in paragraphs a, above:
(1) Serious breaches of discipline.

(2) Matters involving civil authorities.

(3) Incidents considered having politico-military implications.
(4) Situations considered outside the purview oflocal commands or installations.

(5) Death

10-92. Decedent affairs 

a. For United States Navy and United States Marine Corps.

(1) When a USG-funded IMS under DON sponsorship dies while undergoing training with U.S. forces or while
traveling in relation to the training, the repatriation ofremains is the responsibility of the DON. Refer to

Descendent Affairs Manual (NA VMEDCOMINST 5360.1) for guidance. Detailed instructions on actions to be
taken with respect to the remains will be provided by Navy Mortuary Affairs (Medical Support Office), Great

Lakes, IL after coordination with Navy IPO (for USN sponsored IMS) or USMC/CG, SECTC MCCDC (for
USMC sponsored IMS).

(2) Statements of expenses for services in connection with the disposition of a deceased IMS under a USG­
funded program will be submitted to Navy Mortuary Affairs for certification. The statements will then be
forwarded to Naval Education and Training Security Assistance Field Activity for addition of the appropriate

accounting data before submitting for payment. Statements for services in connection with the disposition of

remains of a FMS IMS in a training status will be submitted to Navy Mortuary Affairs for certification and

forwarded to the appropriate embassy for payment.
b. For USCG. Contact USCG International Affairs (G-CI) for guidance.

RFERENCE 

SECNA VINST4950.4B, 

Ch 10, Paras 10-48, 10-
49 .c, 10-90, 10-92 

DATE (YYYMMDD): 

15 Sep 22 

DOWNGRADING INSTRUCTIONS 

NIA 

CLASSIFICATION 

UNCLASSIFIED 
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Checklist C.5 
INTERNATIONAL MILITARY STUDENT (IMS) DEPARTURE 

CHECKLIST 

Departure 

The IMSO should ensure that the following items are reviewed and addressed as necessary when an IMS 
departs the training installation. This Checklist may be modified to reflect the requirements and policies 
at a training activity. A copy of the Departure Checklist should be filed in the IMS Training Record. 
IMS NAME: COUNTRY: ----------------

--------

RANKIRATE: USN EQUIVALENT: GRADUATION DATE: 
--- --- ------

DEPARTING TRAINING INSTALLATION: 
------------------

NEXT DESTINATION: 
-------------------------

DEPARTURE DATE: BRIEFING DATE: 
------ -------

BASE FACILITIES CLEARED 

Quarters/Billeting 
Messing 
Clubs 
Academic Buildings 
Library 

ACADEMIC RECORDS REVIEWED FOR COMPLETENESS AND ACCURACY 

IMS Training Record 
Flight Records 
Graduation certificate Honor Graduate? YES NO 

ADMINISTRATION 

ITO reviewed; all amendments and endorsements included and signed. 
Name removed from Base Locator File 
Mail forwarding address 
Financial Records forwarded 
Indebtedness Issues identified and rectified as appropriate 
Enroute travel notice/completion message transmitted 
ID Card collected and/or destroyed. Must be entered in command log for 

accountability (last training activity) 
Medical Records forwarded 
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TRANSPORTATION 

Transportation to next training activity: 
Airline reservations/tickets confirmed 
Travel by POC procedures reviewed (if applicable) 

Passport/Visa reviewed and correct 
Shipment of personal goods arranged 
Shipment of RIM arranged 
Excess baggage authorized ( as applicable) 
Classified Class Notes and materials reviewed, confirmed, and addressed for 
shipment 
POC status confirmed (sold, shipped, etc.) 

Comments: 

I have received the Departure Briefing, and I understand the information provided to me. 

International Military Student Signature Date 

Departure Checklist filed in IMS Training Record. IMSO initials: ___ Date: 

Checklist C.5 
INTERNATIONAL MILITARY STUDENT (IMS) 
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 Checklist C.6
 International Visitor Checklist 

SENIOR VISITOR NAME: ____________________________ COUNTRY: ____________ 

RANK/RATE: ______   USN EQUIVALENT: ______   VISIT DATES: __________________ 

SPONSOR ACTIVITY/COMMAND: ____________________________________________ 

ESCORT OFFICER NAME: ____________________________   RANK/RATE: __________ 

TYPE OF VISIT:  OT _____   DVOT _____   DIPLOMATIC _____   SELF-INVITED ______ 

PURPOSE OF VISIT: _____________________________________________________________ 

_______________________________________________________________________________ 

OTHER MEMBERS OF VISITING PARTY: 
NAME RANK/RATE USN EQUIV. 

______________________________________________ __________ __________ 

______________________________________________ __________ __________ 

______________________________________________ __________ __________ 

______________________________________________ __________ __________ 

______________________________________________ __________ __________ 

A. ADMINISTRATIVE MATTERS

___ Confirm correct spelling/pronunciation of visitors’ names. 

___ Obtain visitor biographical information. 

___ Determine appropriate uniform. 

___ Identify your activity’s Visit Coordinator: ________________________________________ 

___ Identify your activity’s Visitor Escort: ___________________________________________ 

___ Identify local Foreign Liaison Officer: ___________________________________________ 

___ Determine if honors are to be rendered. 

___ Determine level of publicity required and inform PAO. 

___ Confirm disclosure levels authorized for visit, and inform all appropriate command staff.  

___ Determine if and what type mementos will be exchanged. 

___ Confirm interpreter/translator support is available as required. 
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B. TOUR ITINERARY

___ Plan tentative tour and briefing schedule. 

___ Discuss schedule and subjects with applicable section heads. 

___ Firm up proposed schedule for approval. 

___ When approved, contact applicable section heads. 

___ Reserve conference rooms if applicable (specify support required). 

___ Confirm availability of electronic/media, computer support, and other equipment as needed. 

___ Ensure coffee, refreshments, and other personal needs are arranged. 

___ Confirm arrangements for after-hours events as necessary. 

C. TRANSPORTATION

___ Confirm who is responsible for transportation (USG, foreign govt., or individual visitors.) 

___ Determine method of arrival, time, place, flight number, etc. 

___ Contact IMSO/POC of previous activity if visitors are arriving from another command to 
determine best estimated time of arrival. 

___ Determine who will meet the visitors on arrival. 

___ Ensure sufficient number of appropriate kinds of vehicles is arranged. 

___ Determine number of drivers required. 

___ Ensure drivers know directions.  Prepare detailed directions/instructions if necessary. 

___ If visitors are proceeding to another command, inform IMSO/POC at follow-on activity of 
anticipated estimated time of arrival (ETA).  

D. MEALS/RECEPTION

___ Make arrangements at applicable facility for breakfast, lunch, and dinner. 

___ Determine any special dietary requirements. 

___ Determine if there will be a no-host or host affair. 

___ Determine funding source for visit expenses. 

E. QUARTERS

___ Reserve BOQ or motel as applicable. 

___ Register visitor at BOQ or motel. 

___ Determine who will pick up room key. 

___ Confirm funding source/payment procedures. 

 Checklist C.6
 International Visitor Checklist 
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Appendix D  

IMSO Reference 

Guide

 
NETSAFA 

  MAY 24 

147



SC-TMS 
Quick Reference Guide 

for 
IMSOs 

A quick reference guide for navigating 
IMSO functions in SC-TMS 
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Order of Contents 

I. Accessing SC-TMS:
A. Live SC-TMS:
B. Training/Practice SC-TMS:

II. Today At A Glance:

III. General Information for IMSO to keep up-to-date:
A. IMSO POC
B. Location Remarks
C. Physical Location of Training (PLOT)
D. Course Information
E. International Notes

IV. Reports:
A. Projection Report
B. Ad Hoc Report

V. Working with your Students:
A. Student Training Status and Progress Messages
B. Arrival and Enrollment Reports
C. Completion Report
D. Exception Report
E. General Progress Messages and COVID-19 Progress Messages
F. Arrival Information
G. Foreign Identification Number (FIN
H. Academic Report (DD Form 2496)
I. ITO Repository
J. Flight Hours
K. View Student’s Insurance Policy
L. View Student Checklist
M. Update Student Biographical Information

VI. Field Studies Program (FSP):

VII. POC Directories:

VIII. Report a Problem or Question:

I. Accessing SC-TMS:

A. “Live” side of SC-TMS:
 Log into SAN > Training > SC-TMS9
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B. “Training / Practice” side of SC-TMS: Only Use during class or when you want to “practice”!

This IS NOT Live Data. Changes DO NOT AFFECT the live data. 
The “practice” data is refreshed / updated once a week. 

 Log into SAN > Other > SC-TMS9 Training

Important!!! Notice blue border at top with the words ** Training Server **

II. Today At A Glance:

A. See a quick overview of what is going on “today” in training for Schoolhouse.

B. This can be seen on the SC-TMS Welcome Screen (Today At A Glance):
 Log into SAN > Training > SC-TMS9

- LAST DSAMS Refresh – last time the SAN data was updated.
- NEXT DSAMS Refresh – next scheduled SAN data update.
- Active Students who have an ITO Amendment
- Training Line Statuses that have changed from yesterday
- Activities/Schoolhouses – Number of students at your schoolhouse today.
- Program Types – What programs are being used to fund students at your

schoolhouse today. 
- Countries – The top 10 countries with students at your schoolhouse today.
- Courses – The top 10 courses at your schoolhouse with international students

attending today. 

- Click any hyperlink on this window to see additional information.

- Results for training taking place at your schoolhouse “today” (i.e. active students)
can also be customized by clicking the “Today At A Glance Ad Hoc Report” at the 
top left of the webpage. 

III. General Information for IMSO to keep up-to-date:

A. IMSO POC Information:

 Click: Schoolhouse

1. To add a new IMSO POC: Click, “Add New POC” hyperlink > fill out form > click,
Assign POC > Return to Training Activities

2. To update an existing POC: Click the “Pencil & Paper” icon next to the
appropriate name
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3. To delete a POC: Click the “Red X” icon next to the appropriate name

(Hint: Those identified as “Contact Type” = International Military Student Officer 
(IMSO) will receive automated e-mail notices for uploaded ITOs, Arrival 
Messages etc.) 

B. Location Remarks:

Explain general information about your Schoolhouse and the surrounding area.

 Click: Schoolhouse > Location Remarks > put a checkmark in the Update box next to the
comments to update > enter remarks in Comments field > click, Update button 

(Hint: When updating Location Remarks, be sure to check the update box for those 
categories that you are updating.) 

C. Physical Location of Training (PLOT):

The information entered for PLOT will automatically appear on the student’s ITO as the
Location of Training. (If no PLOT is entered, the address of the Primary IMSO will be used.)

 Click: Schoolhouse > Physical Location (PLOT) > fill out form > click Update

(Per AFSAT, Air Force IMSOs cannot view or edit PLOT.) 

D. Course Information:

View information about courses at your schoolhouse.

 Click: Schoolhouse > Active Courses / International Notes > locate appropriate MASL ID
> click MASL ID hyperlink

(Hint: On the window that lists all Active Courses, click Location Code hyperlink to 
see Location Information details.) 

(Hint: Air Force and Navy IMSOs cannot see course prices, per AFSAT and NETSAFA.) 

E. International Notes:

International Notes are remarks associated with a specific course that international
students should be aware of. International Notes are maintained and updated by the 
IMSO. 

International Notes are IMPORTANT for IMSOs to complete in order to emphasize 
information about a course for the IMS!!! 
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 Click: Schoolhouse > Active Courses / International Notes > click, “Int’l Notes” hyperlink
for appropriate course > enter information about the course > click, Update 

IV. Reports:

(Hint, after a report is “Previewed” the results can then be exported to various formats (i.e. 
PDF, Excel, Word etc.) by selecting the desired format from the “Export to the selected format” 
dropdown and clicking Export.) 

A. Projection Report - Shows courses that are programed in the STL for your schoolhouse
during a given date range, sorted by MASL ID or by Start Date.

 Click: Schoolhouse > Projection Report > (By MASL or By Start Date) > Select a date
range (Start Dt. And End Dt.) > enter any other criteria that may be applicable > 
Preview 

B. Ad Hoc Report – View and Search the Standardized Training List (STL) for your schoolhouse
by a wide variety of filter criteria.

 Click: Reports > Ad Hoc > enter the criteria you are searching for > then click:

> “Web Only” button: (To view results in webpage with hyperlinks for additional
information.)

> “Report Only” button: View results in a format that can be exported (i.e. pdf) &
printed.

> “Export To XLS” button: View results in Excel format.

V. Working with your Students:

A. Student Training Status and Progress Messages.

 Click: Schoolhouse > Student Training & Progress Messages

(Hint: The default is to show “Students Active” (i.e. students who should be at your 
schoolhouse today based on the STL. If needed, use dropdown boxes at the 
top to change the criteria.) 

(Hint: If you want to see all courses in a student’s training track [not just the active 
course at your schoolhouse]: After clicking Student Training & Progress 
Messages, then check the “Show Entire Training Track” checkbox and click 
Search. 
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Hint: Click hyperlinks on the page to see additional information: e.g. 

- Click, Student name hyperlink to see the student information form

- Click, ITO Number hyperlink to view the ITO

Hint: Arrive column: Green Checkmark icon indicates Arrival Report has been 
completed. 
Pad and Pencil icon indicates Arrival Report needs to be 
submitted. 

Enroll column: Green Checkmark icon indicates Enrollment Report has been 
completed. 
Pad and Pencil icon indicates Enrollment Report needs to be 
submitted. 

Complete column: Checkmark icon indicates Completion Report has been 
completed. 
Pad and Pencil icon indicates Completion Report needs to be 
submitted. 

PM column: Use “Hand Holding Paper” icon to submit general Progress 
Messages. 

B. Arrival and Enrollment Reports – IMSO must identify when a student has Arrived and
Enrolled: 

1. Arrival Report:  Click: Schoolhouse > Student Training & Progress Messages > Locate
student > click “Pad and Pencil” icon in Arrive column > fill out 
form > click, Update 

2. Enrollment Report:  Click: Schoolhouse > Student Training & Progress Messages >
Locate student > click “Pad and Pencil” icon in Enroll column 
> fill out form > click, Update

(Hint: If you wait until the Start Date of the course (according to the STL) you can do 
the Arrival and Enrollment Report at the same time.) 

(Hint: When the Enrollment Report is submitted, this will change the Training Line 
Status (TLS) to EN (Enrolled). This change will appear in the STL the following 
day.) 

3. Group Enroll: Submit an Arrival and Enrollment report for many students at the same
time. 

Hint: Wait until the Start Date of the course. 
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Only Group Enroll those students that Arrived and Enrolled as scheduled 
according to the STL. i.e. Report and Start dates are correct. 

> Click: Schoolhouse > Student Training & Progress Messages > Group Enroll
> click the checkbox for those students who arrived and enrolled as
scheduled per the STL > Submit > Return to Student Training Status List

C. Completion Report – IMSO must identify when a student has Completed the course:

1. Completion Report:  Click: Schoolhouse > Student Training & Progress Messages >
Locate student > click “Pad and Pencil” icon in Complete 
column > Fill out form > click Update 

(Hint: When the Completion Report is submitted, this will change the Training Line 
Status (TLS) to CO (Completed). This change will appear in the STL the 
following day.) 

2. Group Completion Report: Submit a Completion Report for many students at the same
time. 

 Click: Schoolhouse > Student Training & Progress Messages > change “Students
Active” dropdown box to “Students Completed Last 30 Days” > View > 
click “Group Complete” button > click the checkbox for those students who 
completed as scheduled per the STL > select appropriate Status and Honor 
Grad dropdown selections > Submit 

D. Exception Report – Shows training lines that need one or more of the following reports to be
completed: Arrival, Enrollment or Completion Report. 

(The default is to show those Arrival, Enrollment or Completion Reports 
that were due within the last month.) 

 Click: Student > Exception Report > (Pad and Pencil icons indicate what reports need to
be submitted.) > click “Pad and Pencil” icon to accomplish the appropriate report. 

E. General Progress Messages – Enter progress messages about a student during training.

(Hint: In addition to general progress messages, you can also enter flight information for a
student going to the next schoolhouse or returning home by submitting a TV (Travel 
Information) progress message. 

The process is the same as for all general progress messages, as shown below.) 

 Click: Schoolhouse > Student Training & Progress Messages > locate the appropriate
student > click the “Hand Holding Paper” icon in the PM column > choose a 
Progress Message from the Progress Message dropdown > enter any applicable 
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Only Group Enroll those students that Arrived and Enrolled as scheduled 
according to the STL. i.e. Report and Start dates are correct. 

> Click: Schoolhouse > Student Training & Progress Messages > Group Enroll
> click the checkbox for those students who arrived and enrolled as
scheduled per the STL > Submit > Return to Student Training Status List

C. Completion Report – IMSO must identify when a student has Completed the course:

1. Completion Report:  Click: Schoolhouse > Student Training & Progress Messages >
Locate student > click “Pad and Pencil” icon in Complete 
column > Fill out form > click Update 

(Hint: When the Completion Report is submitted, this will change the Training Line 
Status (TLS) to CO (Completed). This change will appear in the STL the 
following day.) 

2. Group Completion Report: Submit a Completion Report for many students at the same
time. 

 Click: Schoolhouse > Student Training & Progress Messages > change “Students
Active” dropdown box to “Students Completed Last 30 Days” > View > 
click “Group Complete” button > click the checkbox for those students who 
completed as scheduled per the STL > select appropriate Status and Honor 
Grad dropdown selections > Submit 

D. Exception Report – Shows training lines that need one or more of the following reports to be
completed: Arrival, Enrollment or Completion Report. 

(The default is to show those Arrival, Enrollment or Completion Reports 
that were due within the last month.) 

 Click: Student > Exception Report > (Pad and Pencil icons indicate what reports need to
be submitted.) > click “Pad and Pencil” icon to accomplish the appropriate report. 

E. General Progress Messages – Enter progress messages about a student during training.

(Hint: In addition to general progress messages, you can also enter flight information for a
student going to the next schoolhouse or returning home by submitting a TV (Travel 
Information) progress message. 

The process is the same as for all general progress messages, as shown below.) 

 Click: Schoolhouse > Student Training & Progress Messages > locate the appropriate
student > click the “Hand Holding Paper” icon in the PM column > choose a 
Progress Message from the Progress Message dropdown > enter any applicable 
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information > click the Add button. 
The following is a list of possible “General Progress Messages” 

PM Code Progress Message Title 
TG A.W.O.L. 
AW Academic Warning 
FG Additional Flight Hours Required 
SG Additional Simulator Hours Required 
DP Disciplinary Probation 
DW Disciplinary Warning 
TQ Emergency Leave 
WA Extended - Academic 
WL Extended - Language 
WE Extended - Weather 
WF Extended – Flying 
WM Extended – Medical 
WC Extended- Administrative 
FT Free Text 
HA Hold - Administrative Reasons 
HC Hold - Awaiting Country Disposition 
HM Hold - Medical 
HL Holiday Leave 
HG Honor Graduate 
TH Hospitalized 
MT Medical Appointment (not to exceed one day) 
MR Missing Medical/Admin Information 
NS No Show 
TL Ordinary Leave 
PA Probation Academic 
WR Repeat Block of Instruction 
SL Sick Leave 
SF Sick Leave Family Member 
QT Students Assigned to Quarters for Medical Services 
TV Travel Information 
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F. Arrival Information: - View arrival information entered by a SCO or IMSO.

 Click: Student > Arrival Information

Hint: If arrival Information exists it will be displayed under the general training line 
information with the following labels: Arrival, Remark 

Hint: Notice the dropdown boxes at the top of the window to change the criteria for 
the results. 

G. Foreign Identification Number: (Optional entry)

 Click: Student > FIN Management > click the “Edit” hyperlink next to student’s name >
Enter FIN > Update 

Hint: The FIN can also be entered on the Arrival and Enrollment Reports when these 
are done. 

H. Academic Report (DD Form 2496):

Upload Academic Reports, DD Form 2496, for viewing by SCO, Military Service, GCC etc.
When uploaded, the SCO will receive an e-mail.

 Click: Student > Academic Report (DD2496) > if needed, use dropdown boxes to filter
the criteria to locate the student > click on “Upload File” field for appropriate 
student > locate file to upload and double click it > click, Update > the File Name 
will automatically appear in the Document column. 

Hint: Filenames that are uploaded should NOT include non-alphanumeric 
characters! 

Hint: Once uploaded, click the filename in the Document column to view the 
Academic Report. 

I. ITO Repository: View ITOs and ITO Amendments uploaded by the SCO.

 Click: ITO Repository > if needed, change filter criteria at top of page > click, Submit >
click the “View ITO” hyperlink in “View ITO/Planning ITO” column to see the ITO 
and any amendments. 

J. Flight Hours: (Usually applies to Navy)

Enter Flight and Simulator hours a student has accumulated by equipment type.

 Click: Schoolhouse > Student Training & Progress Messages > Locate the student and
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the appropriate line of training (you may need to use the criteria dropdown boxes 
at the top of the page) > click “Hand Holding Paper” icon in the PM column > 
enter number of hours in appropriate field at the bottom of the page > click the 
Update hyperlink. 

Another way to view Flight Hours is: 

 Click: Reports > Ad Hoc > enter criteria > click “Web Only” button > locate appropriate
line suffix and click “Hand Holding Paper” icon in the PM column. Notice the 
Equipment/Flight Hours section. 

K. View Student’s Insurance Policy: (Applies to Army and Maritime)

For training conducted by Amy and Maritime the IMSO can view the insurance policy
purchased by a student and see if the MILDEP approved the policy as meeting DSCA
minimum requirements.

 Click: Student > Medical Insurance Review > Select appropriate status from Status
dropdown box > Select “View All” from Type dropdown box > click Search 

Results will show that match your criteria. 
Under the “Medical Insurance Policy Document(s) section for the student: 

- To view the insurance policy:  Click: PDF icon
- The Status column will indicate if the MILDEP: Approved, Disapproved the policy or

if the policy is waiting for review.

L. View Student Checklist:

Allows the IMSO to view/access information that has been entered so far for a student or a
group of students. (This is more of a checklist of items the SCO has entered, so far, for 
their student(s)) 

 Click: Student > Student Checklist > In “Track Rpt/End Next/Last Days” section, select
“Reporting Next” from the dropdown box and enter 30 for Days > click Submit 

Results will show what information has been entered, by the SCO, so far for your 
students who are reporting in the next 30 days. 

Depending on your needs, you may want to select different criteria than what was 
illustrated above. 

M. Update Student Biographical Information:

If needed, the IMSO can update a student’s biographical information. The IMSO can
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updated the following fields of the student’s information form in SC-TMS: 
- Foreign Identification Number (FIN)
- Position (current)
- Flight Crew (current position)
- Email address
- Mobile/Cell Phone
- Career Path And/Or PoP

 Click: Schoolhouse > Student Training & Progress Messages > Locate the appropriate
student > Click on the student’s name > update fields as appropriate > Click, 
Update 

You can also access the student form by following the below steps. 

 Click: Student/ITO > Enter the criteria > Click, Submit > Click the Pencil icon in the “Edit
Student” column > update fields as appropriate > Click, Update 

VI. Field Studies Program (FSP):

Keep track of your FSP events, how much they cost and which students attended.
Shows a list of current FSP events that have been completed or planned.

 Click: Schoolhouse > Field Studies Program (FSP) > select Fiscal Year > View

A. New Event Template: Create an entirely new FSP Event Template
 Click: “Create New Event Template” hyperlink > fill out form > click, Save/

Update 

B. Once the event template has been created: Existing Events:

1. To create a new occurrence of an event

 Click: “New Event” hyperlink > fill out form > Save/Update

2. To identify the students who participated in a specific event

 Click: “Assign Students” hyperlink > click the checkbox for each student
who participated in the event > Save/Update 

3. To update information about a specific event occurrence. (i.e. dates, actual
costs etc.)

 Click: “Edit Event” hyperlink > update the form > Save/Update
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4. To delete an occurrence of an event.

 Click: “Delete” hyperlink > OK

VII. POC Directories:

A. IMSO Directory – Lookup any IMSO POC information.

 Click: References > IMSO Directory > Locate schoolhouse > click, Location Code
hyperlink 

B. Military Service CPM Directory – Lookup Military Service POC information.

 Click: References > CPM Directory > Locate appropriate Country (Responsible CPM will
be identified.) 

Another way to view CPM info is:  Log into SAN and click > Training > Country Program 
Mgrs 

C. SCO Directory – Lookup SCO POC information.

 Click: References > SCO Directory > Locate Country Name > click, Country Name
hyperlink 

VIII. Report a Problem or Question:

To report a technical problem with SC-TMS or ask a question about SC-TMS operation, follow
the steps below.

 : At the top of any page in SC-TMS, click “CONTACT US” > enter your comment (be as
specific as possible include error message you are receiving and/or Training Track 
Identifier if applicable) > click, Submit 

An e-mail will be sent to the SC-TMS programmers and Instructors with your comments. 
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Reference Guide D.2 

j SEC 

TRAI 

Maritime 

Insurance Policy Review 

Upload Process via SC-TMS 

31 July 2017 
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Maritime Insurance Policy Review U[!load Process 

A. Requirement:

a. When an international military student or their authorized accompanying (or joining)

dependent(s) have a health insurance policy for medical coverage, the SCO must use

SC-TMS to upload the insurance policy for review by NETSAFA. NETSAFA will review the

policy to ensure it meets the minimum requirements as outlined in SAMM Cl0.9.6.

b. Refer to Maritime policy message _______ for complete guidance and rules

to follow for the insurance review.

c. Below are the steps to accomplish the upload in SC-TMS.

B. Maritime SC-TMS Insurance Policy Upload Process:

Tod 
Idlt.. 
J,1u11t1a 

a. From SC-TMS click Student> Medical Insurance Review
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b. Use the criteria options at the top of the page to locate the student who you will be

uploading the insurance policy for.

The student's basic biographical information must already exist in SC-TMS. 

(i.e. a student record must already be created using Student/lTO in SC· TMS.) 

Medlcal In urance Re\llew 
Mondfy, Much zt, Z017 

�41us- (� IA ,,,.<., ft')..'IJr,,r \'l(." T .. 11 Lo-t b1l .. klrll 

Frs1 f.lepor1 011• •1c:11.1 go 011 a, vl ,f 1 I 
NOlt(Mfn,cf'tdlOlfl, i114' ,.,. ,, .. ll1(1114lltll_1 

26R 111, 

= .... =·R- dO....,...., 

".,..,,,, ,,.,.,.." 

M TomTrain!!' 

Enclosure ( 1) 
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c. Once the student has been located, click the pencil icon, and fill out the Medical

Insurance Document Upload form that appears.

i. Insurance Policy Type dropdown: Ensure to select if the policy covers the IMS

only, Dependent(s) only or Both.

ii. Enter the 1nsurance Policy Number in the appropriate fie Id.

iii. Remarks Block: Enter any darifying remarks as well as all dependents' names

and relationship to the student if the policy covers dependents.

iv. Enter the Insurance Policy Start Date.

v. Enter the Insurance Policy End Date.

vi. Select IMS Training Policy Exceeds Insurance Policy Effective Dates if __ _

vii. Click the Select button and select the .pdf version of the student's scanned

insurance policy. The insurance policy upload should include:

1. Confirmation of Coverage

2. Schedule of Benefits

3. Proofof Purchase

viii. Check the box indicating that the policy does not cover anyone holding a U.S.

Citizenship.

Medical Insurance Document Upload 
P1·8· 17Y001 ·i200 

Please s�leguard 1he da1a associated with foreign s1udents as information 1hat is fo1 official use only. 

Studl!nt: 

Insurance Poliq, Type: 

t;isur.incc Policy Number: 

Remilr".u: 

Insurance Policy StDrt Oate: 

lnsur.ince Policy End Date: 

Upload Insurance Document (PDF): 

Em.iii Recipients: 

II 

IMS 

.. 

D This Policy does not cover anyone holding United States CitiJe<1$hip 

Submtl Request 
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ix. Once the form has ,been fiUed out, click the Submit Request button which will
uploi'ld the document to SC-TMS and nQtify NETSAFAthat an insurance ·policy is
ready for review.

x. If.a stu_derit ras multiple insurance policies thaf need to be reviewed, cHck the
pencil icon again to upload the next insurance policy.

d. Once N ETSAFA has reviewed the insurance policy and made a determination that it does
or d.oes not meet min1mumrequirements, NETSAFAw.ill submit a Progress Message and
the SCO will be notified by automated e-mail indicatjng the findings of NET�4FA.
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DEPARTMENT OF THE NAVY 
NAVY INTERNATIONAL PROGRAMS OFFICE 

1250 10
tH 

STREET SE SUITE 2000 
WASHINGTON NAVY YARD DC20374-5165 

From: Director, Navy International Programs Office 
To: Security Cooperation Officers and International Military Student Officers 

4920 
Ser 230T/18U0167 

MAR 22 2118 

Subj: DEPARTMENT OF THE NA VY PROCESS FOR REVIEW OF HEALTHCARE 
I SURANCE PeLICIES FOR INTERNATIONAL MILITARY AND CIVILIAN 
STUDENTS AND AUTHORIZED DEPENDENTS 

Ref: (a) DoD 5105.38-M Security Assistance Management Manual (SAMM), Chapter 10
(b) DSCA Policy Memo 11-32 of 15 AUG 2011
(c) SECNAVINST 4950.4B of03 JAN 2011
(d) NAVY IPO ltr Ser4920 230T/17U0669 of23 August 2017

Encl: (I) Maritime Insurance Policy Review Upload Process via SC-TMS User Guide 

I. Purpose. To provide guidance for the administration of the Department of the Navy process for
review of healthcare insurance policies for International Military and Civilian Students and
authorized dependents. This memorandum supersedes previous guidance issued via
Ser 240T/13U647 of 25 October 2013, and should be reviewee in its entirety. Effective date of
implementation of subject process is upon receipt.

2. Background. The healthcare insurance policy review has been streamlined with an upload
capability within Security Cooperation Training Management System (SC-TMS) for assessment and
approval. The current process requires an email attaching the request for healthcare review form
along with a scanned copy of the healthcare insurance policy. The new healthcare insurance policy
upload capability increases efficiencies by managing the policy review process within the existing
SC-TMS and eliminating reliance on external mediums of communication.

3. References (a) through (c) establish minimum healthcare insurance policy requirements for
International Military Students (IMS) and International Civilian Students (ICS) and authorized
dependents. Per reference (d), Navy International Programs Office (Navy IPO) has designated Naval
Education and Training Security Assistance Activity (NETSAFA) as the maritime service agent te
execute the new medical review process and has a contract in place to assist the International
Military Student Officer (IMSO) and Security Cooperation Officers (SCO) in determining that the
healthcare insurance policies purchased by the IMS and JCS meet these requirements.

4. When an individual IMS/ICS has been identified by their home country to attend training under
the sponsorship of the Department of the Navy, the SCO will determine whether commercially
procured healthcare insurance is necessary for the IMS/ICS and /or authorized dependents. The
necessity of acquiring such healthcare insurance will vary by training program, by country and by
alternative methods of healthcare coverage that meet the requirement established under reference (a).
If it is determined that commercial healthcare insurance is necessary, the SCO will obtain a copy of
the commercial healthcare in urance policy, in English, from the IMS and upload for assessment by
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Subj: DEPARTMENT OF THE NA VY PROCESS.FOR REVJEW OF HEALTHCARE 
INSURANCE POLICIES FOR iNTERNATI0NAL MiLITAR:Y AND CIVILIAN 
STUDENTS AND AUTH0:RIZED DEPENDENTS 

NavalEducation and Training Security Assistance Field Activity (NETSAf A) via the SC-TfyIS .. 
NETSAFAwill assess the commercial healthcare insurance policies for compliance with Jaws, 
regulations, and pcilides; includingrefere�ces (a). thrcmgh .( c ). Enclosur<;: (l) is guidance to. support 
the prescribed uploading capability. SCOs can upload prospective policies for NETSAFA review 
priorto IMS/JCS procurement to e11sure cc;,nipliance before purchasing. 

5. Every effort must be made to elimin.ate personally identifiable informatie>n '(PU) on the. he�ltlware
insurance polic.y. References in the healthcare .insurance pol Ley to ·any,prote,cted health information,
slic;h as a specific medica, col)tiition as.sociatei. with t.he stu,ent or i.ep_endents, �1:1st also be redacteq.

6, The healthcare insurance policy· review will be completed based existing demand signal, bu.t 
normaUy withi� five working days and th.e compliance dete.rmination wHl be sent to the SCO, IMSO; 
and applicable ·country program manager via progress message in SC� TMS. If the policy is 
determfoed t(,} be ,(!oncompl1;mt, the reason wiil be provided in' the· progress.message. The sco will 
upload the necessary changes for resubmission. If the policy is complaint, the process is. complete, 

7. In.the event that the SCO is unable to access·.the sc..:TMS to upload the healthcare inslir.ance
policy for review, ,the policy must be serit by eni;:ryptea e:-mail to
,;Maritime.Medins.Rev.iew .fot@�avy.mil" forpoltey review consiieration •

. 8. Tbe primary 1ocation:for heaithc.are poHc.y information ts .the DSCA/Defense. Institute. of Security 
CocipenitionStuaies International Ttainfog Mari'agement we.bsite: 
·hctp://www.discs.dsca.mil/pages/itrn/, whe.rethe followip.g.resources.can be fou�d:

a. DoD 5105;3.�-M S.ecqrity A,si-.istanc;e Managemen� Man.ual (SAMM), Chapter 1,0

p. DSC:APolicy Memo 11.,.32.of l5AUG'20ll

c. SEC::NA VINST 4950.4B· of 03 JAN201 l

d. SC-TMS Healthcare Insurance Policy Review User Guise

9. The point of contact for' Navy IPO is the Director of Iiltetnational Training (230T), who can be
reached .at:' (202) 433-5.563, or via e!pail: NlPO'.fRNGPOLICY.fct@navy.mii. i:11e· point o.f c9ntact
for NETS AF A is Mr. Dave Babcock, who cart be reached ·at: (850) 452-:8889 ot .via: email:
daviti.biibcockl @navy,mil

��l� 
E�ecutive Ditec.tor 
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Reference Guide D.3 

A Transaction Control Number (TCN) is a transaction identification number assigned to a submission and 

carried through on the response for tracking purposes. A TCN is a unique alpha-numeric character 

combination used to identify a biometric enrollment file. It is generated upon creation by the enrollment 

system that collects and submits the transaction. 

Below is an example of a TCN structure template. 

6 1 a 9 - 1 12 13 14 1s 16 111s 19 20 21 22 23 24 - I 
--------

1 2 3 4 

Ongioation ldenh ier
(ORI 

GMT T rme Stamp 
Format 

YYYY Dhhmmss 

26 27 28 29 .. 31 32 33 34 • 38 37 38 39 40 

Software 
ameor 

• Le er Unique
C&>dtt 

LSofiware 
Ve,sion Random or Sequential 

Alph -numeric 
code 

Below is an example of an IMS TCN using the above structure. 

IMSIRQ001-20210621075434-BIMO-0360-9JNOU 

IMSIRQ001 is the ORI 

20210621075434 is the GMT Time Stamp 

BIMO is the software name/4 letter unique code 

0360 is the software version 

9JNOU is the random/sequential alpha-numeric code 
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Below is an example of how the TCN is displayed on SOFEX-U in association with the submitted case. 

The SOFEX case contains multiples individuals. 

CEM files are UNCLASSIAED Highest approved dassificat,on ts UNQ.ASSJAEO//FOUO. 

SOFEX ' • • 
--� 

SOFEX-45691 

OSC-1 US EMBASSY BAGHDAD_Baghdad, lraq_20210721064944 

case Details coHections case Documents 

Coltections 

IMSIRQ001-20210621075434-BIMO-0360-9JNOU.EFT 

MALALLAH MAHMOOD IDAN ALAJLAJI 

Collection Classification: U C♦ 
Submitted By. JOH,-,.NY.TAVLORNAVEDO 
Submitted On: 7/21/2021 5:05:06 PM (EST) 

0 Subject Enrollment History 

D Collection Responses 111tsoons-(s) 

� 
------I 
I MSI RQ001-20210621080128· Bl MO-0360-L33RS.EFT 

MOHAMMED HUSSEIN KADHIM KADHIM 

Collection Classification: U Et 
Submitted By. JOHNNV.TAYLORNAVEDO 
Submitted On: 7/21/2021 5:05:07 PM (£ST) 

0 Subject Enrollment History 

C Collection Responses 1 �spon�sJ 

m::.!iilCi':!ill:iJ 

l.!.coect:Ol'l�l�ffll[a Exi,aroA ]ln.-acco�onsi 

MATCH 

I Seect An Action • I 

Coll.a.onD:3'4340 

MATCH 

I s .. ctAnAction • I 
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Below is an example of how the TCN is displayed in a text response from ABIS.

The ABIS response contains either one or multiple TCNs from the same individual.

This particular response is for an IMS submission (TCN: IMSIRQ001-20210621075434-BIMO-0360-
9JNOU). The response shows the submission file and a matching file (TCN: DDB011245-
20100710193136-BATS-4000V-03345).

Each TCN, while associated to the same individual, is a unique identifier associated with a one-time
enrolment.

�
Biometrics Match For TctJ: IMSIRQ001-20210621075434-Bif,0-0360-9JtlOU -� 

**•***•• •• *• **Submission File**** * ... ************* rt 
File Data Source IMS VETTING 
Type of Transaction MAP 
Date Jun 22 2021 12: 00AM 
Transaction Control Number IMSIRQ00120210621075434Bif,003609JNOU 
ABIS Control Number WV0000000-20210721180229-NGEA-1112-05988 
!Jame 
Aliases 
Place of Birth 
Date of Birth 
Reason Fingerprinted 
Date Printed 
Date of Arrest 
Arrest Segment Literal
BAT GUID
BAT Operator Information 
Internment Serial IJumber (ISN) 
Personnel Type 

Doe, John 
<Not in File> 
IQ 
00000000 
IQ-P-TAG001-2303 Capstone 
20210622 
<Not in File> 
<Not in File> 
<Not in File> 
<t-iot in File> 
<Not in File> 
FOREIGN_MILITARY 

********** •• Matching File # 1•;***********,., •

rt 
File Data Source BAT 
Type of Transaction MAP 
Date Jul 10 2010 12: 00AM 
Transaction Control Number DDB01124520100710193136BATS400V03345 
ABIS Control Number WVOOD0000-20100906051336-NGEA-1112-74689 
!Jame AEDAIJ, MALAL LH MAHI-OD 
Aliases <Not in File> 
Place of Birth IQ 
Date of Birth 19690110 
Reason Fingerprinted 
Date Printed 

Volunteer Background Checks 
20100710 

Date of Arrest 
Arrest Segment Literal 
BAT GUID 
BAT Operator Information 
Internment Serial Number (ISN)
Personnel Type 

<Not in File> 
<Not in File> 
0E2FS919FB48454491722236E868CS01 
IRQ: CEtffCOM: USF-I: 2-56IBCT /TFSTEEL/ECPS: IT01211/LIBERTY /BAT /SBAT8CKSA48432/4. 0. 6. 59 
<Not in File> 
FOREIGtJ_tJATIOtJ_HIRE_OCOtJUS 

The TCN of the matching file follows the same structure detailed earlier
( DDB011245-20100710193136-BATS-4000V-03345).

DDB011245 is the ORI 
20100710193136 is the GMT Time Stamp 
BATS is the software name/4 letter unique code
4000V is the software version 
03345 is the random/sequential alpha-numeric code
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      ACRONYMS 

LOA Line of Accounting  ITO Invitational Travel Order 
IMS International Military Student TLA Travel and Living Allowance 
IMSO International Military Student Officer FOT Follow-On-Training 
FMS Foreign Military Sales  IMET International Military Education Training 
EA Expenditure Authority CMS Client Management System  
SANWEB – Security Assistance Network  SAMM Security Assistance Management Manual 

      OVERVIEW 

The NETSAFA IMSO guide for IMS Debit Card/TLA Payments provides IMSO guidance and examples 
for the Debit Card Process and completing an IMS TLA payment.   

Our goal is to streamline each process and provide the best possible service to both the IMSO and IMS 
participating in the program.   

Please read carefully as all processes have changed. 
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ATTACHMENTS 

(1) Fillable First Data Class Roster Template (Class Roster) – (Download to computer to open)
(2) U.S. Debit Card Statement of Understanding (SOU)
(3) U.S. Debit Card Packet Example
(4) IMS Debit Card Helpful Information
(5) Sample Debit Card Authority Spreadsheet W/Instructions – (Download to computer to open)
(6) Fillable Debit Card Authority Spreadsheet
(7) Sample SF-1034 W/Instructions
(8) Fillable SF-1034
(9) Sample DD-577
(10) Fillable DD-577
(11) Lodging Advance Letter Example
(12) Sample DD-1131
(13) Fillable DD-1131

For those personnel who are unable to open the embedded attachments within this document, 
please contact the N84 team and we will send you the documents separately.
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1. ORDERING AN IMS DEBIT CARD:  Attachment (1), which must be downloaded to the computer
to open, is the First Data Class Roster Template (Class Roster).  The IMSO will provide a Class Roster
and the first page of each IMS’ ITO on the roster to the NETSAFA N84 Team via email to
usn.pensacola.netsafapensacolafl.mbx.netsafa-tla-voucher@us.navy.mil within 0-10 days prior to IMS
report date.  DO NOT send class rosters earlier than 10 days prior to the IMS report date.  Only submit a
class roster if the IMS is confirmed and the ITO states that we are paying for entitlements.  If the
IMSO received notification of a new IMS after the class roster has been submitted to the bank, a NEW
class roster with the new IMS’ information must be sent to the NETSAFA N84 Team.  Please ensure you
check all amendments of the ITO for name changes or corrections as incorrect names on the card could
possibly hamper the IMS’ pay.  If the IMS wants a card reissued due to a misspelled name, the IMS
must contact the Customer Service number on the back of the card.  IMS’ will not be reimbursed
for any fees incurred with this card.

a. There should be an approved ITO in the SANWeb at the time of submission of the class roster to
NETSAFA.  IMSOs must also attach Page 1 of the ITO along with any name change amendment so 
the NTESAFA N84 Team can verify the proper spelling of each name (If you have multiple ITO’s 
please combine all pertinent documents in one file, in the same order as the spreadsheet, for faster 
verification).  Once the Debit Card request is sent to the bank, it cannot be changed or deleted.   

b. If the class roster is not filled out properly, the NETSAFA N84 Team will return it to the IMSO
for corrections, which will delay the Debit Card processing time.  The NETSAFA N84 Team will inform 
the IMSO via email when Debit Card requests are sent to the bank.   

c. The class roster template will only include IMS’ who are receiving a Debit Card.  If IMS is
reporting to your location for FOT and was issued a Debit Card at a previous training location, do not add 
the IMS to the template.  Below are the required blocks to be filled in on the Class Roster.   

**CLASS ROSTER REQUIRED FIELDS – DO NOT MAKE CHANGES TO THE TEMPLATE** 
***NO SPECIAL CHARACTERS ARE ALLOWED***

Column A: First Name (Name will be used to personalize the Debit Card (15 spaces max))  
Column B: Last Name (Name will be used to personalize the Debit Card (15 spaces max))  
Column C: Location – Use Command ACRONYM only (19 space max) 
Column D: Address Line 1 – IMSO office address; cards will be mailed to this address (NO P.O. Boxes)  
Column E: Address Line 2 – only if needed  
Column F: City  
Column G: State – Use only 2 spaces  
Column H: Zip Code (First 5 numbers only)  
Column I: Primary phone – (IMSO PHONE NUMBER – NO DASHES)  
Column J: Leave Blank  
Column K: The format will always be an upper case N (DO NOT CHANGE)  
Column L: DOB – fill in using mmddyyyy format  
Column M-W: Leave Blank  
Column X: The format will always be 00.00 

d. It will take approximately 7-15 business days for the IMSO POCs to receive the Debit Card in the
mail from the time the NETSAFA N84 Team orders the card(s).  Debit Cards are sent directly from 
NYCB to the address listed on the class roster template with attention to the IMSO. 

The processing instructions at the top of the spreadsheet are for NETSAFA personnel only. 
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e. If an IMS is reporting to your location for follow-on-training (FOT) with a Debit card, they will
continue to use the same card for payments as long as NETSAFA issued the card, (Upon arrival at your 
location, the IMS is required to change the address with NYCB).  

f. If the IMS has FOT from your unit, they are required to keep their card as the IMS will continue to
receive living allowance payments utilizing that same debit card until IMS returns to their home country.   

g. IMSOs are required to ensure the IMS has a debit card from their previous location.  If IMS does
not have their debit card or was not issued a debit card at their previous training location, it will be 
essential for you to order the IMS a debit card. 

2. RECEIVING/ISSUING THE DEBIT CARD:

a. The IMSO MUST ensure all debit cards that were requested have been received.  If an IMS is
cancelled, replaced, or fails to report, please inform the NETSAFA N84 Team immediately. 

b. The unused debit card must be mailed in its
original packaging to

c. Once the debit card is received, the IMSO is required to issue the debit card to the IMS upon in-
processing or when the Debit Card is received.  The IMS is required to sign a Statement of Understanding 
(SOU) (Attachment (2)) when the debit card is accepted from the IMSO.  The IMSO is required to keep 
the SOU on file.  All information regarding the debit card will be included in the envelope the IMS 
receives with their debit card.  IMSOs must update a “Free Text” Progress Message in the SANWeb to 
indicate if/when the IMS has been issued a Debit Card.   

3. REGISTERING AND ACTIVATING THE DEBIT CARD:

a. The IMSO is required to assist the IMS in activating the debit card.  Activation of the debit card
also includes designating a PIN.  All information on how to activate the debit card will be included in the 
debit card packet from the bank. 

b. The IMS is required to change their address on the debit card each time the IMS changes training
locations to the address of their new location.  All information about this process will be included in the 
debit card packet from the bank. 

c. The NYCB Debit Card will remain active during the IMS duration of training while in the United
States, not to exceed a period of 5 years. 

e. If IMS chooses to close their NYCB account prior to returning to their home country, the IMS
must call NYCB. 

f. IMSOs should give the IMS a copy of Attachments (3) and (4) as reference material.

4. LOST CARD.  If the IMS loses the debit card, the IMS must contact NYCB directly to request a new
debit card.  The new debit card will be sent to the address on file with NYCB; it is very important that
the IMS update the address at each new training location.  If the IMS orders a replacement debit card,
a non-refundable shipment fee could be incurred.

COMMANDING OFFICER 
NETSAFA N84 (DEBIT CARD) 
250 DALLAS ST, SUITE B 
PENSACOLA, FL 32508-5269 
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5. IMS ISSUES/COMPLAINTS:

a. If the IMS has any issues/complaints regarding the NYCB Debit Card, the IMS should inform the
IMSO/IMSO POC immediately.  The IMS will NOT contact the NETSAFA N84 Team under any 
circumstance.  The IMS can contact NYCB Customer Service 24 hours a day/7days a week.  The NYCB 
Customer Service phone number will be on the back of the Debit Card. 

b. The IMS should install the Money Network mobile app to check their account balance, view their
most recent transactions, and locate NYCB branches and associated ATMs.  Do not use third party 
applications to transfer funds as this has resulted in theft. 

c. IMSO’s are to advise the IMS this is a NYCB-issued debit card and they can use it to withdraw
funds at any PLUS, Interlink or Star affiliated ATM surcharge free.  Other ATM locations a fee will be 
assessed.  The IMS can also perform cash back transactions when using the debit card at any point of 
purchase/sale or retailers, however, IMS should be cautious and read any signs posted by the merchant 
regarding additional charges associated with cash back transactions.  

d. The account will not close automatically upon departure of the IMS.  The IMS will have to contact
the bank (phone number provided in the back of their cards) and request the account to be closed once 
they are sure that they are not going to any further training and all funds have been removed. 

6. Travel and Living Allowance (TLA) Purpose:  International Military Students (IMS) that are entitled
to Travel and Living Allowance (TLA) payments need a reliable, secure, and expedient method to access
these funds. DFAS is the paying office for all payments from NETSAFA. In conjunction with DFAS, the
following process has been developed so IMSs can receive timely TLA payments.

a. All TLA payments to each IMS will be deposited directly to their debit card account.

b. TLA packages are submitted every 30 calendar days for the month of entitlement.

Example 1: 1 – 31 May is acceptable 
Example 2: 13 April to 12 May is NOT a calendar month processing. 
Scenario: Based on Example 2, If IMS arrived 13 April, the first TLA package is submitted from 13       

April to 30 April. The second TLA package is submitted for 1 – 31 May, one for each individual 
calendar month. 

(1) TLA is authorized for payment not to exceed 45 days (DODFMR Volume 9, Chapter 5,
050501) at the beginning or the end of each training location timeframe on the ITO, every TLA request 
forward is for 30 calendar days.  

(2) DFAS does not have a monthly timeframe to submit TLA vouchers and can take voucher
requests on all working days.  

          Example: Current month is May.  Only TLA requests for May and earlier may be submitted.  
However, you may submit TLA vouchers up to 5 working days prior to the first of the month with 
the understanding that members will not be paid prior to the first day of the entitlement month. 
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c. Per the Security Assistance Management Manual (SAMM), Chapter 10 applies.  All IMSO’s
should read Chapter 10 in its entirety.  Chapter 10 also includes a table for the Daily Supplemental 
Living Allowances for IMS. 

C10.13.8.1, An IMS authorized TLA should be provided advance TLA, equivalent to the U.S. military 
TLA for the same period, prior to departing their home country. The amount of the advance TLA should 
be a minimum of two weeks but could be up to 30 days if required by the training location, or the entire 
TLA authorized, if the total training duration is five weeks or less. The SCO will indicate on the ITO the 
amount of advance TLA issued to the IMS. In the event the home country government provides the IMS 
with an additional advance that covers the first 30 days, the SCO will not be required to provide advance 
TLA prior to the IMS's departure.  

C10.13.8.2 The IMSO is authorized to coordinate directly with the SCO to identify any reason the SCO 
did not issue the full entitlement, before issuing the IMS the difference if required to ensure the IMS is in 
a living allowance accrual process, whether living on or off post.  

C10.13.8.3 Accompanied IMS living off post/base attending courses where dependents are encouraged 
(See Table C10.T11.), may draw a living allowance advance upon arrival in CONUS of an amount equal 
to the estimated living allowances for the first 45 days at a particular location.  

C10.13.8.4 The IMS living allowance drawn during the period of training is adjusted to ensure that the 
amount of the advance is fully recovered before the student completes training at that location. The 
SCO/IMSO will work collaboratively to ensure that living allowance amounts advanced, prior to the IMS 
departure for training and upon arrival in CONUS, do not exceed the 45 day estimate. 

7. Travel and Living Allowance (TLA) Process:  Steps a–e apply to all IMS entitled TLA payments:
NOTE: Handwritten documents will not be accepted.

a. IMSOs will prepare the TLA package in the order shown below (all will be separate files):

(1) Complete a Debit Card Authority spreadsheet (Attachment (6)).  You are able to submit one
attachment with multiple personnel as long as each IMS has the same line of accounting.  You will need to 
complete attachment (6) for each person that has a different line of accounting.  Step-by-step instructions for 
completing Attachment (6) are located in Attachment (5). 

(2) Complete a SF-1034 to accompany each Debit Card Authority spreadsheet (Attachment (8)).
Step-by-step instructions for completing Attachment (8) are located in Attachment (7).   

(3) Copy of current DD-577 (Attachment (10)) of Certifying Officer signing the SF-1034.
Attachment (9) is an example of a completed DD-577.  All personnel submitting vouchers for payment 
must be designated a Certifying Officer and a corresponding DD 577 must accompany all vouchers 
showing Certifying Officer designation.   

(4) Current copy of Certifying Officer’s training certificate.  This certificate does not need to
accompany every package.  After the initial submission you only need to send a new certificate upon 
completing required annual training.  Certifying Officer training course can be found at 
https://fiscal.treasury.gov/cotraining.  **NOTE: Contractors cannot be Certifying Officers.  

(5) ITOs of all personnel on the Debit Card Authority spreadsheet.  Please only forward up to the
page that has the Line of Accounting (usually just the first page of most ITOs) including all modifications 
changing the name or line of accounting.  In order for NETSAFAs personnel to quickly verify the line of 
accounting, please ensue the file with the ITOs is in the same order as the names on the Debit Card 
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Authority spreadsheet.  Please do not send a separate copy of each ITO as it will take considerably more 
time to process your claims. 

b. Lodging advance.  As noted in the SAMM and quoted on page 7 of this document, IMSOs may
request lodging advance for the IMS and can be obtained by submitting the following:   

(1) Memorandum requesting lodging advance.  Attachment (11) is a good example.

(2) Memorandum will reference the message “SECDEF Washington DC//USDP-
DSCA//141441Z APR 03”. 

(3) Lodging advance will not exceed 10% of overall TLA entitlement.

(4) Repayment schedule to encompass TLA period.

(5) Lodging advance can be paid on first TLA request if desired. Properly update Attachment (9).

c. If voucher submission is the IMS’s FINAL VOUCHER at the current location, the package MUST
be submitted to NETSAFA NLT 10 working days prior to the IMS’s last day of training. 

d. All TLA voucher requests and resubmissions are to be sent through DoD SAFE to the NETSAFA
N84 Team by using the group email at:  usn.pensacola.netsafapensacolafl.mbx.netsafa-tla-
voucher@us.navy.mil 

e. The NETSAFA N84 sends paid settlement voucher to the IMSO on request.

8. TLA Entitlement Overpayment.  If an IMS has been overpaid TLA entitlements and unable to
recoup prior to IMS leaving the country by checking the next month’s pay.  Follow steps below:

a. IMS must acquire a cashier’s check or money order for the total amount of the overpayment made
payable to “DFAS CLEVELAND”.   

b. Complete blocks 3a-d and 6 through 10 of DD Form 1131 - Attachment (13).  A sample DD-1131
is Attachment (12). 

c. Place signed DD Form-1131 and check or money order in an envelope and mail to:

COMMANDING OFFICER 
NETSAFA (N84 TLA TEAM)  
250 DALLAS ST, SUITE B 
PENSACOLA, FL 32508-5269

9. NETSAFA N84 Customer Service Support:  N84 is the TLA Voucher Customer Service support
for all IMSO’s.  All inquiries should be directed to: usn.pensacola.netsafapensacolafl.mbx.netsafa-tla-
voucher@us.navy.mil.  Please include the transaction information that the N84 team sends for verification
of package submission when requesting a status as shown below: 

NETSAFA ORIGINATOR  IMS NAME  REQUEST TYPE  AMOUNT  IMSO  DATE SUBMITTED 

ABBOTT 2533  BEAR, TEDDY I.  EA ‐ MARCH  $3,980.31   BANKS  10/3/2022 

N84 will return incomplete and erroneous packages to the IMSO for action/correction. N84 Personnel do 
not prepare or correct documents. 
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Medical Care Entitlement Summary 

I MEDICAL CARE FOR IMS'S AND THEIR AUTHORIZED DEPENDENTS 
lcATEGORYI PRIORITY louTPATIENT !INPATIENT I DENTAL 
IIMET IMS 
INATO/PfP !same as U.S. military !No charge !cost varies !No charge

IN on-NATO !space A !cost varies !cost varies Emergency Only
Cost varies

IFMSIMS 
INATO/PfP !same as U.S. military !No charge !cost varies !No charge

'Non-NATO !space A !cost varies Cost varies Emergency Only
Cost varies

!DEPENDENTS (Authorized in ITO)

rATO/Pfl' Same as U.S. Millitary ro charge
Emergency Only 

Cost varies Space A Dependent No charge 

ron-NATO !Space A
Emergency Only 

Cost varies Cost varies Space A 
Cost varies 

I COLLECTION ACTION 

I 
I Category
IIMET IMS 
INATO/PfP 
!Non-NATO

IFMSIMS 

U .S. MILITARY 
FACILITY 

I (See ITO) 

IIMETP(l) 
IIMETP(l) 

INATO/PfP lease/IMS/Foreign Govt 

!Non-NATO lease/IMS/Foreign Govt

!D ependent (Authorized ITO)

!NATO/PIP IWS/Foreign Govt 

ron-NATO IWS/Foreign Govt 

I Emergency 

IIMETP 
IIMETP 

lcase/lMS/F oreign Govt 

lease/IMS/Foreign Govt 

IMS(2)/ Foreign Govt(3) 

IMS(2)/ Foreign Govt(3) 

I 
CIVILIAN 
FACILITY 

I N on-Emergency

IIMS/F oreign Govt 
!IMS/Foreign Govt

Case/lMS(2)/F oreign 
Govt 
Case/lMS(2)/F oreign 
Govt 

IMS(2)/Foreign Govt/ 
TRICARE Standard 
Extra 
IMS(2)/Foreign Govt/ 
TRICARE Standard 
Extra 
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NATO Member Countries: 

Albania; Belgium; Bulgaria; Canada; Croatia; Czech Republic; Denmark; Estonia; France; 

Germany; Greece; Hungary; Iceland; Italy; Latvia; Lithuania; Luxembourg; Netherlands; 

Norway; Poland; Portugal; Romania; Slovakia; Slovenia; Spain; Turkey; United Kingdom; 

United States. 

NATO Partnership for Peace (PfP) Countries: 

Albania; Armenia; Austria; Azerbaijan; Belarus; Bosnia and Herzegovina; Bulgaria; Croatia; 

Czech Republic; Estonia; Finland; Georgia; Hungary; Ireland; Kazakhstan; Kyrghyz Republic; 

Latvia; Lithuania; Malta; Moldova; Montenegro; Poland; Romania; Russia; Serbia; Slovakia; 

Slovenia; Sweden; Switzerland; Tajikistan; The former Yugoslav Republic of Macedonia 

(FYROM); Turkmenistan; Ukraine; Uzbekistan. 

For current listing of countries see http://www.nato.int/. 

Table Notes: 
(1) See JSCET Paragraph 8-12 -Provides information and guidance for emergency medical care.

(2) Health Insurance is required when IMS is responsible for payment for medical care and
extends to authorized dependents. Guidance Sources:

1. DSCA Policy Memorandum 11-32 dtd 15 Aug 2011.
http:/ /www.samm.dsca.mil/policy-memoranda/dsca-11-32 

2. IMS ITO; Block 12.
3. JSCET, Paragraph 8-7.
4. DON Process for Review of Healthcare Insurance Policies for International Military

and Civilian Students and authorized dependents, of22 Mar 2018 -directs the SCO to upload 
healthcare insurance policies for coverage review to SC-TMS 9 or to send policies by encrypted 
e-mail to Maritime.Medins.Review.fct@nayy.mil.

(3) There are exceptions where reimbursement for medical care for dependents is authorized by
FMS Case and specified on the IMS's ITO.
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1 Table C10.T12. Daily Supplemental Living Allowances for 
2 International Military Students (IMS) under Security Cooperation 
3 Programs 

4 

Govt or Authorized 
Living 

# 
Contracted 

Mess 
Dependents Dependents 

Allowance Remarks 
Govt Encouraged Accompany 

Rate 
Quarters Student 

Actual cost of 
lodging and 
utilities (not-
to-exceed 
(NTE) 
maximum 
lodging rates 
stated in the 

1 Yes No No Joint Federal 
Travel 
Regulation 
(JFTR)) 

+ JFTR local
meal rate

+ $11 special
IMS incidentals

A statement 
of non-
availability or 
equivalent 

Actual cost of must be 
lodging and issued to the 
utilities (NTE IMS and filed 
maximum with voucher. 
lodging rates 

IMS must also 2 No No No stated in JFTR) 
provide 

+ JFTR local lodging and 
meal rate utility receipts 

+ $11 special and, if 

IMS incidentals applicable, a 
copy of rental 
agreement or 
lodging 
receipt. 

Actual cost of 
lodging and 
utilities (NTE 
maximum 
lodging rates 

3 Yes Yes No stated in JFTR) 

+ JFTR
government
meal rate

+ $11 special
IMS incidentals

5 
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Actual cost of 
lodging and 
utilities (NTE 
maximum 

One or lodging rates 

4 Yes 
two meals 

No stated in JFTR) 
are 

+ JFTR
available 

proportional
meal rate

+ $11 special
IMS incidentals

Yes and free of 
Yes and 

$11 special IMS 
5 

charge 
free of No 

incidentals 
charge 

Government 

Yes and free of 
Available meal rate 

charge 
aboard No 

+ $11 specialship 
IMS incidentals

Yes but 
International 

7 Military Student $0 
chooses to live off

base/post 

Actual cost of Availability of quarters is 

lodging and based upon the availability 

utilities (NTE of government family 

maximum housing. 

lodging rates IMS must provide lodging 
No No Yes Yes stated in JFTR) and utility receipts and, if 

+ JFTR local applicable, a copy of the 

meal rate rental agreement, and 
certify that dependents 

+ $11 special reside with IMS for at least 
IMS incidentals 75% of the course duration. 

Actual cost of 
lodging and 
utilities (NTE 
maximum 
lodging rates 

Yes No Yes stated in JFTR) 

+ JFTR local
meal rate

+ $11 special

IMS incidentals

Actual cost of 
lodging and 
utilities (NTE Availability of quarters is 
maximum based upon the availability 

10 Yes Yes Yes Yes lodging rates of government family 
stated in JFTR) housing. 

+ JFTR local
meal rate
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 INSTRUCTIONS FOR USING THE SANWEB 
TO COMPLETE THE T-MASL REVIEW 

Login into SANWeb at:  https://san.dsca.mil/SANWeb/login/MainUP.aspx using your assigned Username 
and Password or CAC.   (You must be a registered user to access the system.) See SC-TMS Quick Reference 
Guide for IMSOs, Figure 1.2 of this guide, on how to get access if not a registered user. 

Once in SANWeb Cloud, under the Training Tab, select SC-TMS.  Select the Schoolhouse tab. 

UPDATE TO TRAINING LOCATION INFORMATION 

The Schoolhouse page is an editable screen for updating the point-of-contact, email address, and mailing 
address.  Additionally, in the Location Remarks link, text fields are available for adding other useful 
information as follows: 

Training Activities – Identify the training and/or education organizations 

Student Arrival/Departure – Include preferred airport of arrival and departure 
             and directions from the airport. 

Billeting – Include availability, daily rates, and if dependents are authorized.  If 
billeting or living arrangements are outside the DoD network, there is no way for N4 
to know rates and address for these locations.  This information must be noted in the 
billeting section or sent to N42. 

Climate – Include high and low temperatures for the area. 

Dependents-Include unique guidance for authorized dependents 

Driving - Include driver’s license and vehicle ownership requirements. 

General Information – Include any pertinent information  

Medical – Include medical facility information. 

Dining/Messing – Include availability of messing facilities and estimated meal costs. 

Nearest Military Base, Nearest City, Servicing Airport – self explanatory 

Transportation – Include availability of bus, taxi, shuttle, etc. 

Uniform Information – Include seasonal uniform requirements. 

When changes or additions are complete, click on Update at the bottom of the screen. 

UPDATE TO T-MASL COURSE INFORMATION 

All course information should be reviewed for accuracy and updates and changes recommended as 
necessary.  IMSOs should request changes in the T-MASL through the SC-TMS. 

Log on to the SAN Web and proceed to SC-TMS. Once you are at the SC-TMS: 

1. Select the MASL tab;

2. Search Box appears, Type in MASL ID and select the red Search box;

3. Click on MASL ID Listed;

4. Select Course Revision Request link at top left of screen;

5. Describe the requested change and re-click ‘Request Course Revision’ to generate an E-mail to
NETSAFA.

 
NETSAFA 

  MAY 24 

184

https://elnath.idss.ida.org/SANWeb/login/main.aspx?&dt=1/22/2016%209:59:14%20AM
https://elnath.idss.ida.org/SANWeb/login/main.aspx?&dt=1/22/2016%209:59:14%20AM
https://elnath.idss.ida.org/SANWeb/login/main.aspx?&dt=1/22/2016%209:59:14%20AM
https://elnath.idss.ida.org/SANWeb/login/main.aspx?&dt=1/22/2016%209:59:14%20AM
https://elnath.idss.ida.org/SANWeb/login/main.aspx?&dt=1/22/2016%209:59:14%20AM
https://elnath.idss.ida.org/SANWeb/login/main.aspx?&dt=1/22/2016%209:59:14%20AM
https://elnath.idss.ida.org/SANWeb/login/main.aspx?&dt=1/22/2016%209:59:14%20AM
https://elnath.idss.ida.org/SANWeb/login/main.aspx?&dt=1/22/2016%209:59:14%20AM


COURSE/T-MASL ELEMENTS DEFINITIONS 

Course No. – Courses included in the Catalog of Navy Training Courses (CANTRAC) are identified with 
a Course Identification Number (CIN).  The CIN consists of seven or eight alpha/numeric characters with 
the first character representing the course sponsor.  When the course is not reported in CANTRAC, the 
Course No. field may be blank or may be used for a special identifying number unique to the branch of 
service (i.e., Marine Corps, Coast Guard, Army, or Air Force) or unique to the type of training (i.e., 
Correspondence Course = Correscourse). 

Training Military Articles and Services List (T-MASL) Number – A six-digit number assigned by 
NETSAFA to each course of instruction available for attendance by international students. 

Course Title – An abbreviated course title designed to identify the training contained in the course (limited 
to 26 characters). A complete course title should be added to the course description field. 

English Comprehension Level (ECL) - Courses are assigned an English Comprehension Level to indicate the 
level of English comprehension an international student should be capable of to obtain the maximum benefit 
from the course. Courses are assigned numeric numbers usually ranging from 70 to 85 for Navy Training.  An 
ECL of 80 is assigned for courses that are considered to be high risk to either the student or instructors. An 
ECL of 70 is a normal standard for international student entry requirement. 

Security Clearance - The Security Classification is the highest level of classification to which USN students 
are instructed in the course, as shown by the following Definition Codes: 

U = Unclassified 
C = Confidential 
S = Secret 
TS = Top Secret 
W = Submarine Training 

To identify courses of instruction on equipment and training material within the Special Intelligence (SI) 
Community control the classification is: 

Z = Top Secret SI 

Duration – The course duration is viewed in calendar weeks in the SAN IMSO Web.  The duration 
is established based on the class convening date and the class graduation date and includes 
weekends. 

Course Description – An in-depth description of the training detailing the knowledge and skills that 
will be achieved when training is complete. 

Prerequisite Text – identify requirements such as rank, special medical or fitness requirements, 
career field, skills necessary to enroll in the course 

Prerequisite MASL – identify any MASLs for courses that must be taken prior to enrollment in this 
MASL 

International and MASL Notes – These sections can be added and modified to SC-TMS without 
assistance from NETSAFA N4.  Information that provides unique programming data considered 
vital for specific courses of instruction attended by international students. Notes, generally 
speaking, are created when there is a history of administrative or programming errors associated 
with that course of instruction. Some examples of the type information included in notes are: 
Special clothing or equipment required for student to attend the course of instruction; unique 
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reporting requirements; strenuous physical requirements (e.g., for diving courses); student 
biographical data required in advance of student arrival, etc. 

Location Details –This information matches what is edited on the Schoolhouse tab. This is updated by the 
IMSO/training activity without assistance from NETSAFA N4. 
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NETSAFA IMS NEATS Process: 

1. Training Site International Military Student Officer (IMSO) submits NETSAFA NIPRNET Enterprise Alternate Token
System (NEATS) Foreign National (FN) Request Spreadsheet (Naval Information Warfare Center (NIWC) form below) Via
email to the Submitting Trusted Agent (STA) on FN Request Spreadsheet.

2. NETSAFA (STA) submits NETSAFA NEATS FN Request Spreadsheet requesting “Registration only” to NIWC. Via email
to: niwc_lant_pki.htra.fct@us.navy.mil

3. NETSAFA STA forwards NIWC’s approval email with attached NETSAFA NEATS FN Request Spreadsheet to Token
Issuer (TI).

4. TI responds acknowledging receipt; programs token and informs all parties when complete.

5. TI reviews NEATS with STA-who confirms, records, requests overnight shipping label, provides IMSO tracking, then TI
will package NEATS & initial PIN send out via FEDEX

6. IMSO verifies International Military Student (IMS) NEATS token was received and IMS has access with Learning
Management System (LMS).
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Action Required * 
NEATS Token Flow Chart 

YES 

NO 

* 

* 

Training Site IMSO 
previews projected 
IMS inbound gains 

IMS 
requires 
NEATS to 

access 
 

START 

NO 

YES IMSO 
submits 
request 
to STA 

NIWC notifies STA upon 
completion 

TI issues NEATS 

No Further 
Action Required 

IMS 
Can 

Access 
LMS  

Process 
Complete 

STA requests 
Registration to NIWC 

STA notifies TI 

TI/STA review & FEDEX 
OVERNIGHT to IMSO 

IMSO receives & verifies 
IMS access 

NEATS Token Unreadable or 
Needs Pin Reset 

Abbreviation Legend: 

IMS: International Military 
Student 
IMSO: International Military 
Student Officer 
LMS: Learning Management 
System 
NEATS: NIPRNET Enterprise 
Alternate Token System 
NIWC: Naval Information 
Warfare Center 
STA: Submitting Trusted Agent 
TI: Token Issuer 
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Appendix E 

 List of Frequently Used

Acronyms 
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First Data CMS BULK Update 

		First Data
CMS BULK Application
Enroll / Update Template
Payroll v3.0						Instructions:
1. Complete all required fields, failure to do so will cause the file to fail
2. Delete rows 1 and 2 before saving file
3. Check for misspellings and formatting, ensure cells contain Alpha/Numeric Characters only - with the amount field as an exception
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5. To save file: File > Save As > Save As File Type > Text (Tab Delimited) .*txt
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(Required)		Location
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(Optional)		Address Line 1
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(Required)		Address Line 2
30 Spaces
(Optional)		City
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(Required)		State
2 Spaces
(Required)		Zip Code
10 Spaces
(Required)		Primary Phone
10 Spaces
Format: nnnnnnnnnn
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10 Spaces
Format: nnnnnnnnnn
(Optional)		Activate Card
1 Space
Format:  N
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Format:
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(Optional)		Member ID
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(Optional - Must be Unique)		Employer  ID
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(Optional)		Locale
25 Spaces
(Future Use)		Country Code
3 Spaces
(Future Use)		Bulk Shipping
Loc Code
2 Spaces
(Future Use)		Security
25 Spaces
(Future Use)		Trace Number
25 Spaces
(Future Use)		Account Number
17 Positions
(Required for Instant Issue enrollment only)		Card Number
19 Spaces
(Optional)		Amount
8 Spaces
Format:  00.00
(Required)
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APPOINTMENT/TERMINATION RECORD - AUTHORIZED SIGNATURE 
 (Read Privacy Act Statement and Instructions before completing form.)


PRIVACY ACT STATEMENT
AUTHORITY:    E.O. 9397, 31 U.S.C. Sections 3325, 3528, DoDFMR, 7000.14-R, Vol. 5. 
PRINCIPAL PURPOSE(S):  To maintain a record of appointment and termination of appointment of persons to any of the positions listed in Item 6, 
and to identify the duties associated with this appointment. 
SORN T1300 (http://dpclo.defense.gov/Pricacy/SORNsIndex/DODComponentArticleView/tabid/7489/Article/6235/t1300.aspx) 
ROUTINE USE(S):   The information on this form may be disclosed as generally permitted under 5 U.S.C Section 552a(b) of the Privacy Act of 1974, 
as amended.  It may also be disclosed outside of the Department of Defense (DoD) to the Federal Reserve Banks to verify authority of the appointed 
individuals to issue Treasury checks.  In addition, other Federal, State and local government agencies, which have identified a need to know, may 
obtain this information for the purpose(s) identified in the DoD Blanket Routine Uses published at: 
http://dpclo.defense.gov/Privacy/SORNsIndex/BlanketRoutineUses.aspx. 
DISCLOSURE  Voluntary; however, failure to provide the requested information may preclude appointments.


SECTION II -  APPOINTING AUTHORITY
9.  NAME  (First, Middle Initial, Last) 10.  TITLE 11.  DOD COMPONENT/ORGANIZATION


13. SIGNATURE12.  DATE  (YYYYMMDD) 


15.  DATE  (YYYYMMDD) (Not earlier than date in Item 12 or 13)


SECTION I - APPOINTEE
1.  NAME (First, Middle Initial, Last and Rank or Grade) 3.  TITLE


4.  DOD COMPONENT/ORGANIZATION


2.  DoD ID NUMBER


5.  ADDRESS (Include ZIP Code, email address, and telephone number with area code and DSN)


6.  POSITION TO WHICH APPOINTED (X appropriate box - one only.  Checking more than one invalidates the appointment.) 


CERTIFYING OFFICER


DISBURSING OFFICER:  DSSN


DEPARTMENTAL ACCOUNTABLE OFFICIAL
7.  YOU ARE APPOINTED TO SERVE IN THE POSITION IDENTIFIED IN ITEM 6.  YOUR RESPONSIBILITIES INCLUDE:


8.  REVIEW AND ADHERE TO THE FOLLOWING PUBLICATION(S) NEEDED TO ADEQUATELY PERFORM YOUR ASSIGNED DUTIES:


SECTION III - APPOINTEE ACKNOWLEDGEMENT
      I acknowledge and accept the position and responsibilities defined above.  I understand that I am strictly liable to the United 
States for all public funds or payment certification, as appropriate, under my control.  I have been counseled on my pecuniary liability 
applicable to this appointment and have been given written operating instructions.  I certify that my official signature is shown in item 
16 below.
14.  PRINTED NAME (First, Middle Initial, Last)


16.a. DIGITAL SIGNATURE 16.b. MANUAL SIGNATURE


SECTION IV - APPOINTMENT TERMINATION


    The appointment of the individual named above is 
hereby revoked.


17.  DATE (YYYYMMDD) 18.  APPOINTEE INITIALS


19.  NAME OF APPOINTING AUTHORITY 20.  TITLE 21.  APPOINTING AUTHORITY SIGNATURE


DD FORM 577, NOV 2014                


DISBURSING AGENT
COLLECTIONS AGENT
PAYING AGENT
CASHIER CHANGE FUND CUSTODIAN


DEPUTY DISBURSING OFFICER:  DSSN IMPREST FUND CASHIER


ASSISTANT SAFEKEEPING CUSTODIAN
SAFEKEEPING CUSTODIAN


PREVIOUS EDITION IS OBSOLETE. Adobe Designer 9.0







INSTRUCTIONS FOR COMPLETING 
 APPOINTMENT/TERMINATION RECORD - AUTHORIZED SIGNATURE


DD FORM 577 (BACK), NOV 2014 


Use this form to: 
  
1.  Appoint disbursing officers and their agents, e.g., deputy disbursing officers, disbursing agents, paying agents, cashiers, 
     imprest fund cashiers, change fund custodians, and collection agents. 
  
2. Appoint certifying officers.  Certifying officers are those individuals, military or civilian, designated to attest to the correctness 
     of statements, facts, accounts, and amounts appearing on a voucher for payment. 
  
3.  Appoint departmental officials.  Departmental officials are those individuals, military or civilian, who are designated in writing 
     and are not otherwise accountable under applicable law, who provide source information, data or service on which a 
     certifying officer relies when certifying vouchers as correct and proper for payment. 
  
4.  Appoint safekeeping custodians or assistants.  Appointees to these positions are not subject to pecuniary liability. 
  
5.  Governing guidance is in the Department of Defense Financial Management Regulation, Volume 5 (Disbursing Policy). 
  
SECTION I. 
  
1.  Enter the Appointee's name and rank or grade.  
  
2.  Enter the Appointee's 10-digit DoD Identification Number. 
  
3.  Enter the Appointee's title. 
  
4. - 5. Enter the name, complete address (to include e-mail address), and telephone number (include DSN when available)  
     of the DoD Component or activity to which appointed. 
  
6.  Mark X in the appropriate box to indicate the duty the appointee will perform (select only one).  If appointing a disbursing  
     officer or deputy disbursing officer, enter the appropriate DSSN in the space provided. 
  
7.  The appointing authority identifies the types of payments affected, but need only be specific as he or she considers 
      necessary, and may include any other pertinent, applicable information (e.g., system involved). 
  
8.  List all publications the Appointee must review and follow in order to adequately fulfill the requirements of the appointment. 
  
SECTION II. 
  
9. - 12. Enter the appointing authority's name, title, DoD Component/Organization location, and date signed. 
  
13.  The appointing authority must enter his or her manual or digital signature.  If signature is digital, completing item 12 is not 
       required since the digital signature includes the date; enter only after completion of items 1 through 11, as this signature  
       will "lock" those items. 
  
SECTION III. 
  
14. - 16.  The appointee enters his or her name and digital (16a) or manual (16b) signature, or both, depending on type(s) of 
       signature(s) to be employed, in the appropriate spaces.  If the signature is manual (16b), complete item 15, but if the 
       signature is ONLY digital (16a), completing item 15 is not required since the digital signature includes the date.  If the 
       appointee enters both manual and digital signatures, the dates in items 15 and 16a must match.  The date in item 15  
       (or 16a if signed digitally) cannot be earlier than the date in item 12 or 13.  The appointment is effective on the date of 
       acceptance by the appointee, and is not in force without his or her acknowledgement. 
  
SECTION IV. 
  
Completing this section terminates the original appointment.  If partial authority is to be retained, complete a new DD Form 577. 
  
17. Enter the date the termination is effective.  Completion of this item is not required if item 21 is signed digitally, since the 
      electronic signature includes the date. 
  
18. The appointee initials in the space provided acknowledging revocation of the appointment. 
  
19. - 21. The appointing authority enters his or her name, title and signature (which may be digital) in the spaces provided.








Lodging Advance Memo Example 
 


                                                  10 Jan 23 
 
MEMORANDUM 
                                                     
From: IMSO, xxxxxxx, xxxxxxx 
To:      N84, Naval Education and Training Security Assistance Field Activity 
 
Subj:  ADVANCE ON LIVING ALLOWANCE – LTC xxxxxxxxx, Nepalese Army, ITO 


#xxxxxx 
 
Ref:  (a) Msg, SECDEF Washington DC//USDP-DSCA//141441Z APR 03 
  (b) DSCA Electronic Security Assistance Management Manual, Para C10.13.8.4 
 
1.  As a means of alleviating financial hardships, ref (a) authorizes authorizes the students to 
draw a living allowance advance upon arrival in CONUS of an amount up to, but not to exceed, 
the equivalent of 45 days of living allowance.  Ref (b) states “The IMS living allowance drawn 
during the period of training is adjusted to ensure that the amount of the advance is fully 
recovered before the student completes training at that location. “ 
 
2.  Accordingly, request LTC xxxxxxxxx be given an advance of $6,960.00 (30 days his daily  
rate).  Reimbursement of this advance will be deducted from LTC xxxxxxxx’s monthly  
living allowance payment at the rate of $580.00/month for 12 months commencing February  
2023. 
 
3.  If you have any questions, please contact me at xxxxxxxx. 
 
 
 


XXXXXXXXX 
IMSO 
 
 
 
 
 


  
 
 
 
 
 
 
 
 
 


Att (11) 
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DD FORM 1131, DEC 2003


CASH COLLECTION VOUCHER 


1. DISBURSING OFFICE COLLECTION VOUCHER NUMBER


2. RECEIVING OFFICE COLLECTION VOUCHER NUMBER


3. RECEIVING OFFICE
a. ACTIVITY (Name and Location) (Include ZIP Code)


b. RECEIVED AND FORWARDED BY (Printed Name,Title and Signature)


c. TELEPHONE NUMBER (Include Area Code):
    COMMERCIAL: DSN: 


d. DATE (YYYYMMDD)


4. DISBURSING OFFICE
a. ACTIVITY (Name and Location) (Include ZIP Code)


b. DISBURSING OFFICER (Printed Name, Title and Signature)


c. TELEPHONE NUMBER (Include Area Code):
    COMMERCIAL: DSN: 


d. DISBURSING STATION  
    SYMBOL NUMBER


e. DATE (YYYYMMDD)


5. PERIOD:   a. FROM: b. TO:


6. DATE 
RECEIVED


7. NAME OF REMITTER 
DESCRIPTION OF REMITTANCE 


8. DETAILED DESCRIPTION OF  
PURPOSE FOR WHICH  


COLLECTIONS WERE RECEIVED 
9. AMOUNT 10. ACCOUNTING  


CLASSIFICATION


11. TOTAL








Page 1 of 1
PREVIOUS EDITION IS OBSOLETE.


DD FORM 1131, DEC 2003


CASH COLLECTION VOUCHER 


1. DISBURSING OFFICE COLLECTION VOUCHER NUMBER


2. RECEIVING OFFICE COLLECTION VOUCHER NUMBER
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b. RECEIVED AND FORWARDED BY (Printed Name,Title and Signature)


c. TELEPHONE NUMBER (Include Area Code):
    COMMERCIAL: DSN: 


d. DATE (YYYYMMDD)


4. DISBURSING OFFICE
a. ACTIVITY (Name and Location) (Include ZIP Code)


b. DISBURSING OFFICER (Printed Name, Title and Signature)
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COLLECTIONS WERE RECEIVED 
9. AMOUNT 10. ACCOUNTING  


CLASSIFICATION


11. TOTAL








U.S. Debit Card 


 


Statement of Understanding 
 


 


I,          , have received a debit 


card from New York Community Bank (NYCB) which will be used to deposit 


living allowances due to me while attending United States Navy sponsored 


Security Cooperation training.  All payments due to me for living allowances will 


be deposited to the debit card. 


 


I understand that I am responsible for safeguarding the card and associated 


personal identification number (PIN) and am solely responsible for its use.  In the 


event the card is lost or destroyed or unauthorized use is discovered it is my 


responsibility to notify NYCB at the customer service number on the back of the 


card to request resolution or card replacement action.   


 


Any and all debts or charges related to the use of the card, i.e., ATM fees, are 


entirely my responsibility.  The United States government will NOT reimburse any 


charges or fees associated with the use of the card.  Associated card use fees are 


included in the agreement accompanying the card. 


 


If attending further US Navy sponsored training at the same or different location, I 


will maintain the card for future payments associated with that training. 


 


 


Signature:          Date:     


 


 


Att (2) 
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5 Att (3)












IMS Debit Card Helpful Information 


 


- To activate your card:  call 1.800.341.6700  


 


- You must change your mailing address after creating your account and or 


transferring to another command.  It is currently your IMSOs address.  Change it to 


your current residence (hotel/apartment) should you lose or the card gets damaged 


it can be mailed directly to you.   


 


- Download the Money Network App to access your account.  Only use this app to 


transfer funds.  Third party apps to transfer funds have resulted in theft in the 


past. 


 


- ATM surcharges:  you will not have a surcharge if using a PLUS, Interlink or 


Star affiliated ATM (See the U.S. Debit Card Standard Fee Schedule for fees 


associated with your card).  You can also find the closest ATM with no surcharge 


on the Money Network App. 


 


- What if I enter wrong PIN at or forgot my PIN:  If you are having trouble 


remembering your PIN, do not try to guess your PIN.  Call 1.800.341.6700 to 


request a new PIN. 


 


- What happens if I lose my card:  You should call NYCB, 1.800.341.6700, 


customer service immediately.  Once you report a lost or stolen card a new card 


will be issued and the old card will be cancelled. 


 


- If you have not used all of the funds that were put into your account, prior to your 


departure calling 1.800.341.6700 to let the bank know that you are going home.  


This will help avoid problems using your card when you get home.  Should you 


forget to do this prior to departure, the toll free number is 531.210.3520 and you 


can call when you get home.  You can also transfer the funds left on the card to 


your personal bank prior to leaving the country. 
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Instructions (2)

		Sample Debit Card Authority Spreadsheet Instructions



		Do not change any of the formatting on the spreadsheet!



		COLUMN 		ACTION		COMMENTS

		A		Fill in date of submission for each person added to the form

		B/C/D		These are the first 6 positions of the ITO Number.		Column B is first position/Column C is second/column D is third through sixth position.

		E		Enter amount to be paid to the IMS. 

		F		Enter year/month for voucher claim        (ex. 23/04)		This is the effective month of claim.

		G		DO NOT CHANGE		All should will read 8851.

		H		Copy ITO Number directly from the ITO.

		I		Copy LOA from #9 of the ITO or corrected amendment.		You are copying everything except the SDN which is the last part of the LOA.

		J		Copy directly from the ITO.		Usually the last portion of the LOA or annotated within #9 of the ITO.  

		K		LEAVE BLANK		This block is for DFAS Indianapolis use only.

		L		Enter IMS Name (LAST, FIRST)

		M		LEAVE AS SHOWN ON DOCUMENT		This will always be 021913626 unless otherwise directed.

		N		Enter IMS Debit Card Account Number. This # will be 16 digits for all.		You'll need to keep track of all assigned IMS' Account Numbers.

		O		Must match Certifying Officer's name on corresponding SF-1034		First name, Last name format.

		P		Enter amount only if member was issued an advance on this claim.		If N/A, leave blank.

		Q		Enter amount only if member was issued funds for furniture rental on this claim.		If N/A, leave blank.

		R		Enter amount of funds to be issued for Lodging on this claim.		If N/A, leave blank.

		S		Enter amount of funds to be issued for M&IE on this claim.		If N/A, leave blank.

		T		Enter amount of funds to be issued for Baggage on this claim.		If N/A, leave blank.

		U		Enter amount of funds to be issued for travel per diem on this claim.		If N/A, leave blank.

		Very Important



		Once completed, save document with the following naming convention:				COMMAND (SHORT VERSION) DEBIT CARD AUTHORITY - DATE (20230228)                                             ex. NIPO DEBIT CARD AUTHORITY - 20230228

		If you have more than one submission for the day, use the following naming convention for subsequent submissions:				COMMAND (SHORT VERSION) DEBIT CARD AUTHORITY NUMBER OF SUBMISSION FOR THR DAY - DATE (20230228)                                             ex. NIPO DEBIT CARD AUTHORITY 2 - 20230228
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Debit Card Authority

		Debit Card Authority 



		From:  COMMAND NAME (SHORT)



		COMM PH:     COMMAND PHONE #                                  

		DSN PH:      DSN IF AVAILABLE



		Elements highlighted in yellow are required for Expenditure Authority

		Remaining items for processing in DDS

																																NETSAFA/IMSO USE ONLY

		DATE		CC		IA		CASE		AMT		YR/MNTH		DSSN		ITO		COMPLETE LINE OF ACCOUNTING		Standard Document Number (SDN)		DIFS EA #		Travelers Name		Routing Number		Account Number		Certifying officers name		Advance		Furniture Rental		Lodging		M&IE		Baggage		Travel Per Diem

		28-Feb-23		MV		P		23I		2,170.00		2302		8851		MVP23I001100		AA 11 97 XXXX XXXX 8242 0002 667100		N6887023MDMV3TL				BEAR, TEDDY I		021913626		1973123401000567		LAST NAME, FIRST NAME						$2,100.00		$70.00

		28-Feb-23		MV		P		23I		2,170.00		2302		8851		MVP23I0011001		AA 11 97 XXXX XXXX 8242 0002 667100		N6887023MDMV4TL				DANDY, JIM 		021913626		1973123401000568		LAST NAME, FIRST NAME						$2,100.00		$70.00

		28-Feb-23		MV		P		23I		2,170.00		2302		8851		MVP23I0011002		AA 11 97 XXXX XXXX 8242 0002 667100		N6887023MDMV5TL				JONES, TIM		021913626		1973123401000569		LAST NAME, FIRST NAME						$2,100.00		$70.00

		28-Feb-23		MV		P		23I		2,170.00		2302		8851		MVP23I0011003		AA 11 97 XXXX XXXX 8242 0002 667100		N6887023MDMV6TL				MURPHY, JAMES		021913626		1973123401000510		LAST NAME, FIRST NAME						$2,100.00		$70.00

		28-Feb-23		MV		P		23I		2,170.00		2302		8851		MVP23I0011004		AA 11 97 XXXX XXXX 8242 0002 667100		N6887023MDMV7TL				DOE, JANE		021913626		1973123401000511		LAST NAME, FIRST NAME						$2,100.00		$70.00

		28-Feb-23		MV		P		23I		2,402.50		2302		8851		MVP23I0011002		AA 11 97 XXXX XXXX 8242 0002 667100		N6887023MDMV8TL				JAMES, TONY		021913626		1973123401000512		LAST NAME, FIRST NAME						$2,402.50

		28-Feb-23		MV		P		23I		2,402.50		2302		8851		MVP23I0011003		AA 11 97 XXXX XXXX 8242 0002 667100		N6887023MDMV9TL				SMITH, JENNIFER		021913626		1973123401000513		LAST NAME, FIRST NAME						$2,402.50

		28-Feb-23		MV		P		23I		2,402.50		2302		8851		MVP23I0011004		AA 11 97 XXXX XXXX 8242 0002 667100		N6887023MDM10TL				DANBURY, FRANK		021913626		1973123401000514		LAST NAME, FIRST NAME						$2,402.50

		28-Feb-23		MV		P		23I		3,235.00		2302		8851		MVP23I0011003		AA 11 97 XXXX XXXX 8242 0002 667100		N6887023MDM11TL				SAILOR, IMA		021913626		1973123401000515		LAST NAME, FIRST NAME						$3,200.00		$35.00

		28-Feb-23		MV		P		23I		3,235.00		2302		8851		MVP23I0011004		AA 11 97 XXXX XXXX 8242 0002 667100		N6887023MDM12TL				CERNAK, ANTON		021913626		1973123401000516		LAST NAME, FIRST NAME						$3,200.00		$35.00

































		TOTAL								24,527.50

































































































































INSTRUCTIONS

		Debit Card Authority Spreadsheet Instructions

		Do not change formatting on the spreadsheet!

		COL/LINE		ACTION		COMMENTS

		Line 3		Type Command Name (short)

		Lines 5/6		Type IMSO Phone # on Line 5 and DSN on Line 6 if you have one.  Leave blank if not.

		A		Fill in date of submission for each person added to the form

		B/C/D		These are the first 6 positions of the ITO Number.		Column B is first position/Column C is second/column D is third through sixth position.

		E		Enter amount to be paid to the IMS. 

		F		Enter year/month for voucher claim        (ex. 23/04)		This is the effective month of claim.

		G		DO NOT CHANGE		All should will read 8851.

		H		Copy ITO Number directly from the ITO.

		I		Copy LOA from #9 of the ITO or corrected amendment.		You are copying everything except the SDN which is the last part of the LOA.

		J		Copy directly from the ITO.		Usually the last portion of the LOA or annotated within #9 of the ITO.  

		K		LEAVE BLANK		This block is for DFAS Indianapolis use only.

		L		Enter IMS Name (LAST, FIRST)

		M		LEAVE AS SHOWN ON DOCUMENT		This will always be 021913626 unless otherwise directed.

		N		Enter IMS Debit Card Account Number. This # will be 16 digits for all.		You'll need to keep track of all assigned IMS' Account Numbers.

		O		Must match Certifying Officer's name on corresponding SF-1034		Last name, First name format.

		P		Enter amount only if member was issued an advance on this claim.		If N/A, leave blank.

		Q		Enter amount only if member was issued funds for furniture rental on this claim.		If N/A, leave blank.

		R		Enter amount of funds to be issued for Lodging on this claim.		If N/A, leave blank.

		S		Enter amount of funds to be issued for M&IE on this claim.		If N/A, leave blank.

		T		Enter amount of funds to be issued for Baggage on this claim.		If N/A, leave blank.

		U		Enter amount of funds to be issued for travel per diem on this claim.		If N/A, leave blank.

		Very Important

		Once completed, save document with the following naming convention:				YYYYMMDD COMMAND (Short version) Debit Card Authority (Amount in the "TOTAL" block of spreadsheet)                                             ex.  20230228 NIPO DEBIT CARD AUTHORITY $24,527.50
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Instructions (2)

		Sample Debit Card Authority Spreadsheet Instructions



		Do not change any of the formatting on the spreadsheet!



		COLUMN 		ACTION		COMMENTS

		A		Fill in date of submission for each person added to the form

		B/C/D		These are the first 6 positions of the ITO Number.		Column B is first position/Column C is second/column D is third through sixth position.

		E		Enter amount to be paid to the IMS. 

		F		Enter year/month for voucher claim        (ex. 23/04)		This is the effective month of claim.

		G		DO NOT CHANGE		All should will read 8851.

		H		Copy ITO Number directly from the ITO.

		I		Copy LOA from #9 of the ITO or corrected amendment.		You are copying everything except the SDN which is the last part of the LOA.

		J		Copy directly from the ITO.		Usually the last portion of the LOA or annotated within #9 of the ITO.  

		K		LEAVE BLANK		This block is for DFAS Indianapolis use only.

		L		Enter IMS Name (LAST, FIRST)

		M		LEAVE AS SHOWN ON DOCUMENT		This will always be 021913626 unless otherwise directed.

		N		Enter IMS Debit Card Account Number. This # will be 16 digits for all.		You'll need to keep track of all assigned IMS' Account Numbers.

		O		Must match Certifying Officer's name on corresponding SF-1034		First name, Last name format.

		P		Enter amount only if member was issued an advance on this claim.		If N/A, leave blank.

		Q		Enter amount only if member was issued funds for furniture rental on this claim.		If N/A, leave blank.

		R		Enter amount of funds to be issued for Lodging on this claim.		If N/A, leave blank.

		S		Enter amount of funds to be issued for M&IE on this claim.		If N/A, leave blank.

		T		Enter amount of funds to be issued for Baggage on this claim.		If N/A, leave blank.

		U		Enter amount of funds to be issued for travel per diem on this claim.		If N/A, leave blank.

		Very Important



		Once completed, save document with the following naming convention:				COMMAND (SHORT VERSION) DEBIT CARD AUTHORITY - DATE (20230228)                                             ex. NIPO DEBIT CARD AUTHORITY - 20230228

		If you have more than one submission for the day, use the following naming convention for subsequent submissions:				COMMAND (SHORT VERSION) DEBIT CARD AUTHORITY NUMBER OF SUBMISSION FOR THR DAY - DATE (20230228)                                             ex. NIPO DEBIT CARD AUTHORITY 2 - 20230228
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Debit Card Authority

		Debit Card Authority 



		From:  



		COMM PH:                                       

		DSN PH: 



		Elements highlighted in yellow are required for Expenditure Authority

		Remaining items for processing in DDS

																																NETSAFA/IMSO USE ONLY

		DATE		CC		IA		CASE		AMT		YR/MNTH		DSSN		ITO		COMPLETE LINE OF ACCOUNTING		Standard Document Number (SDN)		DIFS EA #		Travelers Name		Routing Number		Account Number		Certifying officers name		Advance		Furniture Rental		Lodging		M&IE		Baggage		Travel Per Diem

														8851												021913626



















































		TOTAL								0.00
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SF-1034 INSTRUCTIONS 


BLOCK ACTION COMMENTS 


US Department, Bureau, or 


Establishment 


Enter: Defense Finance and Accounting Service 


1240 East Ninth Street 


ATTN: Disb. Ops. DSSN 8851 SDP MIGRATION 


Cleveland, OH 44199 


Date Voucher Prepared Enter the current calendar day 


Contract Number and Date LEAVE BLANK 


Requisition Number and Date LEAVE BLANK 


Voucher Number LEAVE BLANK 


Schedule Number LEAVE BLANK 


Paid By LEAVE BLANK 


Payee’s Name and Address 


ENTER: COMMAND (short version) 


Attn: IMSO NAME 


COMMAND ADDRESS 


IMSO phone number 


Ex: NIPO ATTN: IMSO First, Last Name 


250 Dallas Street 


Pensacola, FL 32508 


228-123-4567


Date Invoice Received Enter the current calendar day 


Discount Terms LEAVE BLANK 


Payee’s Account Number ENTER: 021913626 


Shipped From, To, Weight LEAVE BLANK 


Government B/L Number LEAVE BLANK 


Number and Date of Order LEAVE BLANK 


Date of Delivery of Service LEAVE BLANK 


Articles or Services ENTER: DEBIT CARDS 


Quantity 


ENTER: The quantity of personnel who have 


the same amount to be deposited on the 


spreadsheet. 


Ex: 5 IMS to be deposited $2,170 on the 


worksheet, enter 5 in this block. Use 


additional lines when you have IMS with 


different amounts.  In total, you would 


only be able to have 9 IMS with different 


deposit amounts for each SF-1034 and 


Spreadsheet combination. 


Unit Price (COST) Enter the total amount to be deposited.  


This amount must match your entry in 


“Quantity” and number of IMS on 


spreadsheet for this amount. 


Unit Price (PER) Always enter: 1 


Amount This box will automatically fill. 


Total This box will automatically fill. 


The total must match the TOTAL line on 


the spreadsheet  


Payee must NOT use the 


space below LEAVE BLANK 


Certifying Officer Section 


(DATE) ENTER: The date of signature 


(Authorized Certifying 


Officer) Can be digitally signed or wet signature. 


(Title) Enter the same title as block #3 on DD-577 


Accounting Classification 


Enter LOA from ITO (REMEMBER: One SF-


1034 to one Debit Card Authority spreadsheet  


(Every name on each Debit Card Authority must 


have the same LOA). 


If you have 10 IMS and they all have 


different LOAs, you will have 10 Debit 


Card Authority spreadsheets and 10 SF-


1034’s. 


Paid by, per, and Title LEAVE BLANK 


**VERY IMPORTANT** 


Once completed, save document with the following 


naming convention: 


YYYYMMDD COMMAND (Short version) SF 1034 


$xx,xxx.xx (Total on SF 1034 (Must also match Debit 


Card Authority Spreadsheet total) 


ex.  20230228 NIPO SF 1034 $24,527.50 
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PUBLIC VOUCHER FOR PURCHASES AND 
SERVICES OTHER THAN PERSONAL


VOUCHER NUMBER


U.S. DEPARTMENT, BUREAU, OR ESTABLISHMENT AND LOCATION DATE VOUCHER PREPARED


CONTRACT NUMBER AND DATE


REQUISITION NUMBER AND DATE


SCHEDULE NUMBER


PAID BY


DATE INVOICE RECEIVED


DISCOUNT TERMS


PAYEE'S ACCOUNT NUMBER


GOVERNMENT B/L NUMBERSHIPPED FROM TO WEIGHT


DATE OF 
DELIVERY 


OR SERVICE


ARTICLES OR SERVICES  
(Enter description, item number of contract or Federal supply schedule, 


and other information deemed necessary)


QUAN- 
TITY


UNIT PRICE


COST PER


AMOUNT


(Use continuation sheet(s) if necessary) (Payee must NOT use the space below) TOTAL


DIFFERENCES
PAYMENT: APPROVED FOR EXCHANGE RATE


BY


TITLE
Amount verified; correct for payment


(Signature or initials)


=$ =$1.00


Pursuant to authority vested in me, I certify that this voucher is correct and proper for payment.


(Date)
ACCOUNTING CLASSIFICATION


P
A
I
D


CHECK NUMBER


CASH


ON ACCOUNT OF U.S. TREASURY


DATE
$


CHECK NUMBER


PAYEE


ON  (Name of bank)


PER


TITLE


Standard Form 1034 
Revised October 1987 
Department of the Treasury 
1 TFM 4-2000 
 


PAYEE'S 
NAME 
AND 


ADDRESS


NUMBER AND DATE  
OF ORDER (1)


PROVISIONAL


COMPLETE


PARTIAL


FINAL


PROGRESS


ADVANCE


2


(Title)(Authorized Certifying Officer)


3


Previous edition usable


PRIVACY ACT STATEMENT
The information requested on this form is required under the provisions of 31 U.S.C. 82b and 82c, for the purpose of disbursing Federal 
money. The information requested is to identify the particular creditor and the amounts to be paid.  Failure to furnish this information will 
hinder discharge of the payment obligation.


1. When stated in foreign currency, insert name of currency.  
2. If the ability to certify and authority to approve are combined in one person, one signature only is necessary; otherwise the approving 


officer will sign in the space provided, over his official title.  
3. When a voucher is receipted in the name of a company or corporation, the name of the person writing the company or corporate 


name, as well as the capacity in which he signs, must appear.  For example: "John Doe Company, per John Smith, Secretary", or 
"Treasurer", as the case may be. 


B
Y


2








APPOINTMENT/TERMINATION RECORD -AUTHORIZED SIGNATURE 


(Read Privacy Act Statement and Instructions before completing form.) 


PRIVACY ACT STATEMENT 


AUTHORITY: E.O. 9397, 31 U.S.C. Sections 3325, 3528, DoDFMR, 7000.14-R, Vol. 5. 
PRINCIPAL PURPOSE(S): To maintain a record of appointment and termination of appointment of persons to any of the positions listed in Item 6, 
and to identify the duties associated with this appointment. 
SORN T1300 (hlli;1://di;1clo .  defense.gov/Prica Ci/SOR Nsl ndex/DODComi;1onentArticleView/labid/7 489/Article/6235/11300. asi;1x) 
ROUTINE USE(S): The information on this form may be disclosed as generally permitted under 5 U.S.C Section 552a(b) of the Privacy Act of 1974, 
as amended. II may also be disclosed outside of the Department of Defense (DoD) to the Federal Reserve Banks to verify authority of the appointed 
individuals to issue Treasury checks. In addition, other Federal, State and local government agencies, which have identified a need to know, may 
obtain this information for the purpose(s) identified in the DoD Blanket Routine Uses published at: 
hlli;1://di;1clo.defense.gov/Privaci/SORNslndex/BlanketRoutineUses.asi;1x. 
DISCLOSURE Voluntary; however, failure to provide the requested information may preclude appointments. 


SECTION I - APPOINTEE


1. NAME (First, Middle Initial, Last and Rank or Grade) 2. DoD ID NUMBER 3. TITLE INTERNATIONAL MILITARY 


IMSO LAST, IMSO FIRST MI 1234567890 STUDENT OFFICER 


4. DOD COMPONENT/ORGANIZATION 5. ADDRESS (Include ZIP Code, email address, and telephone number with area code and DSN) 


(YOUR ORGANIZATION NAME) (YOUR ORGANIZATION NAME)
(ex.)DON/SWOSCOLCOM (ex.)SWOSCOLCOM


446 CUSHING ROAD


NEWPORT, RI 02841


6. POSITION TO WHICH APPOINTED (X appropriate box - one only. Checking more than one invalidates the appointment.)
- � -


DISBURSING OFFICER: DSSN CASHIER CHANGE FUND CUSTODIAN 
- - -


DEPUTY DISBURSING OFFICER: DSSN PAYING AGENT IMPREST FUND CASHIER 
- --- -


CERTIFYING OFFICER COLLECTIONS AGENT SAFEKEEPING CUSTODIAN 
- -


DEPARTMENTAL ACCOUNTABLE OFFICIAL DISBURSING AGENT ASSISTANT SAFEKEEPING CUSTODIAN 


7. YOU ARE APPOINTED TO SERVE IN THE POSITION IDENTIFIED IN ITEM 6. YOUR RESPONSIBILITIES INCLUDE:


(EX.) - LIAISON FOR INTERNATIONAL MILITARY STUDENTS ASSIGNED TO DON/SWOSCOLCOM.
- PREPARE, CERTIFY AND SUBMIT TLA PAYMENTS TO INTERNATIONAL MILITARY STUDENTS ASSIGNED TO DON/
SWOSCOLCOM.
- PICK UP AND DISTRIBUTE US TREASURY CHECKS TO INTERNATIONAL MILITARY STUDENTS ASSIGNED TO DON/
SWOSCOLCOM.


8. REVIEW AND ADHERE TO THE FOLLOWING PUBLICATION(S) NEEDED TO ADEQUATELY PERFORM YOUR ASSIGNED DUTIES:


JFTR


DODFMR VOL 5


SECTION II - APPOINTING AUTHORITY 


9. NAME (First, Middle Initial, LasO 10. TITLE 11. DOD COMPONENT/ORGANIZATION 


(ex.) COMMANDING OFFICER / YOUR ORGANIZATION
(PERSON CERTIFIED GRANT AUTH) COMMANDER (ex.) DON/SWOSCOLCOM


12. DATE (YYYYMMDD) 13. SIGNATURE 


SECTION Ill -APPOINTEE ACKNOWLEDGEMENT 


I ack nowledge and accept the position and responsibilit ies defined above. I understand that I am st rictly liable to the United 
St ates for all public fund s or payment certification, as appropriate, under my cont rol. I have been counseled on my pecuniary liability 
applicable to this appoint ment and have been given written operating inst ruct ions. I certify that my official signature is shown in item 
16 below. 


14. PRINTED NAME (First, Middle Initial, LasO 15. DATE (YYYYMMDD) (Not earlier than date in Item 12 or 13) 


SAME AS BLOCK 1 


16.a. DIGITAL SIGNATURE 16.b. MANUAL SIGNATURE 


SECTION IV - APPOINTMENT TERMINATION 


The appoint ment of the individual named above is 
17. DATE (YYYYMMDD) 18. APPOINTEE INITIALS


hereby revoked. 


19. NAME OF APPOINTING AUTHORITY 20. TITLE 21. APPOINTING AUTHORITY SIGNATURE


DD FORM 577, NOV 2014 PREVIOUS EDITION IS OBSOLETE. Adobe Designer 9.0 


(MANUAL OR DIGITAL SIGNATURE)
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